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Notes, Cautions, and Warnings
 
NOTE: A NOTE indicates important information that helps you make better use of your printer. 

CAUTION: A CAUTION indicates either potential damage to hardware or loss of data and tells you how to avoid the problem. 

WARNING: A WARNING indicates a potential for property damage, personal injury, or death. 

Information in this document is subject to change without notice. 

© 2012 Dell Inc. All rights reserved. 

Reproduction of these materials in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden. 

Trademarks used in this text: Dell and the DELL logo are trademarks of Dell Inc.; Microsoft, Windows, Windows Server, Windows Vista, and 
Internet Explorer are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries. Macintosh 
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XML Paper Specification (XPS): This product may incorporate intellectual property owned by Microsoft Corporation. The terms and conditions 
upon which Microsoft is licensing such intellectual property may be found at http://go.microsoft.com/fwlink/?LinkId=52369; DES: This product 
includes software developed by Eric Young (eay@mincom.oz.au); AES: Copyright © 2003, Dr Brian Gladman, Worcester, UK. All rights reserved. 
This product uses published AES software provided by Dr Brian Gladman under BSD licensing terms; TIFF (libtiff): Copyright © 1988-1997 Sam 
Leffler and Copyright © 1991-1997 Silicon Graphics, Inc.; ICC Profile (Little cms): Copyright © 1998-2004 Marti Maria. 

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and names or their products. 
Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own. 

The printer software uses some of the codes defined by the Independent JPEG Group. 

UNITED STATES GOVERNMENT RESTRICTED RIGHTS 

This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and in 
applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA. 

November 2012 Rev. A00 
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1 
Dell™ C1760nw/C1660w Color Printer User's Guide 
Click the links to the left for information on the features, options, and operation of your Dell C1760nw/C1660w 
Color Printer. For information on other documentation included with your Dell C1760nw/C1660w Color Printer, 
see "Finding Information" on page 17. 

NOTE: In this manual, Dell C1760nw/C1660w Color Printer is referred to as the "printer." 

Conventions 
The following describe the meaning of the symbols and fonts used in this manual: 

Bold texts : • Names of hardware button on the operator panel. 

• Screen names on the LCD panel. 

• Menus, commands, windows, or dialog boxes displayed on the computer screen. 

Texts in Courier New font : • Menus and messages displayed on the LCD panel. 

• Characters entered from the computer. 

• Directory paths. 

< > : • Key on the keyboard of the computer. 

→ : • Indicates a path to a certain item within a procedure on a computer. 

" " : • Cross references in this manual. 

• Characters entered from the operator panel. 

• Messages displayed on the computer screen. 
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2 
Finding Information 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

What are you looking for? 

• Drivers for my printer 

• My  User's Guide 

Find it here 

Software and Documentation disc 

How to use my printer 

The Software and Documentation disc contains setup video, documentation, 
and drivers for your printer. You can use the disc to install/re-install drivers or 
access your setup video and documentation. 

Readme files may be included on your disc to provide last-minute updates about 
technical changes to your printer or advanced technical reference material for 
experienced users or technicians. 

Quick Reference Guide 

• Safety information Important Information 

• Warranty information 

WARNING: Read and follow all safety instructions in the Important Information 
prior to setting up and operating your printer. 
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What are you looking for? Find it here 

How to set up my printer Setup diagram 

Troubleshooting "Troubleshooting" on page 211 

Express Service Code and Service Tag 

• Latest drivers for my printer 

• Answers to technical service and support 
questions 

• Documentation for my printer 

Service Tag 
xxxxxxx 

Express Service Code 
000 000 000 00 

The Express Service Code and Service Tag are located inside the side door of your 
printer. 

Go to support.dell.com 

support.dell.com provides several online tools, including: 

• Solutions — Troubleshooting hints and tips, articles from technicians, and 
online courses 

• Upgrades — Upgrade information for components, such as printer driver 

• Customer Care — Contact information, order status, warranty, and repair 
information 

• Downloads —  Drivers  

• Manuals — Printer documentation and product specifications 

Go to support.dell.com. Select your region, and fill in the requested details to 
access help tools and information. 
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3 
Product Features 
This chapter describes the product features and indicates their links. 

2-Sided Printing (Manual Duplex Print) Priority Sheet Inserter (PSI) (Dell C1760nw Color Printer only) 

Manual Duplex Print is to print two or more pages on the 
front and back side of a single sheet of paper manually. This 
feature allows you to reduce the paper consumption. 
For more information, see "Loading Print Media When 
Manual Duplex Printing" on page 164. 

Printing through Wireless Connection (Wireless Print) 

The Wireless LAN feature on your printer allows you to install 

the printer at any location, and enables printing without a 

wired connection to your computer.
 
For more information, see "Wireless Connection" on page 30.
 

Print media loaded on the PSI are given precedence over those 
loaded on the Multipurpose Feeder (MPF). Using the PSI 
allows you to use other types or sizes of print media 
preferentially over the regular print media loaded on the MPF. 
For more information, see "Loading Print Media in the Priority 
Sheet Inserter (PSI) (Dell C1760nw Color Printer only)" on 
page 159. 

Printing multiple pages on a single sheet of paper (Multiple Up) 

Multiple Up Print allows you to print multiple pages on a 

single sheet of paper. This feature allows you to reduce the
 
paper consumption.
 
For more information, see the printer driver's help.
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4 
About the Printer 
This chapter provides an overview of your Dell™ C1760nw/C1660w Color Printer. 

NOTE: The images used in this manual are those of the Dell C1760nw Color Printer unless otherwise mentioned. 

Front View 

1 

5671011 9 8 

42 37 

12 

1 Operator Panel 2 Output Tray 

3 Output Tray Extension 4 Print Head Cleaning Rod 

5 Toner Access Cover 6 Power Switch 

7 Paper Width Guides 8 Multipurpose Feeder (MPF) 

9 Front Cover 10 MPF Extension 

11 Length Guide 12 Priority Sheet Inserter (PSI) (Dell C1760nw Color Printer only) 
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Rear View
 

1 

6 

7 
8 
9 

10 

11 

2 

3 
4 
5 

1 Power Connector 2 Rear Cover Release Handle 

3 USB Port 4 Ethernet Port (Dell C1760nw Color Printer only) 

5 Security Slot 6 Rear Cover 

7 Transfer Roller 8 Paper Chute 

9 Paper Feed Roller 10 Transfer Belt 

11 Levers 
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Space Requirements 
Place the printer at a location such that there is adequate space for using the printer feeder and covers. 

218 mm/8.6 inches 

225 mm/8.9 inches 

295.5 mm/11.6 inches 

300 mm/11.8 inches 

329.5 mm/13 inches 307 mm/12.1 inches 

394 mm/15.5 inches 

100 mm/3.9 inches 

CAUTION: To avoid irregular screen image or malfunctioning of your printer, avoid placing the printer in direct sunlight with 
the front cover opened. 

Operator Panel 

For more information on the operator panel, see "Operator Panel" on page 77. 
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Securing the Printer 
To protect your printer from theft, you can use the optional Kensington lock. 

Attach the Kensington lock to the security slot on your printer. 

Security slot 

For details, see the operating instructions supplied with the Kensington lock. 
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Ordering Supplies 
You can order consumables from Dell on the Internet when using a networked printer. Enter the IP address of your 
printer in your web browser, launch the Dell Printer Configuration Web Tool, and click the Order Supplies at: to 
order toner for your printer. 

You can also order toner cartridges by the following method: 

1	 Click Start → All Programs → Dell Printers → Additional Color Laser Software →
 
Dell Supplies Management System.
 

The Dell Supplies Management System window appears.
 

2	 Select your printer from the Select Printer Model list. 

3	 If ordering from the web:
 

a Select a web address from the Select Reorder URL list.
 

b Click the Visit Dell Printer supplies ordering web site.
 

The Dell C1760nw Color Printer/Dell C1660w Color Printer - Dell Supplies Management System screen 
appears. 

c Enter the Service Tag, and then click OK. 

The Service Tag is located inside the toner access cover of your printer. 

Dell supplies web site appears. 

Service Tag 
xxxxxxx 

Express Service Code 
000 000 000 00 

If you order by phone, call the number that appears in the Order by Phone section. 
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2 

Connecting Your Printer 
Your Dell™ C1760nw/C1660w Color Printer interconnection cable must meet the following requirements: 

Connection type Connection specifications 

USB USB 2.0 compatible 

Wireless IEEE 802.11b/802.11g/802.11n 

Ethernet 10 Base-T/100 Base-TX compatible (Dell C1760nw Color Printer only) 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

1 
2 

USB Port 

Ethernet Port
 
(Dell C1760nw Color Printer only)
 

Connecting Printer to Computer or Network 

Direct Connection 
A local printer is a printer attached to your computer using a USB cable. If your printer is attached to a network, go 

to "Ethernet Connection (Dell C1760nw Color Printer only)" on page 34.
 

To connect the printer to a computer:
 

Ensure that the printer, computer, and any other attached devices are turned off and unplugged from the power 
source/outlet. 
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2 Connect the smaller USB connector into the USB port at the back of the printer. 

3 Connect the other end of the cable into a USB port of your computer. 

CAUTION: Do not connect the printer USB cable to the USB port available on the keyboard. 

Wireless Connection 
The specifications of wireless setting function are described below: 

Item Specification 

Connectivity Wireless 

Connectivity Standard IEEE 802.11b/802.11g/802.11n compliant 

Bandwidth 2.4 GHz 

Data Transfer Rate IEEE 802.11b mode: 11, 5.5, 2, 1 Mbps 

IEEE 802.11g mode: 54, 48, 36, 24, 18, 12, 9, 6 Mbps 

IEEE 802.11n mode: 65 Mbps 

Security 64 (40-bit key)/ 128 (104-bit key) WEP, WPA-PSK (TKIP, AES), WPA2-PSK (AES)(IEEE 
802.1x attestation function of WPA 1x non-corresponds), Mixed Mode PSK 

Wi-Fi Protected Setup® (WPS)*1 Push Button Configuration (PBC), Personal Identification Number (PIN) 

*1	 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, WPA-PSK AES, WPA2-PSK 
AES, WPA-PSK TKIP, Open (No Security) 

You can select a method to configure a wireless setting from the following: 

WPS-PBC (Wi-Fi | WPS Button)*1 

WPS-PBC (Operator Panel Menu)*1 

WPS-PIN*2 

Auto SSID Setup 

Manual SSID Setup 
*1	 WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for wireless con

figuration, by starting WPS-PBC on the printer with the  (Wi-Fi | WPS) button or operator panel menu, and then pressing the button 
provided on the wireless LAN access point (Registrar) or router. This setting is available only when the access point supports WPS-PBC. 

*2	 WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required for wire
less configuration, by entering PIN assignments in the printer and computer. This setting, performed through access point, is available 
only when the access points of your wireless router supports WPS. 
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1 

WPS-PBC (Wi-Fi | WPS Button) 

You can start WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) by pressing the  (Wi-Fi | WPS) 
button. 

NOTE: WPS-PBC is available only when the wireless LAN access point (Registrar) or router supports WPS-PBC. 

NOTE: Before starting WPS-PBC with the (Wi-Fi | WPS) button, confirm the position of the WPS button (button name may 
vary) on the wireless LAN access point (Registrar) or router. For information about WPS operation on the wireless LAN access 
point (Registrar) or router, refer to the manual supplied with the product. 

NOTE: For more information on the (Wi-Fi | WPS) button, see "Status of Wi-Fi | WPS Button Backlight" on page 78. 
If a problem occurs or error messages are displayed on the operator panel, see "Wireless Problems" on page 224. 

Press and hold the (Wi-Fi | WPS) button on the printer for 2 seconds.
 

Ensure that the
 (Wi-Fi | WPS) button starts to flash and Press WPS Button on Router appears on 
the operator panel. 

2 Start the WPS operation on the wireless LAN access point (Registrar) or router within two minutes. 

3 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed. 

WPS-PBC (Operator Panel Menu) 

You can start WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) from the operator panel. 

NOTE: WPS-PBC is available only when the wireless LAN access point (Registrar) or router supports WPS-PBC. 

NOTE: Before starting WPS-PBC, confirm the position of the WPS button (button name may vary) on the wireless LAN access 
point (Registrar) or router. For information about WPS operation on the wireless LAN access point (Registrar) or router, refer to 
the manual supplied with the product. 

NOTE: A Password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter 
the password you specified, and press the (Set) button. 

1 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

3 Press the 
 button until Network appears, and then press the (Set) button.
 

4 Press the 
 button until WPS Setup appears, and then press the (Set) button.
 

5 Ensure that Push Btn. Ctrl appears, and then press the
 (Set) button.
 

6 Ensure that Are you sure? appears, and then press the
 (Set) button.
 

Ensure that Press WPS Button on Router is displayed, and start the WPS-PBC on the wireless LAN 

access point (Registrar) or router within two minutes. 

7 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed. 
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WPS-PIN 

The PIN code of WPS-PIN can only be configured from the operator panel. 

NOTE: WPS-PIN is available only when the wireless LAN access point (Registrar) or router supports WPS-PIN. 

NOTE: A Password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter 
the password you specified, and press the (Set) button. 

1	 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

3 Press the 
 button until Network appears, and then press the (Set) button.
 

4 Press the 
 button until WPS Setup appears, and then press the (Set) button.
 

5 Ensure that PIN Code appears, and then press the 
 (Set) button.
 

6 Write down the displayed 8-digit PIN code or select Print PIN Code. The PIN code is printed.
 

7 Ensure that Start Config. appears, and then press the
 (Set) button. 

8	 Ensure that Operate Wireless Router is displayed, and enter the PIN code displayed on step 6 into the 
wireless LAN access point (Registrar) or router. 

NOTE: For WPS operation on the wireless LAN access point (Registrar) or router, refer to the manual supplied with the 
product. 

9 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed. 

Auto SSID Setup 

NOTE: A Password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter 
the password you specified, and press the (Set) button. 

1	 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

3 Press the 
 button until Network appears, and then press the (Set) button.
 

4 Press the 
 button until Wireless Setup appears, and then press the (Set) button. 

The printer automatically searches the access points on wireless network.
 

5 Press the 
  button until the desired access point  appears, and then press the (Set) button.
 

If the desired access point does not appear,  go to "Manual SSID Setup" on page 33.
 

NOTE: Some hidden SSID may not be displayed. If the SSID is not detected turn on SSID broadcast from the router. 

6	 Enter the passphrase or WEP key.
 

When the encryption type of the selected access point is WPA, WPA2 or Mixed in step 5:
 

•	 Enter the passphrase, and then press the (Set) button.
 

When the encryption type of the selected access point is WEP in step 5:
 

•	 Enter the WEP key, and then press the (Set) button. 

NOTE: A passphrase is an encryption key for WPA and WPA2 encryption which consists of 8 to 63 alphanumeric 
characters. It may be described as a key on some access points or routers. For details, refer to the manual supplied with 
the access point or router. 

7 Ensure that Restart Printer to apply settings appears.
 

8 Turn off the printer, and turn it on again to apply the settings.
 

Wireless LAN connection setting is complete.
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Manual SSID Setup 

NOTE: A Password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter 
the password you specified, and press the (Set) button. 

1	 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

3 Press the 
 button until Network appears, and then press the (Set) button.
 

4 Press the 
 button until Wireless Setup appears, and then press the (Set) button.
 

5 Press the 
 button until Manual Setup appears, and then press the (Set) button.
 

6 Enter the SSID, and then press the 
 (Set) button. 

7	 Select the network mode from Infrastructure and Ad-hoc depending on your environment, and then press 
the (Set) button.
 

If you select Infrastructure, proceed to step 8.
 

If you select Ad-hoc, proceed to step 9.
 

8	 Select the encryption type from No Security, Mixed mode PSK, WEP, WPA-PSK-TKIP, or WPA2-PSK-
AES. 

If you do not set security for your wireless network: 

• Press the  button until No Security appears, and then press the (Set) button. 

To use Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES encryption:
 

a Press the 
 button until Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES appears, and then 
press the (Set) button.
 

b Enter the passphrase, and then press the 
 (Set) button. 

NOTE: A passphrase is an encryption key for WPA and WPA2 encryption which consists of 8 to 63 alphanumeric 
characters. It may be described as a key on some access points or routers. For details, refer to the manual supplied with 
the access point or router. 

To use WEP encryption:
 

a Press the 
 button until WEP appears, and then press the (Set) button.
 

b Enter the WEP key, and then press the 
 (Set) button.
 

c Press the 
  button to highlight the desired transmit key from Auto or WEP Key 1 to WEP Key 4, and 
then press the (Set) button.
 

Proceed to step 10.
 

9	 Select the encryption type from No Security or WEP.
 

If you do not set security for your wireless network:
 

• Ensure that No Security appears, and then press the (Set) button. 

To use WEP encryption:
 

a Press the 
 button until WEP appears, and then press the (Set) button.
 

b Enter the WEP key, and then press the 
 (Set) button.
 

c Press the 
  button to highlight the desired transmit key from WEP Key 1 to WEP Key 4, and then press 
the (Set) button. 
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10 Ensure that Restart Printer to apply settings appears. 

11 Turn off the printer, and turn it on again to apply the settings. 

Wireless LAN connection setting is complete. 

Ethernet Connection (Dell C1760nw Color Printer only) 
To connect the printer to a network: 

1 Ensure that the printer, computer and any other connected devices have been turned off and all cables have been 
disconnected. 

2 Connect the Ethernet cable. 

NOTE: Connect the Ethernet cable, only if you need to setup a wired connection. 

To connect the printer to the network, connect one end of an Ethernet cable into the Ethernet port on the back of
 
the printer, and the other end to a LAN port or LAN hub.
 

To setup a wireless connection, see "Wireless Connection" on page 30.
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Reconfiguring the Wireless Setting 
To change the wireless setting through an Ethernet or wireless connection from your computer, perform the 
following. 

NOTE: To change the wireless setting through wireless connection, ensure that the wireless connection setting is completed in 
"Wireless Connection" on page 30. 

NOTE: The following settings are available when the network mode is set to infrastructure in "Wireless Connection" on page 30. 

1 Check the IP address of the printer. 

For details about how to check the IP address of the printer, see "Verifying the IP Settings" on page 41. 

2 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser. 

3 Click Print Server Settings. 

4 Click Print Server Settings tab. 

5 Click Wireless LAN. 

6 Change the wireless setting of the printer. 

7 Reboot the printer. 

8 Change the wireless settings on your computer or access point accordingly. 

NOTE: To change the wireless settings on your computer, refer to the manuals provided with the wireless adapter or if 
your computer provides a wireless adapter tool, change the wireless settings using that tool. 
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Turning On the Printer 
WARNING: Do not use extension cords or power strips.
 

WARNING: The printer should not be connected to an Uninterruptible Power Supply (UPS) system.
 

Connect the power cable to the power connector on the back of your printer (see "Rear View" on page 22). 

2 Connect the other end of the cable to the power source. 

3 Turn on the printer. 
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Setting Up Your Printer 

Setting Initial Settings on the Operator Panel 
(Dell™ C1660w Color Printer Only) 
You need to set the printer language and whether to enable wireless LAN when you turn on the printer for the first 
time. 

When you turn the printer on, the wizard screen to perform the initial setup appears on the operator panel. Follow 
the steps below to set the initial settings. 

NOTE: If you do not start configuring the initial settings, the printer automatically restarts in three minutes. After that, you can 
set the following initial setup by enabling Power On Wizard on the operator panel or Dell Printer Configuration Web Tool 
if needed. 

NOTE: For more information on operator panel, see "Operator Panel" on page 77. 

NOTE: For more information on Dell Printer Configuration Web Tool, see "Dell™ Printer Configuration Web Tool" on page 81. 

Ensure that Language appears. Press the button until the desired language appears, and then press the 
(Set) button. 

English 

Français 

Italiano 

Deutsch 

Español 

Dansk 

Nederlands 

Norsk 

Svenska 

Ensure that Wireless appears. Press the button until the desired selection appears, and then press the 
(Set) button.
 

The printer automatically restarts.
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Printer Setup Using the Software and Documentation Disc 
1 Insert the Software and Documentation disc into your computer to start Dell Printer Setup. 

2	 Double-click the Dell C1760/C1660 Installer icon, and follow the on-screen instructions to connect the computer 
and the printer. 

NOTE: If the Software and Documentation disc does not automatically launch, try the following steps. 

For Windows® XP, Windows Vista®, Windows 7, Windows Server® 2003, Windows Server 2008, and Windows 
Server 2008 R2: 

1 Click Start → All Programs (for Windows Vista and Windows 7) → Accessories (for Windows Vista and 
Windows 7) → Run. 

2 Type D:\setup_assist.exe (where D is the drive letter of the optical drive), and then click OK. 

For Windows 8 and Windows Server 2012: 

1 Point to the bottom right corner of the screen, and then click Search → Type Run in the search box, click Apps, 
and then click Run. 

2 Type D:\setup_assist.exe (where D is the drive letter of the optical drive), and then click OK. 
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7 
Setting the IP Address 

Assigning an IP Address 
An IP address is a unique number that consists of four sections that are delimited by a period and can include up to 

three digits in each section, for example, 111.222.33.44.
 

You can select the IP mode from Dual Stack, IPv4, and IPv6. If your network supports both IPv4 and IPv6, select 

Dual Stack.
 

CAUTION: Assigning an IP address that is already in use can cause network performance issues. 

NOTE: Assigning an IP address is considered as an advanced function and is normally done by a system administrator. 

NOTE: When you assign an IP address manually in IPv6 Mode, use the Dell™ Printer Configuration Web Tool. To open the Dell 
Printer Configuration Web Tool, use the link local address. To check a link local address, see "Verifying the IP Settings" on 
page 41. 

NOTE: Depending on the address class, the range of the IP address assigned may be different. On Class A, for example, an IP 
address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment of IP addresses, contact 
your system administrator. 

You can assign the IP address by using the operator panel or using the Tool Box. 

The Operator Panel 
For more information on using your operator panel, see "Operator Panel" on page 77. 

NOTE: A Password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter 
the password you specified, and press the (Set) button. 

1 Turn on the printer.
 

The Ready to Print message appears on the operator panel.
 

2 Press the 
 (Menu) button.
 

3 Press the 
 button until Admin Menu appears, and then press the (set) button.
 

4 Ensure that Network appears, and then press the 
 (set) button.
 

5 Press the 
 button until TCP/IP appears, and then press the (set) button.
 

6 Press the 
 button until IPv4 appears, and then press the (set) button.
 

7 Ensure that  Get IP Address appears, and then press the 
 (set) button.
 

8 Press the 
 button until Panel appears, and then press the (set) button.
 

9 Press the 
 button and ensure that Get IP Address appears.
 

10 Press the 
 button until IP Address appears, and then press the (set) button. 
The cursor is located at the first digit of the IP address.
 

11 Press the 
 or  button to enter the numbers for the IP address.
 

12 Press the 
 button. 

The next digit is selected. 

13 Repeat step 11 and step 12 to enter all the digits in the IP address, and then press the (set) button.
 

14 Press the 
 button and ensure that IP Address appears.
 

15 Press the 
 button until Subnet Mask appears, and then press the (set) button.
 
The cursor is located at the first digit of the subnet mask.
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16 Press the  or the  button to enter the numbers for the subnet mask. 

17 Press the button. 

The next digit is selected. 

18 Repeat step 16 and step 17 and set subnet mask, and then press the (set) button. 

19 Press the button and ensure that Subnet Mask appears. 

20 Press the button until Gateway Address appears, and then press the 
The cursor is located at the first digit of the gateway address. 

(set) button. 

21 Press the or  button to enter the numbers for the gateway address. 

22 Press the button. 

The next digit is selected. 

23 Repeat step 21 and step 22 to set gateway address, and then press the (set) button. 

24 Turn off and turn on the printer. 

The Tool Box 

NOTE: When you use IPv6 Mode for network printing, the Tool Box cannot be used to assign an IP address. 

1 Click Start → All Programs → Dell Printers → Dell C1760nw Color Printer or Dell C1660w Color Printer 
→ Tool Box. 

NOTE: The Select Printer dialog box opens in this step, when multiple printer drivers are installed on your computer. In this 
case, click the name of Dell C1760nw Color Printer or Dell C1660w Color Printer listed in Printer Name, and then click OK. 

The Tool Box opens. 

2 Click the Printer Maintenance tab. 

3 Select TCP/IP Settings from the list at the left side of the page. 

The TCP/IP Settings page is displayed. 

4 Select the mode from IP Address Mode, and then enter the values in IP Address, Subnet Mask, and Gateway 
Address. 

5 Press the Apply New Settings button to take effect. 

The IP address is assigned to your printer. To verify the setting, open the web browser on any computer connected to the 
network and enter the IP address into the address bar on the browser. If the IP address is set up correctly, the Dell Printer 
Configuration Web Tool displays in your browser. 

You can also assign the IP address to the printer when installing the printer drivers with installer. When you use the 
Network Installation feature, and the Get IP Address is set to AutoIP on the operator panel menu, you can set 
the IP address from 0.0.0.0 to the desired IP address on the printer selection window. 
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Verifying the IP Settings 
You can confirm the settings by using the operator panel, printing the printer settings report, or using the ping 
command. 

NOTE: A Password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter 
the password you specified, and press the (Set) button. 

The Operator Panel 
1 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (set) button.
 

3 Ensure that Network appears, and then press the 
 (set) button.
 

4 Press the 
 button until TCP/IP appears, and then press the (set) button.
 

5 Press the 
 button until IPv4 appears, and then press the (set) button.
 

Check the IP address displayed on the operator panel.
 

The System Settings Report 
1 Print the system settings report. 

For details about how to print a system settings report, see "Printing a Report/List Using the Operator Panel" on 
page 125. 

2 Verify the correct IP address, subnet mask, and gateway address are listed in the system settings report under Wired 
Network or Wireless Network. 

If the IP address shows 0.0.0.0 (the factory default), an IP address has not been assigned. To assign one for your 
printer, see "Assigning an IP Address" on page 39. 

The Ping Command 
Ping the printer and verify that it responds. For example, at a command prompt on a network computer, type ping 
followed by the new IP address (for example, 192.168.0.11): 

ping 192.168.0.11 

If the printer is active on the network, you will receive a reply. 

Setting the IP Address 41 

http:192.168.0.11
http:192.168.0.11


42
 Setting the IP Address 



  

   

  

    

   

  

8 

1 

2 

Loading Paper 
NOTE: The priority sheet inserter (PSI) is available for Dell™ C1760nw Color Printer only. 

NOTE: The images used in this manual are those of the Dell C1760nw Color Printer unless otherwise mentioned. 

NOTE: To avoid paper jams, do not remove the priority sheet inserter while a printing is in progress. 

NOTE: Use only laser print media. Do not use ink jet paper in your printer. 

NOTE: For printing envelopes, see "Loading Print Media" on page 151. 

Loading Print Media in the Multipurpose Feeder (MPF) 
NOTE: The PSI is available for Dell C1760nw Color Printer only. 

Open the front cover by pulling out the instruction sheet. 

Pull the PSI out. 
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Remove the instruction sheet attached to the PSI with adhesive tape. 

NOTE: Read the instruction sheet before you use the PSI. 

Pull the length guide forward until it stops. 

Pull the MPF extension forward until it stops. 
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Adjust the paper width guides to their maximum. 

Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack 
on a level surface. 

Load print media on the MPF with the top edge first and with the recommended print side facing up. 
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9 Adjust the width guides until they rest lightly against the edges of the stack of print media. 

10 Slide the length guide towards the printer until it touches the print media. 

NOTE: Depending on the size of print media, first slide the length guide backward until it stops, and then slide the MPF 
extension until it touches print media. 
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11 Insert the PSI into the printer and then align the PSI to the marking on the paper tray. 

12	 Select the paper type from the printer driver if the loaded print media is not standard plain paper. 
If a user-specified print media is loaded in the MPF, you must specify the paper size setting by using the printer 
driver. 
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Loading Print Media in the Priority Sheet Inserter (PSI) 
(Dell C1760nw Color Printer only) 

Open the front cover. 

Slide the PSI forward, and then align the PSI to the marking on the paper tray. 

Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack 
on a level surface. 
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Load print media on the PSI with the top edge first and with the recommended print side facing up. 

Adjust the width guides until they rest lightly against the edges of the stack of print media. 

Select the paper type from the printer driver if the loaded print media is not standard plain paper.
 
If a user-specified print media is loaded in the PSI, you must specify the paper size setting by using the printer 

driver.
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9 
Installing Printer Drivers on Computers Running 
Windows® 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

Identifying Printer Driver Pre-install Status 
Before installing the printer driver on your computer, check the IP address of your printer by performing one of the 
procedures in "Verifying the IP Settings" on page 41. 

Changing the firewall settings before installing your printer 
If you are running one of the following operating systems, you must change the firewall settings before installing the 
Dell printer software: 

• Microsoft® Windows XP 

• Windows Vista® 

• Windows 7  

• Windows 8  

• Windows Server® 2008 

• Windows Server 2008 R2 

• Windows Server 2012 

NOTE: For Windows XP, Service Pack 2 or 3 must be installed. 

The following procedure uses Windows 7 as an example. 

1 Insert the Software and Documentation disc into your computer. 

2 Click Start → Control Panel. 

3 Select System and Security. 

4 Click Allow a program through Windows Firewall. 

5 Click Change settings → Allow another program. 

6 Check Browse. 

7 D:\setup_assist.exe (where D is the drive letter of the optical drive) in the File name text box, and then 
click Open.
 

8 Click Add, and then click OK.
 

Direct Connection Setup 

For installing host-based printer driver 
1 Insert the Software and Documentation disc into your computer to start Dell Printer Setup. 

2 Click Install Printer Driver and Software. 

3 Select Personal Installation, and then click Next. 
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4	 Follow the on-screen instructions to connect the computer and the printer with a USB cable, and then turn on the 
printer. 

The Plug and Play installation starts and the installation software proceeds to the next page automatically. 

5	 Click Finish to exit the wizard when the Ready to Print! screen appears. If necessary, click Print Test Page to print 
a test page. 

Personal Installation 

A personal printer is a printer attached to your computer or a print server using a USB. If your printer is attached to 
a network and not your computer, see "Network Connection Setup" on page 54. 

For installing XML Paper Specification (XPS) printer driver 

NOTE: Download and install the XPS printer driver at support.dell.com. 

NOTE: The XPS driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit Edition, Windows 
7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, 
Windows Server 2008 R2, and Windows Server 2012. 

Windows Vista or Windows Vista 64-bit Edition 

1 Extract the zip file you downloaded to your desired location. 

2 Click Start → Control Panel → Hardware and Sound → Printers. 

3 Click Add a printer. 

4 Click Add a local printer. 

5 Select the port connected to this product, and then click Next. 

6 Click Have Disk to display the Install From Disk dialog box. 

7 Click Browse, and then select the extracted folder in step 1. 

8 Click OK. 

9 Select your printer name and click Next. 

10	 To change the printer name, enter the printer name in the Printer name box. To use this printer as the default 
printer, select the check box displayed under the Printer name. Click Next. 

Installation starts. 

If the User Account Control dialog box appears, click Continue. 

NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action. 

11 As the driver installation is completed, click Print a test page to print a test page.
 

12 Click Finish.
 

Windows Server 2008 or Windows Server 2008 64-bit Edition 

NOTE: You must log in as an administrator.
 

1 Extract the zip file you downloaded to your desired location.
 

2 Click Start → Control Panel → Hardware and Sound → Printers.
 

3 Click Add a printer.
 

4 Click Add a local printer.
 

5 Select the port connected to this product, and then click Next.
 

6 Click Have Disk to display the Install From Disk dialog box.
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7 Click Browse, and then select the extracted folder in step 1.
 

8 Click OK.
 

9 Select your printer name and click Next. 


10 To change the printer name, enter the printer name in the Printer name box. 

To use this printer as the default printer, select the Set as the default printer check box. Click Next. 

Installation starts. 

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next. 

12 As the driver installation is completed, click Print a test page to print a test page. 

13 Click Finish. 

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2 

1 Extract the zip file you downloaded to your desired location. 

2 Click Start → Devices and Printers. 

3 Click Add a printer. 

4 When you use Windows Server 2008 R2, click Add a local or network printer as an administrator. 

If the User Account Control dialog box appears, click Yes. 

NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action. 

5 Click Add a local printer.
 

6 Select the port connected to this product, and then click Next.
 

7 Click Have Disk to display the Install From Disk dialog box.
 

8 Click Browse, and then select the extracted folder in step 1.
 

9 Click OK.
 

10 Select your printer name and click Next. 

11 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

Installation starts. 

12 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next. 

13 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box. 

14 Click Finish. 

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012 

1 Extract the zip file you downloaded to your desired location. 

2 Right-click the bottom left corner of the screen, and then click Control Panel. 

3 Click Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers → Add a printer. 

4 Click Have Disk to display the Install From Disk dialog box. 

5 Click Browse, and then select the extracted folder in step 1. 

6 Click OK. 

7 Select your printer name and click Next. 
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8 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

Installation starts. 

9 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next. 

10 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box. 

11 Click Finish. 

Network Connection Setup 

Network Printer Setup on a Local Network 

For installing host-based printer driver 

1 Insert the Software and Documentation disc into your computer to start Dell Printer Setup. 

2 Click Install Printer Driver and Software. 

3 Select Network Installation, and then click Next. 

4 Select Local Installation, and then click Next. 

5 Select the printer you want to install from the printer list, and then click Next. If the target printer is not displayed 
on the list, click Refresh to refresh the list or click Add Printer to add a printer to the list manually. You may specify 

the IP address and port name at this point.
 

If you have installed this printer on the server computer, select I am setting up this printer on a server check box.
 

NOTE: When using AutoIP, 0.0.0.0 is displayed in the installer. Before you can continue, you must enter a valid IP address. 

NOTE: You can install the Web Services on Devices (WSD) printer, but the installation of using Windows Server 2008 is not 
supported. 

NOTE: If you are running any of the following operating systems, a Windows Security Alert is displayed: 

•	 Windows Vista 

•	 Windows Vista 64-bit Edition 

•	 Windows 7 

•	 Windows 7 64-bit Edition 

•	 Windows 8 

•	 Windows 8 64-bit Edition 

•	 Windows Server 2008 

•	 Windows Server 2008 64-bit Edition 

•	 Windows Server 2008 R2 64-bit Edition 

• Windows Server 2012 

To continue installing the host-based printer driver, click Unblock or Allow access (for Windows Server 2008 R2 
and Windows 7). 

6	 Specify the printer settings, and then click Next. 

a Enter the printer name. 

b If you want other users on the network to access this printer, select Share this printer with other computers on 
the network, and then enter a share name that users can identify.
 

c If you want to set a printer as the default, select the Set this printer as default check box.
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7 Select the software and documentation you want to install, and then click Install. You can specify folders in which 
to install the Dell software and documentation. To change the folders, click Browse. 

8 Click Finish to exit the wizard when the Ready to Print! screen appears. If necessary, click Print Test Page to print 
a test page. 

For installing XML Paper Specification (XPS) printer driver 

NOTE: Download and install the XPS printer driver at support.dell.com. 

NOTE: The XPS driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit Edition, Windows 
7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition., 
Windows Server 2008 R2, and Windows Server 2012. 

Windows Vista or Windows Vista 64-bit Edition 

1 Extract the zip file you downloaded to your desired location. 

2 Click Start → Control Panel → Hardware and Sound → Printers. 

3 Click Add a printer. 

4 Click Add a network, wireless or Bluetooth printer. 

5 Select printer or click The printer that I want isn't listed. 

6 Select Add a printer using a TCP/IP address or hostname, and then click Next. 

7 Select TCP/IP Device for Device type, and enter the IP address for Hostname or IP address, and then click Next. 

If the User Account Control Continue dialog box appears, click Continue. 

NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action. 

8 Click Have Disk to display the Install From Disk dialog box. 

9 Click Browse, then select the extracted folder in step 1, and then click OK. 

10 Select your printer name and click Next. 

11 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

To use this printer as the default printer, select the Set as the default printer check box.
 

Installation starts.
 

If the User Account Control dialog box appears, click Continue.
 

NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action. 

12 As the driver installation is completed, click Print a test page to print a test page.
 

13 Click Finish.
 

Windows Server 2008 or Windows Server 2008 64-bit Edition 

NOTE: You must log in as an administrator.
 

1 Extract the zip file you downloaded to your desired location.
 

2 Click Start → Control Panel → Hardware and Sound → Printers.
 

3 Click Add a printer.
 

4 Click Add a network, wireless or Bluetooth printer.
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5	 Select your printer or click The printer that I want isn't listed.
 

When you select your printer, go to step 8.
 

When you click The printer that I want isn't listed, go to step 6.
 

6 Select Add a printer using a TCP/IP address or hostname, and then click Next.
 

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click
 
Next. 

If the User Account Control Continue dialog box appears, click Continue.
 

8 Click Have Disk to display the Install From Disk dialog box.
 

9 Click Browse, then select the extracted folder in step 1, and then click OK.
 

10 Select your printer name and click Next. 

11 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

To use this printer as the default printer, select the Set as the default printer check box. 

Installation starts. 

12 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next. 

13 As the driver installation is completed, click Print a test page to print a test page. 

14 Click Finish. 

Windows Server 2008 R2 

1 Extract the zip file you downloaded to your desired location. 

2 Click Start → Devices and Printers. 

3 Click Add a printer. 

4 Click Add a network, wireless or Bluetooth printer. 

5 Select your printer or click The printer that I want isn't listed. 

NOTE: When you click The printer that I want isn't listed, Find a printer by name or TCP/IP screen appears where you can 
find your printer using your printer name or TCP/IP. 

If the User Account Control dialog box appears, click Yes. 

NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action. 

6 Click Have Disk to display the Install From Disk dialog box.
 

7 Click Browse, then select the extracted folder in step 1, and then click OK.
 

8 Select your printer name and click Next.
 

9 To change the printer name, enter the printer name in the Printer name box, and then click Next.
 

10 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. 

11 Click Next. 

Installation starts. 

12 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box. 

13 Click Finish. 
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Windows 7 or Windows 7 64-bit Edition 

1 Extract the zip file you downloaded to your desired location.
 

2 Click Start → Devices and Printers.
 

3 Click Add a printer.
 

4 Click Add a network, wireless or Bluetooth printer.
 

5 Select your printer or click The printer that I want isn't listed.
 

When you select your printer, go to step 8.
 

When you click The printer that I want isn't listed, go to step 6.
 

6 Select Add a printer using a TCP/IP address or host name, and then click Next.
 

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click
 
Next.
 

If the User Account Control dialog box appears, click Yes.
 

NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action. 

8 Click Have Disk to display the Install From Disk dialog box. 

9 Click Browse, then select the extracted folder in step 1, and then click OK. 

10 Select your printer name and click Next. 

11 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

Installation starts. 

12 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box. 

13 Click Finish. 

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012 

1 Extract the zip file you downloaded to your desired location. 

2 Right-click the bottom left corner of the screen, and then click Control Panel. 

3 Click Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers → Add a printer. 

4 Click Have Disk to display the Install From Disk dialog box. 

5 Click Browse, and then select the extracted folder in step 1. 

6 Click OK. 

7 Select your printer name and click Next. 

8 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

Installation starts. 

9 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next. 

10 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box. 

11 Click Finish. 
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Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your 
desk. You can view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering 
replacement consumables. You can click the Dell supplies link for ordering supplies. 

NOTE: The Dell Printer Configuration Web Tool is not available when the printer is directly connected to a computer or a print 
server. 

To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. The printer 

configuration appears on the screen.
 

You can set up the Dell Printer Configuration Web Tool to send you an e-mail when the printer needs supplies or 

intervention.
 

To set up e-mail alerts:
 

1 Launch the Dell Printer Configuration Web Tool. 

2 Click E-Mail Alert link. 

3 Under E-Mail Server Settings, enter the Primary SMTP Gateway, Reply Address, and your or key operator's e-mail 
address in the e-mail list box. 

4 Click Apply New Settings. 

NOTE: Connection pending until printer sends an alert is displayed on the SMTP server until an error occurs. 

Network Printer Setup on a Remote Network 

Before Installation 

Before you start remote installation, perform the following procedures. 

Allow Print Spooler to Accept Client Connections 

NOTE: This step is required for Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit Edition, Windows 7, Windows 7 
64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition, Windows Server 2008, Windows Server 2008 64-bit 
Edition, Windows Server 2008 R2. 

For Windows XP 64-bit Edition, Windows Vista, Windows Server 2003, and Windows Server 2008: 

1 Click Start → All Programs (for Windows Vista only) → Accessories (for Windows Vista only) → Run. 

2 Type gpedit.msc, and then click OK. 

3 Click Computer Configuration → Administrative Templates → Printers. 

4 Right-click Allow Print Spooler to accept client connections and select Properties. 

5 On the Setting tab, select Enabled, and then click OK. 

6 Restart the computer. 

For Windows Server 2008 R2 and Windows 7: 

1 Click Start → All Programs (for Windows 7 only) → Accessories (for Windows 7 only) → Run. 

2 Type gpedit.msc, and then click OK. 

3 Click Computer Configuration → Administrative Templates → Printers. 

4 Right-click Allow Print Spooler to accept client connections and select Edit. 

5 Select Enabled, and then click OK. 

6 Restart the computer. 
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Share the Firewall File and Printer 

NOTE: This step is required for Windows XP, Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit Edition, Windows 
7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, 
Windows Server 2008 R2, and Windows Server 2012. 

For Windows XP: 

1 Click start → Control Panel. 

2 Select Security Center. 

3 Click Windows Firewall. 

4 On the Exceptions tab, check the File and Printer Sharing check box, and then click OK. 

For Windows Vista: 

1 Click Start → Control Panel. 

2 Select Security. 

3 Click Windows Firewall. 

4 Click Change settings. 

5 Click Continue. 

6 On the Exceptions tab, check the File and Printer Sharing check box, and then click OK. 

For Windows Server 2008: 

1 Click Start → Control Panel. 

2 Double-click Windows Firewall. 

3 Click Change settings. 

4 On the Exceptions tab, check the File and Printer Sharing check box, and then click OK. 

For Windows Server 2008 R2 and Windows 7: 

1 Click Start → Control Panel. 

2 Select System and Security. 

3 Click Windows Firewall. 

4 Click Allow a program or feature through Windows Firewall. 

5 If the check boxes under Allowed programs and features: are dimmed, click Change settings. 

6 Check the File and Printer Sharing check box. Home/Work (Private) or Public check box is automatically selected 
according to your settings.
 

If File and Printer Sharing Properties dialog box appears, click OK.
 

7 Click OK.
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Start Remote Registry 

NOTE: This step is required for Windows Vista, Windows Vista 64-bit Edition, Windows 7, Windows 7 64-bit Edition, Windows 8, 
and Windows 8 64-bit Edition. 

1 Click Start → Control Panel.
 

2 Select System and Maintenance (System and Security for Windows 7).
 

3 Click Administrative Tools.
 

4 Double-click Services.
 

5 Click Continue (for Windows Vista only).
 

6 Right-click Remote Registry and select Start.
 

7 Right-click Remote Registry and select Properties.
 

8 Change Startup type: to Automatic, and then click OK.
 

Disable User Account Control 

NOTE: Disabling the User Account Control might leave the system vulnerable to virus attacks. 

NOTE: This step is required for Windows Vista, Windows Vista 64-bit Edition, Windows 7, Windows 7 64-bit Edition, Windows 
Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2. 

For Windows Vista: 

1 Click Start → Control Panel. 

2 Select User Accounts and Family Safety. 

3 Click User Accounts. 

4 Click Turn User Account Control on or off. 

5 Click Continue. 

6 Clear the Use User Account Control (UAC) to help protect your computer check box. 

7 Restart the computer. 

For Windows Server 2008: 

1 Click Start → Control Panel. 

2 Double-click User Accounts. 

3 Click Turn User Account Control on or off. 

4 Click Continue. 

5 Clear the Use User Account Control (UAC) to help protect your computer check box. 

6 Click OK. 

7 Restart the computer. 

For Windows Server 2008 R2: 

1 Click Start → Control Panel. 

2 Select User Accounts. 

3 Click User Accounts. 

4 Click Change User Account Control Settings. 

5 Move the slider to the bottom, and then click OK. 

6 Click Yes. 

7 Restart the computer. 
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For Windows 7: 

1 Click Start → Control Panel.
 

2 Select User Accounts and Family Safety.
 

3 Click User Accounts.
 

4 Click Change User Account Control Settings.
 

5 Move the slider to the bottom, and then click OK.
 

6 Click Yes in User Account Control dialog box.
 

7 Restart the computer.
 

Enable Network Discovery and File Sharing for all Public Networks 

NOTE: This step is required when you use Windows Vista, Windows Vista 64-bit Edition, Windows 7, Windows 7 64-bit Edition, 
Windows 8, Windows 8 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2,  and 
Windows Server 2012 for the server computer. 

For Windows 7, Windows 7 64-bit Edition, Windows Server 2008 R2: 

1 Click Start → Control Panel → Network and Internet → Network and Sharing Center → Change advanced 
sharing settings. 

2 To allow your computer to be found on the network, and to allow other computers on the network to share the files 
and folders on your computer, click Turn on network discovery.
 

3 Click Save changes.
 

4 If you see the User Account Control dialog box, click Yes.
 

For Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition: 

1 Click Start → Network. 

2 Right-click Network and select Properties. 

The Network an Sharing Center screen appears. 

3 Click the down arrow button next to either Network discovery. 

4 To allow your computer to be found on the network, and to allow other computers on the network to share the files 
and folders on your computer, click Turn on network discovery. 

5 Click Apply. 

6 If the User Account Control dialog box appears, click Continue. 

Disable Simple File Sharing 

NOTE: This step is required for Windows XP, and Windows XP 64-bit Edition.
 

1 Click Start → Control Panel.
 

2 Select Appearance and Themes.
 

3 Select Folder Options.
 

4 On the View tab, clear the Use simple file sharing (Recommended) check box, and then click OK.
 

5 Click Start → Control Panel.
 

6 Select Performance and Maintenance.
 

7 Select Administrative Tools.
 

8 Double-click Local Security Policy.
 

9 Click Local Policies → Security Options.
 

10 Right-click Network access: Sharing and security model for local accounts and select Properties. 
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11 Ensure that Classic - local users authenticate as themselves is selected. 

12	 Click OK. 

Installing the Printer Driver 

NOTE: Installation on Windows XP Home Edition, Windows Vista Home Basic, Windows Vista Home Premium, Windows Vista 
x64 Home Basic, Windows Vista x64 Home Premium, Windows 7 Starter, Windows 7 Home Basic, Windows 7 Home Premium, 
Windows 7 x64 Home Basic, and Windows 7 x64 Home Premium, Windows 8, Windows 8 x64, Windows 8 Pro, Windows 8 x64 
Pro, and Windows Server 2012 is not supported. 

1 Insert the Software and Documentation disc provided with the printer in your computer. The Dell Printer Setup 
file launches automatically. 

2 Click Install Printer Driver and Software. 

The Choose an installation type screen appears. 

3 Select Network Installation, and then click Next. 

4 Select Remote Installation, and then click Next. 

5 Enter the Administrator user name and password of the client computer, then select the clients or servers, and then 
click Next. 

NOTE: If you are running any of the following operating systems, a Windows Security Alert is displayed: 

•	 Windows Vista 

•	 Windows Vista 64-bit Edition 

•	 Windows 7 

•	 Windows 7 64-bit Edition 

•	 Windows Server 2008 

•	 Windows Server 2008 64-bit Edition 

• Windows Server 2008 R2 64-bit Edition 

To continue installing the host-based printer driver, click Unblock or Allow access (for Windows Server 2008 R2 
and Windows 7).
 

6 Check if the printer to be installed is listed in Select Printer, and then click Next.
 

NOTE: If the printer to be installed is not listed in Select Printer, try the following steps: 

•	 Click Refresh to update the information. 

•	 Click Add Printer, and then enter a port name (any alphanumeric string of your choosing) and an existing IP address 
for the printer. 

7 Select the required items on Software and Documentation, and then click Install.
 

8 Click Finish to exit this tool.
 

Setting Up for Web Services on Devices (WSD) 
This section provides information for network printing with WSD, the protocol of Microsoft for Windows Vista, 
Windows 7, Windows 8, Windows Server 2008, Windows Server 2008 R2, and Windows Server 2012. 

Adding Roles of Print Services 
When you use Windows Server 2008 or Windows Server 2008 R2, you need to add the roles of print services to the 
Windows Server 2008 or Windows Server 2008 R2 client. 
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For Windows Server 2008 R2: 

1 Click Start → Administrative Tools → Server Manager.
 

2 Select Add Roles from the Action menu.
 

3 Check the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, and 

then click Next.
 

4 Click Next.
 

5 Check the Print Server check box, and then click Next.
 

6 Click Install.
 

For Windows Server 2008: 

1 Click Start → Administrative Tools → Server Manager.
 

2 Select Add Roles from the Action menu.
 

3 Check the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click Next.
 

4 Check the Print Server check box, and then click Next.
 

5 Click Install.
 

For Windows Server 2012: 

1 Click Server Manager of the Start screen. 

2 Select Add Roles and Features from the Manage menu. 

3 Click Next on the Before You Begin window → Select installation type on the Installation Type window → Select 
destination server on the Server Selection window in the Add Roles and Features Wizard.
 

4 Check the Print and Document Services check box on the Server Roles window, and then click Next.
 

5 Select features on the Features window → Confirm installation selections on the Confirmation window.
 

6 Click Install.
 

WSD Printer Setup 
You can install your new printer on the network using Windows Add Printer wizard. When installing using the 
Software and Documentation disc that shipped with your printer, see "Network Connection Setup" on page 54 for 
details. 

NOTE: Installing WSD printer for Windows 8, Windows Server 2008, Windows Server 2008 R2, and Windows Server 2012 is 
available only with the Add Printer wizard. 

Installing a Printer Driver Using the Add Printer Wizard 

1 For Windows Vista, Windows 7, Windows Server 2008, and Windows Server 2008 R2: 
Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for Windows 
Server 2008 and Windows Vista). 

For Windows 8, Windows Server 2012: 
Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware 
for Windows Server 2012) → Devices and Printers. 

2 Click Add a printer to launch the Add Printer wizard. 

3 Select Add a network, wireless or Bluetooth printer. 

4 In the list of available printers, select the one you want to use, and then click Next. 

NOTE: In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/. 
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NOTE:  If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. To enter 
the printer's IP address manually, follow the instructions below. For Windows Server 2008 R2, to create a WSD printer, you 
must be a member of Administrators group. 
1. Click The printer that I want isn't listed. 
2. Select Add a printer using a TCP/IP address or hostname and click Next. 
3. Select Web Services Device from Device type. 
4. Enter the printer's IP address in the Hostname or IP address text box and click Next. 

NOTE: Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, perform one of 
the followings: 

•	 Establish the Internet connection so that Windows Update can scan your computer. 

• Add the printer driver to your computer in advance. 

5 Install the printer driver on your computer. If you are prompted for an administrator password or confirmation, 
type the password or provide confirmation. 

6 Complete the additional steps in the wizard, and then click Finish. 

7 Print a test page to verify print installation. 

a	 For Windows Vista, Windows 7, Windows Server 2008, and Windows Server 2008 R2: 
Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for 
Windows Server 2008 and Windows Vista). 

For Windows 8, Windows Server 2012: 
Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound 
(Hardware for Windows Server 2012) → Devices and Printers. 

b	 Right-click the printer you just created, and then click Printer properties (Properties for Windows Server 2008 
and Windows Vista). 

c On the General tab, click Print Test Page. When a test page is printed successfully, installation is complete. 

Setting Up for Shared Printing 
You can share your new printer on the network using the Software and Documentation disc that shipped with your 
printer, or using Windows Point and Print or peer-to-peer method. However, if you use either of the Microsoft 
methods you will not get features such as the status monitor and other printer utilities, which will get installed with 
the Software and Documentation disc. 

If you want to use the printer on a network, share the printer and install its drivers on all the computers on the 
network. 

NOTE: You need to purchase the Ethernet cable separately for shared printing. 

For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition 

1	 Click Start → Printers and Faxes. 

2 Right-click this printer icon and select Properties. 

3 From the Sharing tab, check the Share this printer check box, and then type a name in the Share name text box. 

4 Click Additional Drivers and select the operating systems of all network clients using this printer. 

5	 Click OK. 

If the files are not present in your computer, then you will be prompted to insert the server operating system CD. 

For Windows Vista, Windows Vista 64-bit Edition 

1	 Click Start → Control Panel → Hardware and Sound → Printers. 

2 Right-click the printer icon and select Sharing. 
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3 Click Change sharing options.
 

4 The "Windows needs your permission to continue" appears.
 

5 Click Continue.
 

6 Select the Share this printer check box, and then type a name in the Share name text box.
 

7 Select Additional Drivers and select the operating systems of all network clients using this printer.
 

8 Click OK.
 

For Windows Server 2008, Windows Server 2008 64-bit Edition 

1 Click Start → Control Panel → Printers.
 

2 Right-click the printer icon and select Sharing.
 

3 Click Change Sharing Options if exists.
 

4 Select the Share this printer check box, and then type a name in the Share name text box.
 

5 Click Additional Drivers and select the operating systems of all network clients using this printer.
 

6 Click OK.
 

For Windows 7, Windows 7 64-bit Edition, Windows Server 2008 R2 

1 Click Start → Devices and Printers. 

2 Right-click the printer icon and select Printer properties. 

3 On the Sharing tab, click Change Sharing Options if exists. 

4 Select the Share this printer check box, and then type a name in the Share name text box. 

5 Click Additional Drivers and select the operating systems of all network clients using this printer. 

6 Click Apply, and then click OK. 

For Windows 8, Windows 8 64-bit Edition, Windows Server 2012 

1 Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware 
for Windows Server 2012) → Devices and Printers.
 

2 Right-click the printer icon and select Printer properties.
 

3 On the Sharing tab, click Change Sharing Options if exists.
 

4 Select the Share this printer check box, and then type a name in the Share name text box.
 

5 Click Additional Drivers and select the operating systems of all network clients using this printer.
 

6 Click Apply, and then click OK.
 

To check that the printer is shared: 

•	 Ensure that the printer object in the Printers, Printers and Faxes, or Devices and Printers folder is shared. The 

share icon is shown under the printer icon.
 

• Browse  Network or My Network Places. Find the host name of the server and look for the shared name you 
assigned to the printer. 

Now that the printer is shared, you can install the printer on network clients using the Point and Print method or the 
peer-to-peer method. 
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Point and Print 
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This feature 
automatically downloads and installs the printer driver. 

For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition 

1 On the Windows desktop of the client computer, double-click My Network Places. 

2 Locate the host name of the server computer, and then double-click the host name. 

3 Right-click the shared printer name, and then click Connect. 

Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Printers and Faxes folder. The time taken to copy varies based on the network traffic. 

Close My Network Places. 

4 Print a test page to verify installation. 

a Click start (Start for Windows Server 2003 / Windows Server 2003 x64 Edition) → Settings (for Windows XP 
/ Windows XP 64-bit Edition) → Printers and Faxes. 

b Select the printer you have installed. 

c Click File → Properties. 

d On the General tab, click Print Test Page. 

When a test page is printed successfully, installation is complete. 

For Windows Vista, Windows Vista 64-bit Edition 

1 Click Start → Network. 

2 Locate and double-click the host name of the server computer. 

3 Right-click the shared printer name, and then click Connect. 

4 Click Install driver. 

5 Click Continue in User Account Control dialog box. 

Wait until the driver is copied from the server to the client computer. A new printer object is added to the Printers 
folder. The duration of this procedure may vary based on the network traffic. 
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6	 Print a test page to verify installation.
 

a Click Start → Control Panel → Hardware and Sound.
 

b Select Printers.
 

c Right-click the printer you just created and select Properties.
 

d On the General tab, click Print Test Page.
 

When a test page is printed successfully, installation is complete. 

For Windows Server 2008, Windows Server 2008 64-bit Edition 

1 Click Start → Network. 

2 Locate the host name of the server computer, and then double-click the host name. 

3 Right-click the shared printer name, and then click Connect. 

4 Click Install driver. 

5 Wait until the driver is copied from the server to the client computer. A new printer object will be added to the 
Printers folder. The time taken for these activities varies based on network traffic. 

6	 Print a test page to verify installation.
 

a Click Start → Control Panel.
 

b Select Printers.
 

c Right-click the printer you just created and select Properties.
 

d On the General tab, click Print Test Page.
 

When a test page is printed successfully, installation is complete. 

For Windows 7, Windows 7 64-bit Edition, Windows Server 2008 R2 

1 Click Start → your user name → Network (Start → Network for Windows Server 2008 R2)..
 

2 Locate the host name of the server computer, and then double-click the host name.
 

3 Right-click the shared printer name, and then click Connect.
 

4 Click Install driver.
 

5 Wait until the driver is copied from the server to the client computer. A new printer object will be added to the 

Printers folder. The time taken for these activities varies based on network traffic. 

6	 Print a test page to verify installation.
 

a Click Start → Devices and Printers.
 

b Right-click the printer you just created and select Printer properties.
 

c On the General tab, click Print Test Page.
 

When a test page is printed successfully, installation is complete. 

For Windows 8, Windows 8 64-bit Edition, Windows Server 2012 

1 Point to the bottom right corner of the screen, and then click Search → Type Network in the search box, click 
Apps, and then click Network. 

2 Locate the host name of the server computer, and then double-click the host name. 

3 Right-click the shared printer name, and then click Connect. 

4 Click Install driver. 

5 Wait until the driver is copied from the server to the client computer. A new printer object will be added to the 
Printers folder. The time taken for these activities varies based on network traffic. 
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6	 Print a test page to verify installation.
 

a Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound
 
(Hardware for Windows Server 2012) → Devices and Printers.
 

b Right-click the printer you just created and select Printer properties.
 

c On the General tab, click Print Test Page.
 

When a test page is printed successfully, installation is complete. 

Peer-to-Peer 
If you use the peer-to-peer method, the printer driver is installed on each client computer. The client computers can 
modify the drivers and handle the print jobs. 

For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition 

1 Click start (Start for Windows Server 2003 / Windows Server 2003 x64 Edition) → Settings (for Windows XP / 
Windows XP 64-bit Edition) Printers and Faxes.
 

2 Click Add a Printer to launch the Add Printer wizard.
 

3 Click Next.
 

4 Select A network printer, or a printer attached to another computer, and then click Next. If the printer is not 

listed, type in the path of the printer in the text box. 

For example:\\<server host name>\<shared printer name> 

The server host name is the name of the server computer that identifies it to the network. The shared printer name 
is the name assigned during the server installation process. 

5	 Click Browse for a printer, and then click Next. 

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, specify the 
location where the driver is available. 

6 Select Yes if you want this printer to be set as the default printer, and then click Next.
 

If you want to verify installation, click Yes to print a test page. 


7 Click Finish.
 

When a test page prints successfully, installation is complete.
 

For Windows Vista, Windows Vista 64-bit Edition 

1 Click Start → Control Panel → Hardware and Sound → Printers.
 

2 Click Add a Printer to launch the Add Printer wizard.
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3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and type in the path of the printer in the Select a 
shared printer by name text box and click Next. 

For example:\\<server host name>\<shared printer name> 

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process. 

4 If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, specify the 
location where the driver is available. 

5 Select Yes if you want this printer to be set as the default printer, and then click Next. 

6 If you want to verify installation, click Print a test page. 

7 Click Finish. 

When a test page is printed successfully, installation is complete. 

For Windows Server 2008, Windows Server 2008 64-bit Edition 

1 Click Start → Control Panel → Printers. 

2 Click Add a Printer to launch the Add Printer wizard. 

3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and type in the path of the printer in the Select a 
shared printer by name text box and click Next. 

For example: \\<server host name>\<shared printer name>
 

The server host name is the name of the server computer that identifies it on the network. The shared printer 

name is the name assigned during the server installation process.
 

4 If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, specify the 
location where the driver is available. 

5 Select Yes if you want this printer to be set as the default printer, and then click Next. 

6 If you want to verify installation, click Print a test page. 

7 Click Finish. 

When a test page is printed successfully, installation is complete. 

For Windows 7, Windows 7 64-bit Edition, Windows Server 2008 R2 

1 Click Start → Devices and Printers. 

2 Click Add a Printer to launch the Add Printer wizard. 
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3	 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer and click Next, or 
select The printer that I want isn't listed. Click Select a shared printer by name and type in the path of the printer 
in the text box, and then click Next. 

For example: \\<server host name>\<shared printer name> 

The server host name is the name of the server computer that identifies it to the network. The shared printer name 
is the name assigned during the server installation process. 

4 If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, you need to 
specify the path to the available drivers. 

5 Confirm the printer name, and then click Next. 

6 Select Yes if you want this printer to be set as the default printer, and then click Next. 

7 If you want to verify installation, click Print a test page. 

8 Click Finish. 

When a test page is printed successfully, installation is complete. 

For Windows 8, Windows 8 64-bit Edition, Windows Server 2012 

1 Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware 
for Windows Server 2012) → Devices and Printers. 

2 Click Add a Printer to launch the Add Printer wizard. 

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer and click Next, or 
select The printer that I want isn't listed. Click Select a shared printer by name and type in the path of the printer 
in the text box, and then click Next. 

For example: \\<server host name>\<shared printer name>
 

The server host name is the name of the server computer that identifies it to the network. The shared printer name
 
is the name assigned during the server installation process.
 

4 If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, you need to 
specify the path to the available drivers. 

5 Confirm the printer name, and then click Next. 

6 Select Yes if you want this printer to be set as the default printer, and then click Next. 

7 If you want to verify installation, click Print a test page. 

8 Click Finish. 

When a test page is printed successfully, installation is complete. 
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Installing Printer Drivers on Computers Running 
Macintosh 

Installing the Drivers and Software 
1 Run the Software and Documentation disc on the Macintosh computer.
 

2 Double-click the Dell C1760/C1660 Installer icon, and then click Continue.
 

3 Click Continue on the Introduction screen.
 

4 Click Continue on the Important Information screen.
 

5 Select a language for the Software License Agreement.
 

6 After reading the Software License Agreement, click Continue.
 

7 If you agree to the terms of the Software License Agreement, click Agree to continue the installation process.
 

8 Confirm the installation location, and then click Continue.
 

9 Click Install to perform the standard installation. 


10 Type the administrator's name and password, and then click Install Software. 

11 Click Close to complete installation. 

Adding a Printer on Mac OS X 10.5 or Later Version(s) 

When Using a USB connection 

1 Turn on the printer. 

2 Connect the USB cable between the printer and Macintosh computer. 

3 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7). 

4 Click the Plus (+) sign, and click Default. 

5 Select the printer connected via USB from the Printer Name list. 

Name and Print Using are automatically entered.
 

6 Click Add.
 

When Using Bonjour 

1 Turn on the printer. 

2 Ensure that your Macintosh computer is connected to the network. 

If you use wired connection, connect the Ethernet cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and printer. 

3 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7). 

4 Click the Plus (+) sign, and click Default (Click the Plus (+) sign, and select the printer from Nearby Printers. If 
there are no printers in Nearby Printers, select Add Other Printer or Scanner for Mac OS X 10.7). 

5 Select the printer connected via Bonjour from the Printer Name list. 

Name and Print Using are automatically entered. 

6 Click Add. 

Installing Printer Drivers on Computers Running Macintosh 71 



 

 

    

  

 

 

 

     

   

 

 

    

   

 

When Using IP Printing 

1 Turn on the printer. 

2 Ensure that your Macintosh computer is connected to the network. 

If you use wired connection, connect the Ethernet cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and printer. 

3 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7). 

4 Click the Plus (+) sign, and click IP. 

5 Select Line Printer Daemon - LPD for Protocol. 

6 Type the IP address for the printer in the Address area. 

7 Select the model of your printer for Print Using. 

NOTE: When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it. 

8 Click Add. 

Adding a Printer on Mac OS X 10.4.11 

When Using a USB Connection 

1 Turn on the printer. 

2 Connect the USB cable between the printer and Macintosh computer. 

3 Start Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.
 

4 Click Add.
 

5 Click Default Browser in the Printer Browser dialog box.
 

6 Select the printer connected via USB from the Printer Name list.
 

Name and Print Using are automatically entered.
 

7 Click Add.
 

When Using Bonjour 

1 Turn on the printer. 

2 Ensure that your Macintosh computer is connected to the network. 

If you use wired connection, connect the Ethernet cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and printer. 

3 Start the Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.
 

4 Click Add.
 

5 Click Default Browser in the Printer Browser dialog box.
 

6 Select the printer connected via Bonjour from the Printer Name list.
 

Name and Print Using are automatically entered.
 

7 Click Add.
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When Using IP Printing 

1 Turn on the printer. 

2 Ensure that your Macintosh computer is connected to the network. 

If you use wired connection, connect the Ethernet cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and printer. 

3 Start Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications. 

4 Click Add. 

5 Click IP Printer in the Printer Browser dialog box. 

6 Select Line Printer Daemon - LPD for Protocol. 

7 Type the IP address for the printer in the Address area. 

8 Select the model of your printer for Print Using. 

NOTE: When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it. 

9 Click Add. 
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Operator Panel 

Using the Operator Panel Buttons 
The operator panel has a liquid crystal display (LCD), seven buttons, and an indicator. 

1 

6 

8 

7 

5 

3 

4 

2 

1 Ready/Error indicator 

•	 Lights up green when the printer is ready or sleeping and blinks when data is being received. 

• Lights up orange when an error occurs and blinks when an unrecoverable print error occurs. 

2 LCD Panel 

3 buttons 

•	 Selects submenus or setting values in the Menu mode. 

4 (Set) button 

•	 Displays the selected menu or item and determines the selected value in the Menu mode. 

5  (Cancel) button 

•	 Cancels the current print job. 

•	 Switches to the Print mode from the top menu of the Menu mode. 

•	 Switches to the upper hierarchy of the menu from the submenu of the Menu mode. 

6  (Menu) button 

•	 Switches to the Menu mode from the Print mode. 

•	 Switches to the Print mode from the Menu mode. 

7 buttons 

• Scrolls through menus or items in the Menu mode. To enter numbers or passwords, press these buttons. 

8  (Wi-Fi | WPS) button 

•	 Starts Wi-Fi Protected Setup® (Push Button Configuration). Lights up when it is activated, and blinks in 
certain conditions. 
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Status of Wi-Fi | WPS Button Backlight 
This section describes when the backlight of the (Wi-Fi | WPS) button lights up or blinks. 

For more information, see "Wireless Problems" on page 224. 

Wi-Fi | WPS Button 
Backlight 

Off 

Wireless LAN 
settings*1 

N/A 

Disable 

Printer Status Error Message 

Connected to the network via Ethernet 
cable; Wi-Fi settings is not available when 
an Ethernet cable is connected to the 
printer. 

-

- -

Enable The printer enters Sleep/Deep Sleep mode -

On Enable Wireless link established 

Blinking Enable Searching for wireless LAN access point or 
normal router 

Blinking Enable Searching/Connecting with WPS access 
slowly point or router during wireless operation 

Blinking Enable No wireless LAN access point or router Wireless Timeout Error 
fast found within the specified time 

WPS Connection failure WirelessDownload Error 

Wireless LAN access point or router found 
but connection error occurs (Passphrase 
error) 

Detected WPS signals from multiple access 
points or routers during wireless operation 
(session overlap) 

WPS Connection failure; Security setting of 
the wireless LAN access point or router is 
WEP, which is unsupported on WPS. 

Wireless Password Error 

Wireless Session Overlap
Error 

Wireless WEP AP Connected 
Error 

Wrong WEP key entered during the wireless WEP Key Input Error 
setup 

*1 You can enable/disable the Wireless LAN settings. For more information, see "Wireless LAN" on page 127. 
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Using the Operator Panel to Change Printer Settings 
You can select menu items and corresponding values from the operator panel.
 

When you first enter the menus from the operator panel, you see an asterisk (*) next to a value in the menus. This 

asterisk indicates the factory default menu setting. These settings are the original printer settings.
 

NOTE: Factory defaults may vary for different countries.
 

When you select a new setting from the operator panel, an asterisk appears next to the setting to identify it as the 

current user default menu setting.
 

These settings are active until new ones are selected or the factory defaults are restored.
 

To select a new value as a setting:
 

1 Press the (Menu) button.
 

2 Press the 
 or  button until the desired menu appears, and then press the (Set) button.
 

3 Press the 
 or  button until the desired menu or menu item appears, and then press the (Set) button. 

• If the selection is a menu, the menu is opened and the first system setting in the menu appears. 

• If the selection is a menu item, the default menu setting for the menu item appears.
 

Each menu item has a list of values for the menu item. A value can be:
 

• A phrase or word to describe a setting 

• A numerical value that can be changed 

• An On or Off setting 

• Press the or  button at the same time. This will restore the factory default menu settings. Press 
the (Set) button to return the settings to the factory default menu settings.
 

4 Press the 
 or  button to scroll until the desired value appears.
 

5 Press the 
 (Set) button. 

This enables the setting value, which is indicated by an asterisk (*) next to the setting value. 

6 Press the (Cancel) or button to return to the previous menu.
 

To continue setting other items, select the desired menu. To quit setting new values, press the 
 (Cancel) 
button. 

Driver settings may have precedence over changes previously made. In such case, change the defaults of the operator 
panel. 

Printing a Device Settings Page 
The device settings page shows current settings for the printer menus. For details about how to print a panel settings 
report, see "Understanding the Printer Menus" on page 125. 
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Changing the Language 
To display a different language on the operator panel: 

The Operator Panel 
1 Press the 

2 Press the 

3 Press the 

(Menu) button. 

button until Panel Language appears, and then press the 

 button until the desired language appears, and then press the 

(Set) button. 

(Set) button. 

The Tool Box 
1 Click Start → All Programs → Dell Printers → Dell C1660w Color Printer or Dell C1760nw Color Printer 
→ Tool Box. 

NOTE: For details about starting the Tool Box, see "Starting the Tool Box" on page 111. 

The Tool Box opens. 

2 Click the Printer Maintenance tab. 

3 Select System Settings from the list at the left side of the page. 

The System Settings page is displayed. 

4 Select the desired language from Panel Language, and then click Apply New Settings. 

Setting the PowerSaver Time Option 
You can set the powersaver time for the printer. The printer waits before it restores the default copy settings, if you 
do not start copying after changing them on the operator panel. 

1 Press the (Menu) button. 

2 Press the button until Admin Menu appears, and then press the (Set) button. 

3 Press the button until System Settings appears, and then press the (Set) button. 

4 Ensure that PowerSaver Time appears, and then press the (Set) button. 

5 Press the button to select Sleep, Deep Sleep, or Auto-Off Timer, and then press the (Set) 
button. 

When you select Sleep or Deep Sleep, go to step 7. 

When you select Auto-Off Timer, go to step 6. 

6 Press the button to select Off or On, and then press the (Set) button. 

If you select Off, go to step 8. 

7 Press the  or button or enter the desired value using the numeric keypad, and then press the (Set) button. 

You can select from 5–30 minutes for Sleep, 1-6 minutes for Deep Sleep, or 60-1440 minutes for 
Auto-Off Timer. 

8 Press the  (Cancel) or  button to return to the previous menu. 
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Dell™ Printer Configuration Web Tool 

NOTE: The images used in this manual are those of the Dell C1760nw Color Printer unless otherwise mentioned. 

Overview 
NOTE: This web tool is available only when the printer is connected to a network. 

One of the features of the Dell Printer Configuration Web Tool is the E-Mail Alert Setup, which sends an e-mail to 
you or the key operator when the printer needs supplies or intervention. 

To fill out printer inventory reports requiring the asset tag number of all the printers in your area, use the Printer 
Information feature in the Dell Printer Configuration Web Tool. Enter the IP address of each printer on the 
network to display the asset tag number. 

The Dell Printer Configuration Web Tool feature also allows you to change the printer settings and keep track of 
printing trends. If you are a network administrator, you can copy the printer settings to one or all printers on the 
network using your web browser. 

Setting Up the Dell Printer Configuration Web Tool 
Ensure that you activate JavaScript in your browser before using the Dell Printer Configuration Web Tool.
 

It is recommended that you configure the environment settings of your web browser before using the Dell Printer 

Configuration Web Tool.
 

NOTE: The Dell Printer Configuration Web Tool pages may be unreadable if the language differs from that of your web browser. 

Setting Up From Web Browser 
It is recommended that you configure both the environment settings of your web browser and the operator panel 
before using the Dell Printer Configuration Web Tool. 
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For Internet Explorer® 

Setting Up the Display Language 

1 Select Internet Options from Tools on the menu bar. 

2 Select Languages in the General tab. 

3 Specify the display language in order of preference in the Language list. 

For example: 

• Italian (Italy) [it-IT] 

• Spanish (Traditional Sort) [es-ES tradnl] 

• German (Germany) [de-DE] 

• French (France) [fr-FR] 

• English (United States) [en-us] 

• Danish [da-DK] 

• Dutch (Netherlands) [nl-NL] 

• Norwegian (Bokmal) [no] 

• Swedish [sv-SE]  

Setting the IP Address of the printer to Non-Proxy 

1 Select Internet Options from the Tools menu. 

2 Click LAN Settings under Local Area Network (LAN) settings in the Connections tab. 

3 You can configure the LAN settings in one of the following ways: 

• Clear the  Use a proxy server for your LAN check box under Proxy server. 

• Click  Advanced, and then specify the IP address of your printer in the Do not use proxy server for addresses 
beginning with field under Exceptions. 

After setting the language and proxy, enter <http://nnn.nnn.nnn.nnn/> (the IP address of your printer) in 
the URL entry field of the browser to activate the Dell Printer Configuration Web Tool. 

For Firefox® 

Setting Up the Display Language 

1 Select Options from the Tools menu. 

2 Click Choose in the Content tab. 

3 Specify the display language in order of preference in the Languages in order of preference list. 

For example: 

• English [en] or English/United States [en-us] 

• Italian [it] 

• Spanish [es]  

• German [de] 

• French [fr]  

• Dutch [nl]  

• Norwegian [no] 

• Swedish [sv]  

• Danish [da] 
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Setting the IP Address of the printer to Non-Proxy 

1 Select Options from the Tools menu. 

2 Click Advanced tab. 

3 Click Network on the Options dialog box. 

4 Click Connection → Settings. 

5 You can configure the LAN settings in one of the following ways: 

•	 Select the No Proxy check box, if you do not want to use a proxy. 

•	 Select the Auto-detect proxy settings for this network check box. 

•	 Select the Manual proxy configuration: check box, and then enter a hostname and a port number if you have 
a list of one or more proxy servers. If you have an IP address that does not use a proxy, enter the IP address of 
your printer in the No Proxy for: edit box. 

•	 Select the Automatic proxy configuration URL: check box. 

After setting the language and proxy, enter <http://nnn.nnn.nnn.nnn/> (the IP address of your printer) in 
the URL entry field of the browser to activate the Dell Printer Configuration Web Tool. 

Setting Up From Operator Panel 
You can launch the Dell Printer Configuration Web Tool only when EWS is set to Enable (the factory default) on 
the operator panel. Check the operator panel setting if you cannot launch the Dell Printer Configuration Web Tool. 
For more information, see "Understanding the Printer Menus" on page 125. 

Starting the Dell Printer Configuration Web Tool 
To launch the Dell Printer Configuration Web Tool, enter the IP address of your printer in your web browser. 

If you do not know the IP address of your printer, print the printer settings report or display the TCP/IP Settings 
page, which lists the IP address. For details about how to find your printer's IP address, see "Verifying the IP Settings" 
on page 41. 

Overview of the Menu Items 
Use the Dell Printer Configuration Web Tool for: 

Printer Status 

Use the Printer Status menu to get feedback on the printer status. When a toner cartridge is running low, click the 
order supplies link on the first screen to order an additional toner cartridge. 

Printer Jobs 

Use the Printer Jobs menu to contain information on the Job List page and Completed Jobs page. 

These pages show the details of the status regarding each protocol or job. 

Printer Settings 

Use the Printer Settings menu to change printer settings and view the settings in the operator panel remotely. 
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Print Server Settings 

Use the Print Server Settings menu to change the type of printer interface and necessary conditions for 
communications. 

Copy Printer Settings 

Use the Copy Printer Settings menu to copy the printer settings to another printer or printers on the network by 
entering the IP address of each printer. 

NOTE: You must log in as an administrator to use this feature. 

Print Volume 

Use the Print Volume option to check the number of pages printed for each paper size. 

Printer Information 

Use the Printer Information menu to display the information of your printer. 

E-Mail Alert 

Use the E-Mail Alert menu to receive an e-mail when the printer needs supplies or intervention. Enter your name or 
the key operator name in the e-mail list box to be notified. 

Set Password 

Use the Set Password menu to lock the Dell Printer Configuration Web Tool with a password so that other users do 
not inadvertently change the printer settings you selected. 

NOTE: You must log in as an administrator to use this feature. 

Online Help 

Click Online Help to visit the Dell Support web site. 

Order Supplies at: 

www.dell.com/supplies 

Contact Dell Support at: 

support.dell.com 
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Page Display Format 
The layout of the page is divided into three sections. 

Top Frame 
The top frame is located on the top of all pages. When the Dell Printer Configuration Web Tool is activated, the 

current status and specifications of the printer are displayed in the top frame on every page. 


The following items are displayed in the top frame.
 

1 Dell C1760nw Color Printer Displays the printer model name. 

2 IP Address Displays the IP address of your printer. 

3 Location Displays the location of the printer. The location can be changed in the Basic 
Information on the Print Server Settings page. 

4 Contact Person Displays the administrator name of the printer. The name can be changed in the Basic 
Information on the Print Server Settings page. 

5 Event Panel Displays the condition of the printer. If an error occurs, the error code and message are 
displayed. For example, 077-090:Paper jam. Open... 

6 Printer Bitmap Shows the bitmap image of the printer. The Printer Status menu appears in the right 
frame when you click the image. 
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Left Frame 
The left frame is located on the left side of all pages. The menu titles displayed in the left frame are linked to 
corresponding menus and pages. You can go to the corresponding page by clicking their characters. 

The following menus are displayed in the left frame. 

1 Printer Status Links to the Printer Status menu. 

2 Printer Jobs Links to the Printer Jobs menu. 

3 Printer Settings Links to the Printer Settings Report menu. 

4 Print Server Settings Links to the Print Server Reports menu. 

5 Copy Printer Settings Links to the Copy Printer Settings menu. 

6 Print Volume Links to the Print Volume menu. 

7 Printer Information Links to the Printer Status menu. 

8 E-Mail Alert Links to the Print Server Settings menu. 

9 Set Password Links to the Security menu. 

10 Online Help Links to the Dell Support website. 

11 Order Supplies at: Links to the Dell web page. 

12 Contact Dell Support at: Links to the Dell support page web address: support.dell.com 
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Right Frame 
The right frame is located on the right side of all pages. The contents of the right frame correspond to the menu that 
you select in the left frame. For details on the items displayed in the right frame, see "Details of the Menu Items" on 
page 88. 

Buttons in the Right Frame 

1 Refresh button Receives the current printer configuration and updates the latest information in the right 
frame. 

2 Apply New Settings button Submits new settings made on the Dell Printer Configuration Web Tool to the printer. 
The new settings replace the old settings of the printer. 

3 Restore Settings button Restores the old settings. New settings will not be submitted to the printer. 
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Changing the Settings of the Menu Items 
Some menus allow you to change the printer settings access through the Dell Printer Configuration Web Tool. 
When you access these menus, the authentication window appears on the screen. Enter a user name and password of 
the administrator by following the prompts displayed in the dialog box. 

The default user name is admin, and the default password is left blank (NULL). You can change only the password in 
the Set Password page in the Security menu. For more information, see "Set Password" on page 109. 

Details of the Menu Items 

"Printer Status" "Printer Status" 

"Printer Events" 

"Printer Information" 

"Printer Jobs" "Job List" 

"Completed Jobs" 

"Printer Settings" "Printer Settings Report" "Menu Settings" 

"Reports" 

"Printer Settings" "System Settings" 

"USB Settings" 

"Secure Settings" 

"Printer Maintenance" "Paper Density" 

"Adjust BTR" 

"Adjust Fusing Unit" 

"Auto Registration Adjustment" 

"Color Registration Adjustments" 

"Clean Developer" 

"BTR Refresh" 

"Maintenance Chart" 

"Reset Defaults" 

"Non-Dell Toner" 

"Adjust Altitude" 

"Web Link Customization" 
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"Print Server Settings" "Print Server Reports" "Print Server Setup Page" 

"E-Mail Alert Setup Page" 

"Print Server Settings" "Basic Information" 

"Port Settings" 

"TCP/IP" 

"E-Mail Alert" 

"Bonjour (mDNS)" 

"SNMP" 

"Wireless LAN"*1 

"Reset Print Server" 

"Security" "Set Password" 

"IP Filter (IPv4)" 

"Copy Printer Settings" "Copy Printer Settings" 

"Copy Printer Settings Report" 

"Print Volume" "Print Volume" 

*1 This item is available only when the printer is connected with a wireless network. 

Printer Status 
Use the Printer Status menu to check the status of consumables, hardware, and specifications of the printer. 

The following pages are displayed in the Printer Status menu. 

Printer Status 

Purpose: 

To check the status of the consumables and trays. 

Values: 

Cyan Cartridge Level 

Magenta Cartridge Level 

Yellow Cartridge Level 

Displays the percentage of toner remaining in each toner cartridge. 
When a cartridge is empty, a message appears. The text Call or 
Order is linked to the Dell Printer Supplies website. 

Black Cartridge Level 

Paper Trays Status OK Indicates that there is some paper in the tray but the quantity is 
unknown. 

Add Paper Indicates that there is no paper in the tray. 

Capacity Displays the maximum capacity of the output tray. 

Size Displays the size of paper in the tray. 

Output Tray Status OK Indicates that the tray is available. 

Capacity Displays the maximum capacity of the output tray. 

Cover Status Closed Indicates that the cover is closed. 

Open Indicates that the cover is open. 

Printer Type Displays the type of the printer. Color Laser is displayed normally. 

Printing Speed Displays the printing speed. 
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Printer Events 

Purpose: 

When faults such as Out of Paper or Rear Cover is Open occur, the details of all alerts or indications of faults are
 
displayed in the Printer Events page.
 

Values:
 

Location Displays the location where the error occurred. 

Details Displays the details of the error. 

Printer Information 

Purpose:
 

To display the system information of the printer. This page can also be displayed by clicking Printer Information in 

the left frame.
 

Values: 

Dell Service Tag Number Displays Dell's service tag number. 

Express Service Code Displays the express service code of the printer. 

Asset Tag Number Displays the asset tag number of the printer. 

Printer Serial Number Displays the serial number of the printer. 

Memory Capacity Displays the memory capacity. 

Processor Speed Displays the processing speed. 

Printer Revision Levels Firmware Version Displays the version of the controller. 

Network Firmware Version Displays the NIC version. 

Printer Jobs 
The Printer Jobs menu contains information on the Job List and Completed Jobs pages. These pages show the 
details of the status regarding each protocol or the print jobs. 

Job List 

Purpose:
 

To confirm the print jobs that are being processed. Click Refresh to update the screen.
 

Values:
 

ID Displays the job ID. 

Job Name Displays the file name of the job being printed. 

Owner Displays the name of the job owner. 

Host Name Displays the name of the host computer. 

Job Status Displays the status of the job being printed. 

Host I/F Displays the status of the host interface. 

Job Submitted Time Displays the date when the print job was submitted. 
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Completed Jobs 

Purpose:
 

To check the completed jobs. Up to 10 latest print jobs are displayed. Click Refresh to update the screen.
 

Values:
 

ID Displays the job ID. 

Job Name Displays the file name of the job. 

Owner Displays the name of the job owner. 

Host Name Displays the name of the host computer. 

Output Result Displays the status of the job. 

Impression Number Displays the total number of pages used by the print job. 

No. of Sheets Displays the total number of sheets used by the print job. 

Host I/F Displays the status of the host interface. 

Job Submitted Time Displays the date when the job was submitted. 

Printer Settings 
Use the Printer Settings menu to display the Printer Settings Report and to configure the printer settings. 

The following tabbed pages are displayed at the top of the right frame. 

Printer Settings Report 

The Printer Settings Report tab contains the Menu Settings and Reports pages. 

Menu Settings 

Purpose: 

To display the current settings of your printer. 

Values: 

System Settings Power Saver Time - Sleep Displays the time taken by the printer before it enters Sleep mode 
after it finishes a job. 

Power Saver Time - Deep Displays the time taken by the printer before it enters Deep Sleep 
Sleep mode after it goes into Sleep mode. 

Power Saver Time - Auto-Off Displays the time taken by the printer to be turned off after it has 
Timer*1 entered Deep Sleep mode. 

Fault Time-Out Displays the time taken by the printer before it cancels jobs that 
stop abnormally. 

Job Time-Out Displays the amount of time that the printer waits for data to arrive 
from the computer. 

mm/inch Displays the measurement unit used after the numeric value on the 
operator panel. 

Default Paper Size Displays the default paper size. 

Disable printing with larger Displays whether to disable printing if the paper size set in the 
paper size printer driver and the paper size set in the tray of the printer does 

not match (the paper set in the tray is larger). 
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Auto Log Print Displays whether to automatically print a job history report after 
every 10 jobs. 

Low Toner Alert Msg Displays whether to show the alert message when the toner is low. 

Panel Language Displays the language used on the operator panel. 

USB Settings USB Port Displays whether the USB interface is enabled. 

Secure Settings Panel Lock Set Displays whether to limit access to the menus with a password. 

Login Error - Attempts Displays the maximum number that the administrator fails to log 
in. 

Software Download Displays whether to enable download of software updates. 

Paper Density Plain Displays the paper density of plain paper. 

Label Displays the paper density of labels. 

Adjust BTR Plain Displays the voltage setting of the transfer roller for plain paper. 

Plain Thick Displays the voltage setting of the transfer roller for thick plain 
paper. 

Covers Displays the voltage setting of the transfer roller for cover paper. 

Label Displays the voltage setting of the transfer roller for labels. 

Coated Displays the voltage setting of the transfer roller for coated paper. 

Envelope Displays the voltage setting of the transfer roller for envelopes. 

Recycled Displays the voltage setting of the transfer roller for recycled paper. 

Adjust Fusing Unit Plain Displays the temperature setting of the fusing unit for plain paper. 

Plain Thick Displays the temperature setting of the fusing unit for thick plain 
paper. 

Covers Displays the temperature setting of the fusing unit for cover paper. 

Label Displays the temperature setting of the fusing unit for labels. 

Coated Displays the temperature setting of the fusing unit for coated 
paper. 

Envelope Displays the temperature setting of the fusing unit for envelopes. 

Recycled Displays the temperature setting of the fusing unit for recycled 
paper. 

Auto Registration Adjustment Displays whether to automatically adjust color registration. 

Adjust Altitude Displays the altitude of the location where the printer is installed. 

BTR Refresh Displays whether to execute counter measures for 
curling/separating discharge of the paper. 

Non-Dell Toner Displays whether to use toner cartridge of another manufacturer. 

Web Link Customization Select Reorder URL Displays a link used for ordering consumables, which can be 
accessed from Order Supplies at: in the left frame. 

Regular Displays the regular web address 
(http://accessories.us.dell.com/sna) that can be linked to Order 
Supplies at: 

Premier Displays the premier web address (http://premier.dell.com) that 
can be linked to Order Supplies at: 

*1 Auto-Off Timer feature is available only in certain regions. 
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Reports 

Purpose: 

To print the settings and history information of your printer. 

Values: 

Printer Settings Click Start to print the printer settings page. 

Device Settings Click Start to print the device settings page. 

Job History Click Start to print the Job History report. 

Error History Click Start to print the Error History report. 

Color Test Page Click Start to print the Color Test Page. 

Printer Settings 

The Printer Settings tab contains the System Settings, USB Settings, and Secure Settings pages. 

System Settings 

Purpose: 

To configure the basic printer settings. 

Values: 

Power Saver Time - Sleep*1 Specifies the time taken by the printer before it enters Sleep mode after it finishes a job. 

Power Saver Time - Deep Specifies the time taken by the printer before it enters Deep Sleep mode after it goes into Sleep 
Sleep mode. 

Power Saver Time - Auto-Off Specifies the time it takes to automatically turn off the printer after it has entered Deep Sleep 
Timer*2 mode. 

Fault Time-Out Specifies the time taken by the printer before it cancels jobs that stop abnormally. The print job is 
cancelled if it times out. 

Job Time-Out Specifies the amount of time that the printer waits for data to arrive from the computer. The print 
job is cancelled if it times out. 

mm / inch*3 Specifies the measurement unit displayed after the numeric value on the operator panel. 

Default Paper Size Specifies the default paper size. 

Disable printing with larger Specifies whether to print jobs if the paper set in the tray of the printer is larger than the paper 
paper size*4 size set in the printer driver (the paper size does not have to match). 

Auto Log Print Specifies if a job history needs to be printed after every 10 jobs. 

Low Toner Alert Msg Alerts you if the toner is low. 

Panel Language Used to set the language on the operator panel. 

*1	 Enter 5 in Sleep to put the printer in the Sleep mode five minutes after it finishes a job. This uses less energy, but requires more 
warm-up time for the printer. Enter 5 if your printer shares an electrical circuit with room lighting and you notice lights flickering. 
Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate with minimum 
warm-up time. Select a value between 5 and 30 minutes for the Sleep mode if you want a balance between energy consumption and a 
shorter warm-up period. 
The printer automatically returns to the standby mode from the Sleep mode when it receives data from the computer. You can also 
return the printer to the standby mode by pressing any button on the operator panel. 

*2	 Auto-Off Timer feature is available only in certain regions. 
*3	 The default for mm/inch and Default Paper Size vary depending on country-specific factory default. 
*4	 Disable printing with larger paper size is available only in the Dell Printer Configuration Web Tool and the Tool Box. 
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USB Settings 

Purpose: 

To change the USB settings on your printer. 

Values: 

USB Port To enable the USB interface on your printer. 

Secure Settings 

Panel Lock 

Purpose: 

To restrict access to Admin Menu and Report/List with a password, and to set or change the password. 

NOTE: This menu sets a password to lock the operator panel. When you change the password for the Dell Printer Configuration 
Web Tool, click Set Password on the left frame and set the password. 

Values: 

Panel Lock Set Restricts access to Admin Menu and Report/List with a password. 

New Password Sets a password required to access Admin Menu and Report/List. 

Re-enter Password Enter the new password again to confirm. 

Login Error 

Purpose: 

To set the maximum number of failed login attempts before an administrator is denied access to Admin Menu and 
Report/List. 

NOTE: This item is available only when Panel Lock Set is set to Enable. 

Software Download 

Purpose: 

To set whether to enable download of software updates. 

Printer Maintenance 

The Printer Maintenance tab contains the Paper Density, Adjust BTR, Adjust Fusing Unit, Auto Registration 
Adjustment, Color Registration Adjustments, Clean Developer, BTR Refresh, Maintenance Chart, Reset Defaults, 
Non-Dell Toner, Adjust Altitude, and Web Link Customization pages. 

Paper Density 

Purpose: 

To specify the paper density. 

Values: 

Plain Sets the paper density of plain paper. 

Label Sets the paper density of labels. 
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Adjust BTR 

Purpose: 

To specify the optimum voltage settings for printing for the transfer roller (BTR). To decrease the voltage, set 
negative values. To increase the voltage, set positive values. 

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage. 

NOTE: The print quality changes depending on the values you select for this item. 

Values: 

Plain Sets the reference voltage setting for the transfer roller for plain paper within the range of -3 to 3. 

Plain Thick Sets the reference voltage setting for the transfer roller for thick plain paper within the range of 
-3 to 3. 

Covers Sets the reference voltage setting for the transfer roller for cover paper within the range of -3 to 3. 

Label Sets the reference voltage setting for the transfer roller for labels within the range of -3 to 3. 

Coated Sets the reference voltage setting for the transfer roller for coated paper within the range of -3 to 3. 

Envelope Sets the reference voltage setting for the transfer roller for envelopes within the range of -3 to 3. 

Recycled Sets the reference voltage setting for the transfer roller for recycled paper within the range of 
-3 to 3. 

Adjust Fusing Unit 

Purpose: 

To specify the optimum temperature settings for printing for the fusing unit. To decrease the temperature, set 
negative values. To increase the temperature, set positive values. 

The default settings may not give the best output on all paper types. When the printed paper has curled, try to 
decrease the temperature. When the toner does not fuse on the paper properly, try to increase the temperature. 

NOTE: The print quality changes depending on the values you select for this item. 

Values: 

Plain Sets the temperature settings for the fusing unit for plain paper within the range of -3 to 3. 

Plain Thick Sets the temperature settings for the fusing unit for thick plain paper within the range of -3 to 3. 

Covers Sets the temperature settings for the fusing unit for cover paper within the range of -3 to 3. 

Label Sets the temperature settings for the fusing unit for labels within the range of -3 to 3. 

Coated Sets the temperature settings for the fusing unit for coated paper within the range of -3 to 3. 

Envelope Sets the temperature settings for the fusing unit for envelopes within the range of -3 to 3. 

Recycled Sets the temperature settings for the fusing unit for recycled paper within the range of -3 to 3. 

Auto Registration Adjustment 

Purpose: 

To specify whether to automatically adjust color registration. 
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Color Registration Adjustments 

Purpose: 

To specify whether to manually adjust color registration. 

Color registration adjustments need to be made during the initial setup of the printer or when the printer is moved 
to a different location. 

NOTE: The Color Registration Adjustments feature can be configured when Auto Registration Adjustment is set to Off. 

Values: 

Auto Correct Click Start to automatically correct color registration. 

Color Regi Chart	 Click Start to print a color registration chart. The color registration chart prints a lattice pattern of 
yellow, magenta, and cyan lines. On the chart, find the values on the right side that are next to the 
line that is perfectly straight for each of the three colors. If the value for this line is 0, color 
registration is not needed. If the value for this line is any value other than 0, specify the 
adjustment values under Color Registration Adjustments. 

Color Registration 	 Enter Number Specifies lateral (perpendicular to paper feed direction) and process 
Adjustments	 (paper feed direction) color adjustment values individually for Y 

(Yellow), M (Magenta), C (Cyan), LY (Left Yellow), LM (Left 
Magenta), LC (Left Cyan), RY (Right Yellow), RM (Right 
Magenta), and RC (Right Cyan) within the range of -5 to +5. 

Clean Developer 

Purpose: 

To rotate the developer motor and stir the toner in the toner cartridge, to use up a toner cartridge when you need to 
replace it before the end of its life, or to stir the toner in a new toner cartridge. 

Values: 

Clean Developer Click Start to stir the toner in the toner cartridge. 

Yellow Toner Refresh Click Start to clean the toner in the yellow toner cartridge. 

Magenta Toner Refresh Click Start to clean the toner in the magenta toner cartridge. 

Cyan Toner Refresh Click Start to clean the toner in the cyan toner cartridge. 

Black Toner Refresh Click Start to clean the toner in the black toner cartridge. 

BTR Refresh 

Purpose: 

To specify whether to automatically execute counter measures for curling/separating discharge of the paper. 
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Maintenance Chart 

Purpose: 

To print various charts that can be used for diagnosing your printer. 

Values: 

Ghost Click Start to print a chart to check for ghost printing. 

4Colors Click Start to print bands of yellow, magenta, cyan, and black with varying density. 

Alignment Click Start to print a chart, and then check for proper alignment of the print image on the paper. 

Drum Refresh Click Start to print a chart to check the light fatigue of the drum cartridge. 

Reset Defaults 

Purpose: 

To initialize NVM (non-volatile memory) for system parameters. After executing this function and rebooting the 
printer, all the menu parameters, except the parameters for the network, are reset to their default values. 

Values: 

Reset Defaults and restart Click Start to initialize the system parameters. 
printer. 

Non-Dell Toner 

Purpose: 

To use toner cartridge of another manufacturer. 

NOTE: Using non-Dell-brand toner cartridges may make some printer features unusable, reduce print quality and decrease the 
reliability of your printer. Dell recommends only new Dell-brand toner cartridges for your printer. Dell does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Dell. 

NOTE: Before you use toner cartridge of another manufacturer, be sure to restart the printer. 

Adjust Altitude 

Purpose: 

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used. 

NOTE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner. 
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Web Link Customization 

Purpose:
 

To specify a link used for ordering consumables, which can be accessed from Order Supplies at: in the left frame.
 

Values:
 

Select Reorder URL Select Regular or Premier web address to be linked to Order Supplies at: 

Regular Displays the regular web address (http://accessories.us.dell.com/sna) that can be linked to 
Order Supplies at: 

Premier Displays the premier web address (http://premier.dell.com) that can be linked to 
Order Supplies at: 

Print Server Settings 
Use the Print Server Settings menu to set the type of printer interface and necessary conditions for 

communications.
 

The following tabbed pages are displayed in the top of the right frame.
 

Print Server Reports 

The Print Server Reports tab contains the Print Server Setup Page and E-Mail Alert Setup Page. 

Print Server Setup Page 

Purpose: 

To verify the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) and printing ports. On 
this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the Print 
Server Settings tab. 

Values: 

Ethernet*1 Ethernet Settings Displays the current settings of Ethernet transmission rate and the 
duplex settings. 

Current Ethernet Settings Displays the current Ethernet settings. 

MAC Address Displays the Media Access Control (MAC) address of the printer. 

Wireless Settings*2 Wireless LAN Displays whether to enable wireless connection. 

SSID Displays the name that identifies the network. 

Network Type Displays the network type from either the Ad-Hoc or Infrastructure 
mode. 

MAC Address Displays the MAC address of the wireless printer setting. 

Link Channel Displays the channel number of the connection. 

Link Quality Displays the quality of the connection. 
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TCP/IP Settings IP Mode Displays the IP mode. 

Host Name Displays the host name. 

IPv4*3 IP Address Mode Displays the IP address mode. 

IP Address Displays the IP address. 

Subnet Mask Displays the subnet mask. 

Gateway Address Displays the gateway address. 

IPv6*4 Enable Stateless Address Displays whether to enable the 
stateless address. 

Use Manual Address Displays whether to set the IP 
address manually. 

Manual Address*5 Displays the IP address. 

Stateless Address 1-3*6 Displays the stateless addresses. 

Link Local Address*6 Displays the link local address. 

Manual Gateway Address*5 Displays the gateway address. 

Auto Configure Gateway 
Address*6 

Displays the gateway address. 

DNS IPv4*3 Get DNS Server Address Displays if the printer receives the 
from DHCP DNS server address automatically 

from the DHCP server. 

Current DNS Server Address Displays the DNS server address. 

IPv6*4 Get DNS Server Address Displays if the printer receives the 
from DHCPv6-lite DNS server address automatically 

from the DHCPv6-lite server. 

Current DNS Server Address Displays the DNS server address. 

Priority to IPv6 DNS Name 
Resolution*7 

Displays whether to use the DNS 
Name Resolution feature. 

LPD Port Status Displays the port status. 

Connection Time-Out Displays the connection time-out period. 

Port9100 Port Status Displays the port status. 

Port Number Displays the port number. 

Connection Time-Out Displays the connection time-out period. 

WSD Port Status Displays the WSD (Web Services on Devices) port status. 

Port Number Displays the WSD port number. 

Receive Time-Out Displays the receive time-out period. 

Notification Time-Out Displays the notification time-out period. 

Maximum Number of TTL Displays the maximum number of TTLs. 

Maximum Number of Displays the maximum number of notifications. 
Notification 

HTTP Port Status Displays the port status. 

Port Number Displays the port number. 

Simultaneous Connections Displays the number of connections received simultaneously by the 
client. 

Connection Time-Out Displays the connection time-out period. 
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Bonjour (mDNS) Port Status Displays the port status. 

Host Name Displays the host name. 

Printer Name Displays the printer name. 

SNMP Port Status Displays the port status. 

IP Filter (IPv4)*8 Address Displays the list of IP addresses that are permitted or denied access 
to the printer. 

Address Mask Displays the list of subnet mask that are permitted or denied access 
to the printer. 

Active Mode Displays whether to be permitted or denied access to the printer. 
*1 This item is available only when the printer is connected with a wired network.
 
*2 This item is available only when the printer is connected with a wireless network.
 
*3 This item is displayed when IPv4 or Dual Stack Mode is selected.
 
*4 This item is displayed when IPv6 or Dual Stack Mode is selected.
 
*5 This item is displayed only when Use Manual Address is Enable.
 
*6 This item is displayed only when an IP address has been assigned.
 
*7 This item is available only when using IPv6 dual mode.
 
*8 This item is only available for LPD or Port9100.
 

E-Mail Alert Setup Page 

Purpose: 

To verify the current settings of SMTP/POP (Simple Mail Transfer Protocol/Post Office Protocol) used for the e-mail 
feature and e-mail alert feature. In this page, you can only verify the settings of items. If you want to change the 
settings, go to the pages in the Print Server Settings tab. 

Values: 

E-Mail Server Settings Port Status Displays the port status. 

Primary SMTP Gateway Displays the primary SMTP gateway. 

SMTP Port Number Displays the SMTP port number. 

E-Mail Send Authentication Displays the authentication method for outgoing e-mail. 

POP3 Server Address Displays the POP3 server address. 

POP3 Port Number Displays the POP3 port number. 

Reply Address Displays the reply e-mail address sent with each e-mail alert. 

SMTP Server Connection Displays the status of the SMTP server connection. 
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E-Mail Alert Settings E-Mail List 1 Displays the acceptable e-mail addresses for the e-mail alert feature 
specified in E-Mail List 1. 

Select Alerts for List 1 Supplies Alerts Displays the e-mail alert receive 
status for consumables. 

Paper Handling Alerts Displays the e-mail alert receive 
status for paper handling. 

Service Call Displays the e-mail alert receive 
status for service calls. 

E-Mail List 2 Displays the acceptable e-mail addresses for the e-mail alert feature 
specified in E-Mail List 2. 

Select Alerts for List 2 Supplies Alerts Displays the e-mail alert receive 
status for consumables. 

Paper Handling Alerts Displays the e-mail alert receive 
status for paper handling. 

Service Call Displays the e-mail alert receive 
status for service calls. 

Print Server Settings 

The Print Server Settings tab contains the Basic Information, Port Settings, TCP/IP, E-Mail Alert, Bonjour 
(mDNS), SNMP, Wireless LAN, and Reset Print Server pages. 

Basic Information 

Purpose: 

To configure the basic information of the printer. 

NOTE: The Auto Refresh feature is effective for the contents of the top frame, Printer Status page, Job List page, and Completed 
Jobs page. 

Values: 

System Settings Printer Name Specifies the name of the printer using up to 31 alphanumeric 
characters. 

Location Specifies the location of the printer using up to 63 alphanumeric 
characters. 

Contact Person Specifies the contact name, number, and other information of the 
administrator and service center using up to 63 alphanumeric 
characters. 

Administrator E-Mail 
Address 

Specifies the contact address of the administrator and service 
center using up to 63 alphanumeric characters. 

Asset Tag Number Enter the asset tag number for the printer. 

EWS Settings Auto Refresh Automatically refreshes the contents of the status display pages. 

Auto Refresh Interval Sets the time interval for refreshing the contents of the status 
display pages automatically from 15 to 600 seconds. 
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Port Settings 

Purpose: 

To enable or disable printing connectors and management protocol features. 

NOTE: The settings in the Port Settings page will be valid only when the printer is rebooted. When you change or configure the 
settings, click Apply new settings to apply new settings. 

Values: 

Ethernet*1 Ethernet Settings Auto	 Detects Ethernet transmission rate 
and the duplex settings 
automatically. 

10Base-T Selects 10Base-T Half-Duplex as the 
Half-Duplex default value. 

10Base-T Selects 10Base-T Full-Duplex as the 
Full-Duplex default value. 

100Base-TX Half-Duplex Selects 100Base-TX Half-Duplex as 
the default value. 

100Base-TX Full-Duplex Selects 100Base-TX Full-Duplex as 
the default value. 

Current Ethernet Settings Displays the current settings of Ethernet. 

MAC Address Displays the MAC address of the printer. 

Port Status LPD	 Specifies whether to enable LPD. 

Port9100	 Specifies whether to enable Port9100. 

WSD	 Specifies whether to enable the WSD port. 

Bonjour (mDNS) Specifies whether to enable the Bonjour (mDNS) feature. 

E-Mail Alert Specifies whether to enable the E-Mail Alert feature. 

SNMP	 Specifies whether to enable the SNMP. 

*1 This item is available only when the printer is connected with a wired network. 
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TCP/IP 

Purpose: 

To configure the IP address, subnet mask, and gateway address of the printer. 

Values: 

TCP/IP Settings IP Mode Specifies the IP mode. 

Host Name Specifies the host name. 

IPv4 IP Address Mode Selects the IP address mode. 

Manual IP Address Manually sets the IP address. 

Manual Subnet Mask Manually sets the subnet mask. 

Manual Gateway Address Manually sets the gateway address. 

IPv6 Enable Stateless Address To enable the stateless address. 

Use Manual Address To set the IP address manually. 

Manual Address Manually sets the IP address. To 
specify an IPv6 address, enter the 
address. Followed by a slash (/) and 
then "64". For details, consult your 
system administrator. 

Manual Gateway Address Manually sets the gateway address. 

DNS DNS Domain Name Specifies the domain name of the domain name server. Up to 255 
alphanumeric characters, periods, and hyphens can be used. If you 
need to specify more than one domain name, separate them using a 
comma or semicolon. 

IPv4 Get DNS Server Address 
from DHCP 

Specifies if the printer receives the 
DNS server address automatically 
from the DHCP server. 

Manual DNS Server Address Sets the DNS server address. 

IPv6 Get DNS Server Address 
from DHCPv6-lite 

Specifies if the printer receives the 
DNS server address automatically 
from the DHCPv6-lite server. 

Manual DNS Server Address Sets the DNS server address. 

Priority to IPv6 DNS Name 
Resolution 

Specifies whether to enable the DNS 
Name Resolution feature. 

LPD Connection Time-Out Sets the connection time-out period from 1 to 1000 seconds. 

IP Filter (IPv4) Click IP Filter (IPv4) to set the IP filter settings on the IP Filter 
(IPv4) page. 

Port9100 Port Number Sets the port number from 9000 to 9999. 

Connection Time-Out Sets the connection time-out period between 1 and 1000 seconds. 

IP Filter (IPv4) Click IP Filter (IPv4) to set the IP filter settings on the IP Filter 
(IPv4) page. 
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WSD Port Number Sets the port number. This must be 80 or between 8000 and 9999. 

Receive Time-Out Sets the receive time-out period from 1 to 65535 seconds. 

Notification Time-Out Sets the notification time-out period from 1 to 60 seconds. 

Maximum Number of TTL Sets the maximum number of TTL from 1 to 10. 

Maximum Number of 
Notification 

Sets the maximum number of notifications from 10 to 20. 

HTTP Port Number Sets the port number. This must be 80 or between 8000 and 9999. 

Simultaneous Connections Displays the maximum number of connections received 
simultaneously by the client. 

Connection Time-Out Sets the connection time-out period from 1 to 255 seconds. 

E-Mail Alert 

Purpose:
 

To configure settings for E-Mail Alert. This page can also be displayed by clicking E-Mail Alert in the left frame.
 

Values:
 

E-Mail Server Settings Primary SMTP Gateway Sets the primary SMTP gateway. 

SMTP Port Number Specifies the SMTP port number. This must be 25, 587 or between 
5000 and 65535. 

E-Mail Send Authentication Specifies the authentication method for outgoing e-mail. 

SMTP Login User	 Specifies the SMTP login user. Up to 63 alphanumeric characters, 
periods, hyphens, underscores, and at symbols (@) can be used. If 
specifying more than one address, separate them using commas. 

SMTP Login Password Specifies the SMTP account password using up to 31 alphanumeric 
characters. 

Re-enter SMTP Login Enter the SMTP account password again to confirm. 
Password 

POP3 Server Address*1 Specifies the POP3 server address in IP address format of 
"aaa.bbb.ccc.ddd" or as a DNS host name using up to 63 characters. 

POP3 Port Number*1 Specifies the POP3 server port number. This must be 110 or 
between 5000 and 65535. 

POP User Name*1	 Specifies the POP3 account user name. Up to 63 alphanumeric 
characters, periods, hyphens, underscores, and at symbols (@) can 
be used. If specifying more than one address, separate them using 
commas. 

POP User Password*1 Specifies the POP3 account password using up to 31 alphanumeric 
characters. 

Re-enter POP User Enter the POP3 account password again to confirm. 
Password*1 

Reply Address Designates the reply e-mail address sent with each e-mail alert. 

SMTP Server Connection Displays the status of the SMTP server connection. 
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E-Mail Alert Settings E-Mail List 1 Sets acceptable e-mail addresses for the e-mail alert feature using 
up to 255 alphanumeric characters. 

Select Alerts for List 1 Supplies Alerts	 Specifies whether to receive an e-mail 
alert for consumables. 

Paper Handling Alerts	 Specifies whether to receive an e-mail 
alert for paper handling. 

Service Call Specifies whether to receive an e-mail 
alert for service calls. 

E-Mail List 2 Sets acceptable e-mail addresses for the e-mail alert feature using 
up to 255 alphanumeric characters. 

Select Alerts for List 2 Supplies Alerts	 Specifies whether to receive an e-mail 
alert for consumables. 

Paper Handling Alerts	 Specifies whether to receive an e-mail 
alert for paper handling. 

Service Call Specifies whether to receive an e-mail 
alert for service calls. 

*1 This item is available only when POP before SMTP for E-Mail Send Authentication is selected. 

Bonjour (mDNS) 

Purpose: 

To configure the detailed settings for Bonjour. 

Values: 

Host Name Specifies the host name up to 63 alphanumeric characters and "-" (dash). The original setting will 
remain valid if nothing is entered. 

Printer Name Specifies the printer name up to 63 alphanumeric characters and symbol sets. 

SNMP 

Purpose: 

To configure the detailed settings of SNMP. 

Values: 

Community Name Community Name (Read 
only)*1 

Specifies the community name to access (read only) data using up 
to 31 alphanumeric characters. 

The original setting will remain valid if nothing is entered. 
Characters entered for community name in the previous settings 
will not be displayed on the screen. The default Read Community 
is public. 

Re-enter Community Name 
(Read only)*1 

Enter the community name to access (read only) data again to 
confirm. 

Community Name 
(Read/Write)*1 

Specifies the community name to access (read and write) data 
using up to 31 alphanumeric characters. 

The original setting will remain valid if nothing is entered. 
Characters entered for community name in the previous settings 
will not be displayed on the screen. The default Read/Write 
Community is private. 
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Re-enter Community Name Enter the community name to access (read and write) data again to 
(Read/Write)*1 confirm. 

Community Name (Trap)*1	 Specifies the community name used for trap up to 31 
alphanumeric characters. 

The original setting will remain valid if nothing is entered. 
Characters entered for community name in the previous settings 
will not be displayed on the screen. The default Trap Community is 
" " (NULL). 

Re-enter Community Name Enter the community name used for trap again to confirm. 
(Trap)*1 

Trap Notification 1-4 Trap Address Type	 Select the trap address type from the list. Selecting Off clears the 
settings in Trap Address, Port Number, and Notify, and does not 
notify trap occurrence. Selecting IPv4 or IPv6 allows you to enter 
Trap Address. 

Trap Address	 Specifies the IP address and IP socket in the following format: 

• IPv4  

Specifies the IP address and IP socket in the 
nnn.nnn.nnn.nnn:mmmmm format. Each section of "nnn" is a 
variable value between 0 and 255. Note that values 127 and 224
254 are not valid for the first three-digits only. The IP socket 
mmmmm is a variable value between 0 and 65535. 

• IPv6  

Specifies the IP address and IP socket in the 
xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:mmmmm format. Each 
section of "xxxx" is a hexadecimal variable value between 0 and 
ffff. The IP socket mmmmm is a variable value between 0 and 
65535. 

Port Number Enter the SNMP trap destination port number. 

Notify	 Specifies whether to notify trap occurrence. 

Authenticate Error Trap	 Specifies whether to notify Authenticate Error Trap. 

*1 The default value can be changed by using Dell Printer Configuration Web Tool. 
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Wireless LAN 

Purpose: 

To configure wireless network settings.
 

To connect the printer with a wireless network, be sure to disconnect the Ethernet cable.
 

NOTE: Once wireless LAN is activated, wired LAN protocol will be disabled. 

Values: 

Wireless Settings Wireless LAN Specifies whether to enable wireless connection. 

SSID Specifies the name that identifies the wireless network using up to 
32 alphanumeric characters. 

Network Type Specifies the network type from either Ad-Hoc or Infrastructure. 

MAC Address Displays the MAC address of the wireless network setting of the 
printer. 

Link Channel Displays the channel number of the wireless connection of the 
printer. 

Link Quality Displays the quality of the wireless network connection of the 
printer. 

Security Settings Encryption Select the security method from the list. 

No Security Specifies No Security to configure 
the wireless setting without 
specifying a security method from 
WEP, WPA-PSK TKIP, WPA-PSK 
AES/WPA2-PSK AES, and Mixed 
Mode PSK. 

WEP Specifies the WEP to use through 
the wireless network. 

WPA-PSK TKIP*1 Specifies the WPA-PSK TKIP to use 
through the wireless network. 

WPA-PSK AES/WPA2-PSK 
AES*1 

Specifies the WPA-PSK AES/WPA2
PSK AES to use through the wireless 
network. 

Mixed Mode PSK Specifies the Mixed Mode PSK to 
use through the wireless network 
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WEP Encryption Select the WEP key code from the list. 

WEP Key 1 Enter the WEP key when WEP is selected from Encryption of 
Security Settings. 

Re-enter WEP Key 1 Enter the WEP key 1 again to confirm. 

WEP Key 2 Enter the WEP key when WEP is selected from Encryption of 
Security Settings. 

Re-enter WEP Key 2 Enter the WEP key 2 again to confirm. 

WEP Key 3 Enter the WEP key when WEP is selected from Encryption of 
Security Settings. 

Re-enter WEP Key 3 Enter the WEP key 3 again to confirm. 

WEP Key 4 Enter the WEP key when WEP is selected from Encryption of 
Security Settings. 

Re-enter WEP Key 4 Enter the WEP key 4 again to confirm. 

Transmit Key Specifies the transmit key type from the list. 

WPA-PSK Pass Phrase Specifies the passphrase. 

Re-enter Pass Phrase Enter the passphrase again to confirm. 

*1 This item is available only when the Infrastructure mode is selected for Network Type. 

Reset Print Server 

Purpose: 

To initialize NVM (non-volatile memory) for the network feature and reboot the printer. You can also initialize NVM 
of the printer from Reset Defaults in the Printer Settings menu. 

Values: 

Initialize NIC NVRAM Click Start to initialize NVM. Network settings will revert to the factory default settings and 
Memory and restart printer. reboot the network capability. 

Restart Printer Click Start to reboot the printer. 

Dell™ Printer Configuration Web Tool 108 



   

 

  

    

  

   

  
 

 

  

Security 

The Security tab contains the Set Password and IP Filter (IPv4) pages. 

Set Password 

Purpose: 

To set or change the password that is required to access the setup parameters of the printer from the Dell Printer
 
Configuration Web Tool.
 

This page can also be displayed by clicking Set Password in the left frame.
 

NOTE: If you forgot your password, initialize NVM (non-volatile memory) to restore the password to the default (NULL). See 
"Reset Print Server" on page 108. 

NOTE: When you change the password to lock the operator panel, set the password from Panel Lock Set in the Printer Settings. 

Values: 

Administrator Password Sets the password using up to 10 alphanumeric characters. The password will appear as asterisks 
(*) in the field when it is entered. 

Re-enter Administrator Enter the password again to confirm. 
Password 

Access denial by the Sets the maximum number that the administrator fails to log in. If you set 0, this feature is 
authentication failure of the disabled. The failed attempts counter is reset to 0 by a successful authentication. Every 
Administrator administrator authentication is rejected if the counter exceeds the maximum number of failed 

login attempts. 

IP Filter (IPv4) 

Purpose: 

To specify the IP address and subnet mask to be permitted or denied access to the printer. 

NOTE: This item is only available for LPD or Port9100. 

Values: 

Address Specifies the IP addresses that are permitted or denied access to the printer. Enter a numeric value 
between 0 and 255 in each field. 

Address Mask Specifies the subnet mask that are permitted or denied access to the printer. Enter a numeric 
value between 0 and 255 in each field. 

Active Mode Reject Rejects printing from specified network address. 

Permit Permits printing from specified network address. 

Disabled Disables the IP Filter feature for the specified IP address. 
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Copy Printer Settings 
The Copy Printer Settings menu contains the Copy Printer Settings and Copy Printer Settings Report pages. 

Copy Printer Settings 

Purpose: 

To copy the printer settings to one or more printers of the same model. 

To copy the settings to another printer, specify the IP address and password of the printer to which the settings are 
copied in the IP Address text box and Password text box. Then, click Copy the settings to the Host in the above list. 
Copying the settings is complete. The connection time-out period is 60 seconds. After that, you can check whether 
the settings were copied to this page. And you need to click Copy settings to the Host in the above list and reboot 
the machine of the Dell Printer Configuration Web Tool in the destination printer to verify if the settings were 
actually copied or not. 

If the settings can be copied but the printer configuration is different, the settings of only the common items are 
copied. Printer settings can be copied to 10 IP addresses of printers simultaneously. 

Copy Printer Settings Report 

Purpose: 

To verify the histories of copying. 

NOTE: The history is cleared by turning off the printer. 

Print Volume 
Purpose:
 

Use the Print Volume menu to verify the number of printed pages.
 

Values:
 

Printer Page Count Displays the total number of pages printed since the printer was shipped from the factory. 

Paper Used Displays the number of pages printed for each paper size. 
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Understanding the Tool Box Menus
 
The Tool Box allows you to view or specify the printer settings. You can also diagnose the printer settings by using 

the Tool Box.
 

The Tool Box consists of the Printer Settings Report, Printer Maintenance, and Diagnosis tabs.
 

NOTE: The Password dialog box appears the first time you try to change settings on Tool Box when Panel Lock is set on the 
printer. In this case, enter the password you specified, and click OK to apply the settings. 

Starting the Tool Box 
Click Start → All Programs → Dell Printers → Dell C1760nw Color Printer or Dell C1660w Color Printer → Tool Box. 

NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this case, 
click Dell C1760nw Color Printer or Dell C1660w Color Printer listed in Printer Name, and then click OK. 

The Tool Box opens. 

Using the Tool Box to Change the Printer Settings 
You can select menu items and corresponding values from the Tool Box. 

To select a new value as a setting: 

1 Click Start → All Programs → Dell Printers → Dell C1760nw Color Printer or Dell C1660w Color Printer 
→ Tool Box. 

NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1760nw Color Printer or Dell C1660w Color Printer listed in Printer Name, and then click OK. 

The Tool Box opens.
 

2 Click the Printer Maintenance tab.
 

3 Select the desired menu item.
 

Each menu item has a list of values for the menu item. A value can be:
 

• A phrase or word to describe a setting 

• A numerical value that can be changed 

• An On or Off setting
 

4 Select the desired value, and then click the associated button with each menu item.
 

Driver settings may have precedence over changes previously made and may require you to change the Tool Box 
defaults. 
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Printer Settings Report 
The Printer Settings Report tab contains the Printer Information, Menu Settings, Reports, and TCP/IP Settings 
pages. 

Printer Information 
Purpose: 

To display the information of your printer. 

Values: 

Dell Service Tag Number Displays the service tag number of your printer. 

Express Service Code Displays the express service code of the printer. 

Printer Serial Number Displays the serial number of the printer. 

Printer Type Displays the type of the printer. 

Asset Tag Number Displays the asset tag number of the printer. 

Memory Capacity Displays the memory capacity. 

Processor Speed Displays the processing speed. 

Firmware Version Displays the version of the controller. 

Network Firmware Version Displays the Network Interface Card (NIC) version. 

MCU Firmware Version Displays the version of the Machine Control Unit (MCU) firmware. 

Printing Speed (Color) Displays the speed for color printing. 

Printing Speed (Monochrome) Displays the speed for monochrome printing. 

Menu Settings 
Purpose: 

To display the current settings of your printer. 

Values: 

System Settings Power Saver Timer - Sleep Displays the time taken by the printer before it enters 
Sleep mode after it finishes a job. 

Power Saver Timer - Deep Sleep Displays the time taken by the printer before it enters 
Deep Sleep mode after it goes into Sleep mode. 

Power Saver Timer - Auto-Off Timer *1 Displays the time it takes to automatically turn off the 
printer after the printer has entered the Deep Sleep mode. 

Fault Time-Out Displays the time taken by the printer before it cancels 
jobs that stop abnormally. 

Job Time-Out Displays the amount of time that the printer waits for data 
to arrive from the computer. 

Auto Log Print Displays whether to automatically print a job history 
report after every 10 jobs. 

mm/inch Displays the measurement unit used after the numeric 
value on the operator panel. 

Panel Language Displays the language used on the operator panel. 

Default Print Paper Size Displays the default paper size. 
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Low Toner Alert Message Displays whether to show the alert message when the 
toner is low. 

Disable printing with larger paper size	 Displays whether to disable printing if the paper size set in 
the printer driver and the paper size set in the tray of the 
printer does not match (the paper set in the tray is larger). 

Paper Density Plain	 Displays the paper density of plain paper. 

Label	 Displays the paper density of labels. 

Adjust BTR Plain Displays the voltage setting of the transfer roller for plain 
paper. 

Plain Thick Displays the voltage setting of the transfer roller for thick 
plain paper. 

Recycled Displays the voltage setting of the transfer roller for 
recycled paper. 

Covers Displays the voltage setting of the transfer roller for cover 
paper. 

Coated Displays the voltage setting of the transfer roller for coated 
paper. 

Envelope Displays the voltage setting of the transfer roller for 
envelopes. 

Label	 Displays the voltage setting of the transfer roller for labels. 

Adjust Fusing Unit Plain Displays the temperature setting of the fusing unit for 
plain paper. 

Plain Thick Displays the temperature setting of the fusing unit for 
thick plain paper. 

Recycled Displays the temperature setting of the fusing unit for 
recycled paper. 

Covers Displays the temperature setting of the fusing unit for 
cover paper. 

Coated Displays the temperature setting of the fusing unit for 
coated paper. 

Envelope Displays the temperature setting of the fusing unit for 
envelopes. 

Label Displays the temperature setting of the fusing unit for 
labels. 

Auto Registration Displays whether to automatically adjust color registration. 
Adjustment 

Adjust Altitude Displays the altitude of the location where the printer is installed. 

Non-Dell Toner Displays whether to use toner cartridge of another manufacturer. 

BTR Refresh Mode Displays whether to execute counter measures for curling/separating discharge of the paper. 

*1 Auto-Off Timer feature is available only in certain regions. 
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Reports 
Purpose: 

To print the settings and history information of your printer.
 

The reports are printed in the paper size specified in printer settings.
 

Values: 

Printer Settings Click to print a detailed list of the printer settings. 

Device Settings Click to print a detailed list of the device settings. 

Job History Click to print the completed jobs history. 

Error History Click to print the error history. 

Color Test Page Click to print a color test page. 

TCP/IP Settings 
Purpose: 

To display the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol. 

Values: 

IP Address Mode Displays the method for acquiring the IP address. 

IP Address Displays the IP address of your printer. 

Subnet Mask Displays the subnet mask. 

Gateway Address Displays the gateway address. 

Printer Maintenance 
The Printer Maintenance tab contains the System Settings, Paper Density, Adjust BTR, Adjust Fusing Unit, Color 
Registration Adjustment, Adjust Altitude, Reset Defaults, Non-Dell Toner, BTR Refresh Mode, TCP/IP Settings, 
and Network Settings pages. 

System Settings 
Purpose: 

To configure the power saving mode, time-out time, job log auto print, mm/inch setting, operator panel language 
setting, default paper size setting, and low toner alert message setting. 

Values: 

Sleep*1 Available Range: Specifies the time taken by the printer before it enters Sleep mode after it 
5–30 minutes finishes a job. 

Deep Sleep Available Range: Specifies the time taken by the printer before it enters Deep Sleep mode 
1–6 minutes after it goes into Sleep mode. 

Auto-Off Timer*2 0: Off Specifies the time taken by the printer before it automatically turns off 

60–1440 minutes after it has entered Deep Sleep mode. 

Fault Time-Out 0: Off Disables the fault time-out. 

Available Range: Specifies the time taken by the printer before it cancels jobs that stop 
3–300 seconds abnormally. The print job is cancelled if it times out. 

Understanding the Tool Box Menus 114 



   
 

  

 

 

 

 

 

     
 

      
     

      
  

   
   

Job Time-Out 0: Off	 Disables the job time-out. 

Available Range: Specifies the amount of time that the printer waits for data to arrive from 
5–300 seconds the computer. The print job is cancelled if it times out. 

Auto Log Print Off	 Does not automatically print a job history report. 

On	 Automatically prints a job history report after every 10 jobs. 

mm/inch millimeter (mm)	 Specifies the measurement unit displayed after the numeric value on the 
operator panel.inch (") 

Panel Language English	 Specifies the language to be used on the operator panel. 

French 

German 

Italian 

Spanish 

Danish 

Dutch 

Norwegian 

Swedish 

Default Print Paper Size A4 Specifies the default paper size. 

Letter 

Low Toner Alert On Shows the alert message when the toner is low. 
Message Off	 Does not show the alert message. 

Disable printing with Off Prints even if the paper set in the tray of the printer is larger than the 
larger paper size*3 paper size set in the printer driver (the paper size does not have to match). 

On Disables printing if the paper size set in the printer driver differs from the 
paper set in the tray of the printer (the paper set in the tray is larger). 

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes. 

*1	 Enter 5 in Sleep to put the printer in the Sleep mode five minutes after it finishes a job. This uses less energy, but requires more warm-
up time for the printer. Enter 5 if your printer shares an electrical circuit with room lighting and you notice lights flickering. 
Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate with minimum 
warm-up time. Select a value between 5 and 30 minutes for the Sleep mode if you want a balance between energy consumption and a 
shorter warm-up period. 
The printer automatically returns to the standby mode from the Sleep mode when it receives data from the computer. You can also 
return the printer to the standby mode by pressing any button on the operator panel. 

*2 Auto-Off Timer feature is available only in certain regions.
 
*3 Disable printing with larger paper size is available only in the Dell Printer Configuration Web Tool and the Tool Box.
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Paper Density 
Purpose: 

To specify the paper density. 

Values: 

Plain Normal Specifies the paper density of plain paper. 

Light 

Label Normal Specifies the paper density of labels. 

Light 

Apply New Settings After you complete the settings, click Apply New Settings to apply the 
changes. 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 

Adjust BTR 
Purpose: 

To specify the optimum voltage settings for printing for the transfer roller (BTR). To decrease the voltage, set 
negative values. To increase, set positive values.
 

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 

increase the voltage. If you see white spots on the print output, try to decrease the voltage.
 

NOTE: The print quality changes depending on the values you select for this item. 

Values: 

Plain Available Range: 
-3 – +3 

Plain Thick Available Range: 
-3 – +3 

Recycled Available Range: 
-3 – +3 

Covers Available Range: 
-3 – +3 

Coated Available Range: 
-3 – +3 

Envelope Available Range: 
-3 – +3 

Label Available Range: 
-3 – +3 

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes. 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 
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Adjust Fusing Unit 
Purpose: 

To specify the optimum temperature settings for printing for the fusing unit. To decrease the temperature, set 
negative values. To increase, set positive values.
 

The default settings may not give the best output on all paper types. When the printed paper has curled, try to 

decrease the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.
 

NOTE: The print quality changes depending on the values you select for this item. 

Values: 

Plain Available Range: 
-3 – +3 

Plain Thick Available Range: 
-3 – +3 

Recycled Available Range: 
-3 – +3 

Covers Available Range: 
-3 – +3 

Coated Available Range: 
-3 – +3 

Envelope Available Range: 
-3 – +3 

Label Available Range: 
-3 – +3 

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes. 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 

Color Registration Adjustment 
Purpose: 

To set Color Registration Adjustment (individual yellow, magenta, cyan correction) settings. When Auto 
Registration Adjustment is set to On, the printer prints the color registration chart and adjusts the color registration 
by using the chart. Color registration adjustments need to be made during the initial setup of the printer or when 
the printer is moved to a different location. 

Values: 

Auto Registration On Automatically adjusts color registration. 
Adjustment Off Does not automatically adjust color registration. 

Auto Correct*1 Click Start to automatically correct color registration. 

Print Color Regi Chart*1, *2 Click Start to open the Print Color Regi Chart window, and then select the 
paper size and click OK to print a color registration chart. 
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Registration 
Adjustments*1 

Y(Yellow) Available Range: 
-5–+5 

Specifies lateral (perpendicular to paper feed direction) 
color adjustment values individually. 

M(Magenta) Available Range: 
-5–+5 

C(Cyan) Available Range: 
-5–+5 

LY(Left Yellow) Available Range: 
-5–+5 

Specifies process (paper feed direction) color 
adjustment values individually. 

LM(Left Magenta) Available Range: 
-5–+5 

LC(Left Cyan) Available Range: 
-5–+5 

RY(Right Yellow) Available Range: 
-5–+5 

RM(Right Magenta) Available Range: 
-5–+5 

RC(Right Cyan) Available Range: 
-5–+5 

Apply New Settings After you complete 
changes. 

the settings, click Apply New Settings to apply the 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 

*1	 This item is available only when Auto Registration Adjustment is set to Off. 
*2	 The color registration chart prints a lattice pattern of yellow, magenta, and cyan lines. On the chart, find the values on the right side that 

are next to the line that is perfectly straight for each of the three colors. If the value for this line is 0, color registration is not needed. If 
the value for this line is any value other than 0, specify the adjustment values under Registration Adjustments. 

Adjust Altitude 
Purpose: 

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used. 

NOTE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner. 

Values: 

0 meter Specifies the altitude of the location where the printer is installed. 

1000 meters 

2000 meters 

3000 meters 

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes. 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 
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Reset Defaults 
Purpose: 

To initialize NVM (non-volatile memory) for system parameters. After executing this function and rebooting the 
printer, all the menu parameters, except the parameters for the network, are reset to their default values. 

For details, see "Resetting Defaults" on page 123. 

Values: 

Start Click to initialize the system parameters. 

Non-Dell Toner 
Purpose: 

To use toner cartridge of another manufacturer. 

NOTE: Using non-Dell™-brand toner cartridges may make some printer features unusable, reduce print quality and decrease 
the reliability of your printer. Dell recommends only new Dell-brand toner cartridges for your printer. Dell does not provide 
warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell. 

NOTE: Before you use toner cartridge of another manufacturer, be sure to restart the printer. 

Values: 

Non-Dell Toner Off Does not use toner cartridge of another manufacturer. 

On Use toner cartridge of another manufacturer. 

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes. 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 

BTR Refresh Mode 
Purpose: 

To execute counter measures for curling/separating discharge of the paper. 

Values: 

BTR Refresh Mode Off Does not automatically execute counter measures for curling/separating discharge of 
the paper. 

On Automatically executes counter measures for curling/separating discharge of the paper. 

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes. 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 
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TCP/IP Settings 
Purpose: 

To configure TCP/IP settings. 

Values: 

IP Address Mode AutoIP Automatically sets the IP address. 

DHCP Uses DHCP to set the IP address. 

BOOTP Uses BOOTP to set the IP address. 

RARP Uses RARP to set the IP address. 

Manually Set Manually sets the IP address. 

IP Address Manually sets the IP address allocated to the printer. 

Subnet Mask Manually sets the subnet mask. 

Gateway Address Manually sets the gateway address. 

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes. 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 

Network Settings 
Purpose:
 

To display the server settings of the Dell Printer Configuration Web Tool.
 

NOTE: When the printer is connected to the USB port, this setting cannot be displayed. 

Values: 

Print Server Display Click to display the server settings for the Dell Printer Configuration Web Tool. 
Settings 

Display of Dell Off Turns off the display of the server settings for the Dell Printer Configuration Web 
Configuration Web Tool. 
Tool On Turns on the display of the server settings for the Dell Printer Configuration Web 

Tool. 

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes. 

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes. 
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Diagnosis 
The Diagnosis tab contains the Chart Print, Machine Check, Environment Sensor Info, Developer Stir Mode, and 
Refresh Mode pages. 

Chart Print 
Purpose: 

To print various charts that can be used for diagnosing your printer. 

Values: 

Paper Size A4 Selects the paper size to print charts. 

Letter 

Ghost Configuration Chart Click to print a chart to check for ghost printing. 

4 Colors Configuration Chart Click to print bands of yellow, magenta, cyan, and black with varying density. 

Alignment Chart Click to print a chart, and then check for proper alignment of the print image on the 
paper. 

Drum Refresh Configuration Chart Prints a chart to check the light fatigue of the drum cartridge. 

Machine Check 
Purpose: 

To check the operation of the different components of the printer. 

Values: 

Machine Check Main Motor Operation Click Start to operate the main motor inside the printer. Confirm the motor 
Check sound. 

Feed Roll Operation Click Start to operate the feed roll. Confirm the motor sound. 
Check*1 

REGI CLUTCH Click Start to operate the REGI CLUTCH. Confirm that you can hear the 
Operation Check clutch clicking. 

Dispense Motor Check Click Start to operate the dispense motor for each toner cartridge. Confirm 
(Yellow) the motor sound. 

Dispense Motor Check 
(Magenta) 

Dispense Motor Check 
(Cyan) 

Dispense Motor Check 
(Black) 

Play of Sound Click to play back through speakers of your computer a recording of the 
normal sound for the currently selected Machine Check item. 

Start Click to check the operation of the item selected in Machine Check and 
display the results to Result. 

*1 When you perform the feed roll operation check, remove the paper from the Multipurpose Feeder (MPF). 
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Environment Sensor Info 
Purpose:
 

To display the internal environment sensor information of the printer to Result.
 

Get Environment Sensor Info Click to confirm the internal environment sensor information of the printer such as 
temperature and humidity. 

Developer Stir Mode 
Purpose: 

To rotate the developer motor and stir the toner in the toner cartridge. 

Values: 

Start Click to stir the toner. 

Refresh Mode 
Purpose: 

To use up a toner cartridge when you need to replace it before the end of its life, or to stir the toner in a new toner 
cartridge. 

NOTE: Using the Refresh Mode consumes extra toner. 

Values: 

Yellow Click to clean the toner in the yellow toner cartridge. 

Magenta Click to clean the toner in the magenta toner cartridge. 

Cyan Click to clean the toner in the cyan toner cartridge. 

Black Click to clean the toner in the black toner cartridge. 
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Resetting Defaults 
After executing this function and rebooting the printer, all the menu parameters are reset to their default values. 

The following menu parameters are exceptions and are not reset. 

•	 Network settings 

•	 Panel Lock settings and password 

•	 Login Error settings 

•	 USB Port settings 

1	 Click Start → All Programs → Dell Printers → Dell C1760nw Color Printer or Dell C1660w Color Printer → 
Tool Box. 

NOTE: For details about starting the Tool Box, see "Starting the Tool Box" on page 111. 

The Tool Box opens.
 

2 Click the Printer Maintenance tab.
 

3 Select Reset Defaults from the list at the left side of the page.
 

The Reset Defaults page is displayed.
 

4 Click Start.
 

The printer restarts automatically to apply the settings.
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Understanding the Printer Menus 
When your printer is configured as a network printer available to a number of users, the access to the Admin Menu 
menus can be limited. This prevents unauthorized users from using the operator panel to inadvertently change the 
default menu settings that has been set by the administrator. However, you can select settings for individual print 
jobs using the printer driver. Print settings selected from the printer driver have precedence over the default menu 
settings selected from the operator panel. 

Report/List 
Use the Report/List menu to print the settings and history information of your printer. 

NOTE: A Password is required to enter the Report/List menu when Panel Lock Set is set to Enable. In this 
case, enter the password you specified, and press the (Set) button. 

Printer Setting 
Purpose: 

To print a list of the information such as the printer name, service tag, the status of the printer, consumables, and 
the network settings. 

Device Settings 
Purpose: 

To print a detailed list of all the settings on the operator panel menus. 

Job History 
Purpose: 

To print a detailed list of the print jobs that have been processed. This list contains the last 10 print jobs. 

Error History 
Purpose: 

To print a detailed list of paper jams and fatal errors. 

Color Test Page 
Purpose: 

To print a page for testing colors. 

Printing a Report/List Using the Operator Panel 
1 Press the (Menu) button.
 

2 Press the 
 button until Report/List appears, and then press the (Set) button.
 

3 Press the 
  button until the desired report or list appears, and then press the (Set) button.
 

The selected report or list is printed.
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Printing a Report/List Using the Tool Box 
1 Click Start → All Programs → Dell Printers → Dell C1760nw Color Printer or Dell C1660w Color Printer 
→ Tool Box. 

NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1760nw Color Printer or Dell C1660w Color Printer listed in Printer Name, and then click OK. 

The Tool Box opens.
 

2 Click the Printer Settings Report tab.
 

3 Select Reports from the list at the left side of the page.
 

The Reports page is displayed.
 

4 Click the button for the desired report or list.
 

The report or list is printed.
 

Admin Menu 
Use the Admin Menu menu to configure a variety of printer features. 

NOTE: A Password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this 
case, enter the password you specified, and press the (Set) button. 

Network 
Use the Network menu to change the printer settings affecting jobs sent to the printer through the wired or 
wireless network. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

Ethernet (Dell C1760nw Color Printer only) 

Purpose: 

To specify the communication speed and the duplex settings of Ethernet. The change takes effect after the printer is 
turned off and then on. 

Values: 

Auto* Detects the Ethernet settings automatically. 

10Base Half Uses 10base-T half-duplex. 

10Base Full Uses 10base-T full-duplex. 

100Base Half Uses 100base-TX half-duplex. 

100Base Full Uses 100base-TX full-duplex. 

NOTE: This item is not displayed when the Ethernet cable is disconnected and Wireless LAN is set to Enable. 
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Wireless LAN 

Purpose: 

To enable the wireless connection. 

Values: 

Enable Enables the wireless connection. 

Disable Disables the wireless connection. 

NOTE: For Dell C1760nw Color Printer, the factory default is Enable. For Dell C1660w Color Printer, the factory default is 
Disable. 

NOTE: When you use the USB connection and do not use the wireless connection, you need to disable the wireless LAN. 

Wireless Status 

Purpose: 

To display the information on the wireless signal strength. No changes can be made on the operator panel to improve 
the status of the wireless connection. 

Values: 

Good Indicates good signal strength. 

Acceptable Indicates marginal signal strength. 

Low Indicates insufficient signal strength. 

No Reception Indicates that no signal is received. 

NOTE: For Dell C1760nw Color Printer, this item is displayed when the Ethernet cable is disconnected and Wireless LAN is 
set to Enable. 

NOTE: For Dell C1660w Color Printer, this item is displayed only when Wireless LAN is set to Enable. 

Wireless Setup 

Purpose: 

To configure the wireless network interface. 

Values: 

Select Access Select the access point from the list. 

WEP Key When you select an access point using WEP as the security method, 
enter the WEP key. For 64bit keys, up to 10 hexadecimal characters 
can be entered. For 128bit keys, up to 26 hexadecimal characters can 
be entered. 

PassPhrase 
Entry 

When you select an access point using WPA, WPA2, or Mixed as the 
encryption type, enter the passphrase of 8 to 63 alphanumeric 
characters. 

Understanding the Printer Menus 127 



 

  

    

  

 

 

 

 
  

 

 

 

  

 
  

 

Manual Setup Enter (SSID) Specify a name to identify the wireless network. Up to 32 
alphanumeric characters can be entered. 

Infrastructure Select when you configure the wireless setting through the access 
point such as a wireless router. 

No Security* Specify No Security to configure the wireless setting without 
specifying a security method from WEP, WPA-PSK-TKIP, and WPA2
PSK-AES. 

Mixed mode PSK Select to configure the wireless setting with the encryption type of 
Mixed mode PSK. Mixed mode PSK automatically selects the 
encryption type from either WPA-PSK-TKIP, WPA-PSK-AES, or 
WPA2-PSK-AES. 

PassPhrase Specifies the passphrase of alphanumeric characters 
Entry from 8 to 63. 

WEP Specifies the WEP key to use through the wireless network. For 64bit 
keys, up to 10 hexadecimal characters can be entered. For 128bit keys, 
up to 26 hexadecimal characters can be entered. 

Transmit Key Specifies the transmit key from Auto* , WEP Key 1, 
WEP Key 2, WEP Key 3, and WEP Key 4. 

WPA-PSK-TKIP Select to configure the wireless setting with the security method of 
WPA-PSK-TKIP. 

PassPhrase Specify the pass phrase of alphanumeric characters 
Entry from 8 to 63. 

WPA2-PSK-AES Select to configure the wireless setting with the security method of 
WPA2-PSK-AES or WPA-PSK-AES. 

PassPhrase Specify the pass phrase of alphanumeric characters 
Entry from 8 to 63. 

Ad-hoc Select to configure the wireless setting without the access point such 
as a wireless router. 

No Security* Specify No Security to configure the wireless setting without 
specifying the security method from WEP. 

WEP Specifies the WEP key to use through the wireless network. For 64bit 
keys, up to 10 hexadecimal characters can be entered. For 128bit keys, 
up to 26 hexadecimal characters can be entered. 

Transmit Key Specifies the transmit key from WEP Key 1* , WEP 
Key 2, WEP Key 3, and WEP Key 4. 

NOTE: For Dell C1760nw Color Printer, this item is displayed when the Ethernet cable is disconnected and Wireless LAN is 
set to Enable. 
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WPS Setup 

Purpose: 

To configure the wireless network using WPS. 

Values: 

Push Btn. Ctrl PBC Start*1 Configures the wireless setting with the security method of WPS-PBC. 

PIN Code Start Config. Configures the wireless setting using the PIN code assigned automatically 
by the printer. 

Print PIN Code Prints the PIN code. Confirm it when you enter the PIN code to your 
computer. 

*1 You can also start  WPS-PBC by pressing and holding the (Wi-Fi | WPS) button. 

NOTE: WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, WPA-PSK 
AES, WPA2-PSK AES, WPA-PSK TKIP, Open (No Security) 

NOTE: For Dell C1760nw Color Printer, this item is displayed when the Ethernet cable is disconnected and Wireless LAN is 
set to Enable. 

NOTE: For Dell C1660w Color Printer, this item is displayed only when Wireless LAN is set to Enable. 

Reset Wireless 

Purpose: 

To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network 
settings are reset to their default values. 

NOTE: For Dell C1760nw Color Printer, this item is displayed when the Ethernet cable is disconnected and Wireless LAN is 
set to Enable. 

NOTE: For Dell C1660w Color Printer, this item is displayed only when Wireless LAN is set to Enable. 

TCP/IP 

Purpose: 

To configure TCP/IP settings. The change takes effect after the printer is turned off and then on. 

Values: 

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address. 

IPv4 Mode Uses IPv4 to set the IP address. 

IPv6 Mode Uses IPv6 to set the IP address. 

IPv4 Get IP Address AutoIP* Automatically sets the IP address. 

BOOTP Uses BOOTP to set the IP address. 

RARP Uses RARP to set the IP address. 

DHCP Uses DHCP to set the IP address. 

Panel Enables the IP address entered on the operator panel. 

IP Address Manually sets the IP address allocated to the printer. 

Subnet Mask Manually sets the subnet mask. 

Gateway Address Manually sets the gateway address. 

Understanding the Printer Menus 129 



 

 
  

   

  
 

 

 

 

  

 

Protocol 

Purpose: 

To enable or disable each protocol. The change takes effect after the printer is turned off and then on. 

Values: 

LPD Enable* Enables the Line Printer Daemon (LPD) port. 

Disable Disables the LPD port. 

Port9100 Enable* Enables the Port9100 port. 

Disable Disables the Port9100 port. 

WSD Enable* Enables the Web Services on Devices (WSD) port. 

Disable Disables the WSD port. 

SNMP UDP Enable* Enables the UDP port. 

Disable Disables the UDP port. 

E-Mail Alert Enable* Enables the E-mail Alert feature. 

Disable Disables the E-mail Alert feature. 

EWS Enable* Enables an access to Dell™ Printer Configuration Web Tool embedded in the printer. 

Disable Disables an access to Dell Printer Configuration Web Tool embedded in the printer. 

Bonjour (mDNS) Enable* Enables the Bonjour (mDNS). 

Disable Disables the Bonjour (mDNS). 

IP Filter 

Purpose: 

To block data received from certain IP addresses through the wired or wireless network. You can set up to five IP 
addresses. The change takes effect after the printer is turned off and then on. 

Values: 

No. n/Address 
(n is 1-5.) 

Sets the IP address for Filter n. 

No. n/Mask 
(n is 1-5.) 

Sets the address mask for Filter n. 

No. n/Mode 
(n is 1-5.) 

Off* 

Accept 

Disables the  feature for Filter n. 

Accepts an access from the specified IP address. 

Reject Rejects an access from the specified IP address. 

NOTE: This item is only available for LPD or Port9100. 

Reset LAN 

Purpose: 

To initialize network data stored in NVM (non-volatile memory). After executing this function and rebooting the 
printer, all network settings are reset to their default values. 
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USB Settings 
Use the USB Settings menu to change printer settings affecting a USB port. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

USB Port 

Purpose: 

To change the USB settings on your printer. The change takes effect after the printer is turned off and then on. 

Values: 

Enable* Enables the USB interface. 

Disable Disables the USB interface. 

System Settings 
Use the System Settings menu to configure a variety of printer features. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

PowerSaver Time 

Purpose: 

To specify the time for transition to power saver mode. 

Values: 

Sleep 5min.* 

Available Range: 
5-30min. 

Specifies the time taken by the printer before it enters Sleep mode 
after it finishes a job. 

Deep Sleep 6min.* 

Available Range: 
1–6min. 

Specifies the time taken by the printer before it enters Deep Sleep 
mode after it goes into Sleep mode. 

Auto-Off Timer*1 Off Disables the Auto-Off Timer. 

On* 180min.* 

Available Range: 
60–1440min. 

Specifies the time it takes to automatically turn off the printer after it 
has entered Deep Sleep mode. 

*1 Auto-Off Timer feature is available only in certain regions. 

Enter 5 in Sleep to put the printer in the Sleep mode five minutes after it finishes a job. This uses less energy, but 
requires more warm-up time for the printer. Enter 5 if your printer shares an electrical circuit with room lighting and 
you notice lights flickering. 

Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate 
with minimum warm-up time. Select a value between 5 and 30 minutes for the Sleep mode if you want a balance 
between energy consumption and a shorter warm-up period. 

The printer automatically returns to the standby mode from the Sleep mode when it receives data from the 
computer. You can also return the printer to the standby mode by pressing any button on the operator panel. 

If the Auto-Off Timer feature turns off the printer, the printer cannot be turned back on automatically. To turn the 
printer back on, physically turn the power switch of the printer to On. 
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Fault Time-Out 

Purpose: 

To specify the time taken by the printer before it cancels jobs that stop abnormally. The print job is cancelled if it 
times out. 

Values: 

On* 60 sec.* Specifies the time taken by the printer before it cancels jobs that stop abnormally. 

Available Range: 
3–300 sec. 

Off Disables the fault time-out. 

Job Time-out 

Purpose: 

To specify the amount of time that the printer waits for data to arrive from the computer. The print job is cancelled 
if it times out. 

Values: 

On* 30 sec.* Specifies the amount of time that the printer waits for data to arrive from the computer. 

Available Range: 
5–300 sec. 

Off Disables the job time-out. 

mm/inch 

Purpose: 

To specify the measurement unit displayed after the numeric value on the operator panel. 

Values: 

millimeter(mm) Specifies the default measurement unit. 

inch(") 

NOTE: The default for mm/inch varies depending on country-specific factory default. 

Def. Paper Size 

Purpose: 

To specify the default paper size. 

Values: 

A4 

Letter 

NOTE: The default for Def. Paper Size varies depending on country-specific factory default. 
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Auto Log Print 

Purpose: 

To automatically print a job history report after every 10 jobs. 

Values: 

Off* Does not automatically print a job history report. 

On Automatically prints a job history report. 

NOTE: The job history report can also be printed using the Report/List menu. 

Low Toner Msg 

Purpose: 

To specify whether to show the alert message when toner is low. 

Values: 

On* Shows the alert message when the toner is low. 

Off Does not show the alert message when the toner is low. 

Power On Wizard (Dell C1660w Color Printer only) 

Purpose: 

To perform initial setup for the printer. 

Values: 

No* Does not perform the initial setup for the printer. 

Yes Performs the initial setup for the printer. 

Maintenance 
Use the Maintenance menu to initialize the NV (non-volatile) memory, configure the plain paper quality 
adjustment settings, and configure the security settings. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

F/W Version 

Purpose: 

To display the version of the controller. 

Service Tag 

Purpose: 

To display the service tag of the printer. 

Express Code 

Purpose: 

To display the express service code of the printer. 
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Paper Density 

Purpose: 

To specify the paper density. 

Values: 

Plain Normal* 

Light 

Label Normal* 

Light 

Adjust BTR 

Purpose: 

To specify the optimum voltage settings for printing for the transfer roller (BTR). To decrease the voltage, set 
negative values. To increase the voltage, set positive values. 

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage. 

NOTE: The print quality changes depending on the values you select for this item. 

Values: 

Plain 0* 

Available Range: -3 – +3 

Plain Thick 0* 

Available Range: -3 – +3 

Covers 0* 

Available Range: -3 – +3 

Label 0* 

Available Range: -3 – +3 

Coated 0* 

Available Range: -3 – +3 

Envelope 0* 

Available Range: -3 – +3 

Recycled 0* 

Available Range: -3 – +3 
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Adj. FusingUnit 

Purpose: 

To specify the optimum temperature settings for printing for the fusing unit. To decrease the temperature, set 
negative values. To increase the temperature, set positive values. 

The default settings may not give the best output on all paper types. When the printed paper has curled, try to 
decrease the temperature. When the toner does not fuse on the paper properly, try to increase the temperature. 

NOTE: The print quality changes depending on the values you select for this item. 

Values: 

Plain 0* 

Available Range: -3 – +3 

Plain Thick 0* 

Available Range: -3 – +3 

Covers 0* 

Available Range: -3 – +3 

Label 0* 

Available Range: -3 – +3 

Coated 0* 

Available Range: -3 – +3 

Envelope 0* 

Available Range: -3 – +3 

Recycled 0* 

Available Range: -3 – +3 

Auto Reg Adj 

Purpose: 

To specify whether to automatically adjust color registration. 

Values: 

On* Automatically adjusts color registration. 

Off Does not automatically adjust color registration. 
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Color Reg Adj 

Purpose: 

To specify whether to manually adjust color registration.
 
Color registration adjustments need to be made during the initial setup of the printer or when the printer is moved 

to a different location.
 

NOTE: The Color Reg Adj feature can be configured when Auto Reg Adj is set to Off. 

Values: 

Auto Correct	 Automatically corrects color registration. 

ColorRegi Chart	 Prints a color registration chart. The color registration chart prints a 
lattice pattern of yellow, magenta, and cyan lines. On the chart, find 
the values on the right side that are next to the line that is perfectly 
straight for each of the three colors. If the value for this line is 0, color 
registration is not needed. If the value for this line is any value other 
than 0, specify the adjustment values under Enter Number. 

Enter Number Y 0*	 Specifies lateral (perpendicular to paper feed direction) color 
adjustment values individually for Y (Yellow), M (Magenta), C Available Range: -5–+5 
(Cyan). 

M 0* 

Available Range: -5–+5 

C 0* 

Available Range: -5–+5 

LY 0*
 

Available Range: -5–+5
 

LM 0*
 

Available Range: -5–+5
 

LC 0*
 

Available Range: -5–+5
 

RY 0*
 

Available Range: -5–+5
 

RM 0*
 

Available Range: -5–+5
 

RC 0*
 

Available Range: -5–+5
 

Specifies process (paper feed direction) color adjustment values 
individually for LY (Left Yellow), LM (Left Magenta), LC (Left 
Cyan), RY (Right Yellow), RM (Right Magenta) and RC (Right 
Cyan). 

Clean Developer 

Purpose: 

To rotate the developer motor and stir the toner in the toner cartridge. 
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Toner Refresh 

Purpose: 

To use up a toner cartridge when you need to replace it before the end of its life, or to stir the toner in a new toner 
cartridge. 

Values: 

Yellow Cleans the toner in the yellow toner cartridge. 

Magenta Cleans the toner in the magenta toner cartridge. 

Cyan Cleans the toner in the cyan toner cartridge. 

Black Cleans the toner in the black toner cartridge. 

BTR Refresh 

Purpose: 

Specify whether to execute counter measures for curling/separating discharge of the paper. 

Values: 

Off* Does not automatically execute counter measures for curling/separating discharge of the paper. 

On Automatically executes counter measures for curling/separating discharge of the paper. 

Chart 

Purpose: 

To print various charts that can be used for diagnosing your printer. 

Values: 

Ghost Prints a chart to check for ghost printing. 

4Colors Prints bands of yellow, magenta, cyan, and black with varying density. 

Alignment Prints a chart, and then check for proper alignment of the print image on the paper. 

Drum Refresh Prints a chart to check the light fatigue of the drum cartridge. 

Reset Defaults 

Purpose: 

To initialize NVM (non-volatile memory) for system parameters. After executing this function and rebooting the printer,
 
all the menu parameters, except the parameters for the network, are reset to their default values.
 

For details, see "Resetting Defaults" on page 141.
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Non-Dell Toner 

Purpose: 

To use toner cartridge of another manufacturer. 

NOTE: Using non-Dell-brand toner cartridges may make some printer features unusable, reduce print quality and decrease the 
reliability of your printer. Dell recommends only new Dell-brand toner cartridges for your printer. Dell does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Dell. 

NOTE: Before you use toner cartridge of another manufacturer, be sure to restart the printer. 

Values: 

Off* Does not use toner cartridge of another manufacturer. 

On Uses toner cartridge of another manufacturer. 

Adjust Altitude 

Purpose: 

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used. 

NOTE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner. 

Values: 

0m* Specifies the altitude of the location where the printer is installed. 

1000m 

2000m 

3000m 

Secure Settings 
Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being 
changed accidentally. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

Panel Lock 

Panel Lock Set 

Purpose: 

To restrict access to Admin Menu and Report/List. 

For details see "Panel Lock Function" on page 140. 

Values: 

Disable* Does not restrict access to Admin Menu and Report/List. 

Enable Restricts access to Admin Menu and Report/List with a password. 

New Password Sets a password required to access Admin Menu and Report/List. 
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Re-enter Enters the new password again to confirm. 

Current Password*1 Enter the current password to disable Panel Lock Set. 
*1 Current Password is displayed only when changing the setting from Enable to Disable. 

Change Password 

Purpose: 

To change a password to limit access to the menus. 

Values: 

Current Password Enter the current password to change the password. 

New Password Enter the new password. 

Re-enter Enter the new password again to confirm. 

NOTE: This item is displayed only when Panel Lock set is set to Enable. 

Login Error 

Purpose: 

To set the maximum number of failed login attempts before an administrator is denied access to Admin Menu and 
Report/List. 

Values: 

Off* Does not set the maximum number of failed login attempts. 

On 5times* Sets the maximum number of failed login attempts. 

Available Range: 
1 - 10times 

NOTE: This item is available only when Panel Lock Set is set to Enable. 

S/W Download 

Purpose: 

To enable or disable download of firmware updates. 

Values: 

Enable* Enables firmware updates. 

Disable Disables firmware updates. 
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Panel Language 
Purpose: 

To specify the language to be used on the operator panel. 

Values: 

English* 

Français 

Italiano 

Deutsch 

Español 

Dansk 

Nederlands 

Norsk 

Svenska 

Panel Lock Function 
This feature prevents unauthorized users from changing settings made by the administrator. However, you can select 
settings for individual print jobs using the printer driver. 

Enabling the Panel Lock 
1 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

3 Press the 
 button until Secure Settings appears, and then press the (Set) button.
 

4 Ensure that Panel Lock appears, and then press the 
 (Set) button.
 

5 Ensure that Panel Lock Set appears, and then press the
 (Set) button.
 

6 Press the 
 button until Enable appears, and then press the (Set) button.
 

7 Enter the new password, and then press the 
 (Set) button.
 

8 Re-enter the password to confirm the password that you entered, and then press the 
 (Set) button. 

NOTE: If you forget your password, turn off the printer. Then, while holding the (Menu) button, turn on the printer. Continue 
to hold the (Menu) button until New Password appears. Perform step 7 and 8. The display will briefly indicate the 
password has been changed. 

NOTE: If you change the password, perform steps 1 and 2. Enter the current password, and then press the (Set) button. 
Perform steps 3 and 4. Press the  button until Change Password appears, and then press the (Set) button. Enter the 
current password, and then press the (Set) button. Perform step 7 and 8. This will change the password. 

Disabling the Panel Lock 
1 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

3 Enter the password, and then press the 
 (Set) button.
 

4 Press the 
 button until Secure Settings appears, and then press the (Set) button.
 

5 Ensure that Panel Lock appears, and then press the 
 (Set) button. 
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6 Ensure that Panel Lock Set appears, and then press the (Set) button.
 

7 Press the 
 button until Disable appears, and then press the (Set) button.
 

8 Enter the current password, and then press the
 (Set) button. 

Resetting Defaults 
After executing this function and rebooting the printer, all the menu parameters are reset to their default values. 

The following menu parameters are exceptions and are not reset. 

• Network settings 

• Panel Lock settings and password 

• Login Error settings 

• USB Port settings 

NOTE: A Password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this case, 
enter the password you specified, and press the  (Set) button. 

1 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

3 Press the 
 button until Maintenance appears, and then press the (Set) button.
 

4 Press the 
 button until Reset Defaults appears, and then press the (Set) button.
 

5 Ensure that Are you sure? appears, and then press the
 (Set) button.
 

6 Turn off the printer, and turn it on again to apply the settings.
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Print Media Guidelines 
Print media can be paper, labels, envelopes, and coated paper among others. Your printer provides high-quality 
printing on a variety of print media. Selecting the appropriate print media for your printer helps avoid printing 
troubles. This section describes selecting print media, caring for print media, and loading the print media in 
Multipurpose Feeder (MPF) or Priority Sheet Inserter (PSI). 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

NOTE: PSI is available only for Dell C1760nw Color Printer. 

Paper 
For the best print quality in color, use 75 g/m2 (20 lb) xerographic, grain long paper. For the best print quality in 
black and white, use 90 g/m2 (24 lb) xerographic, grain long paper. Before buying large quantities of any print media, 
it is recommended that you try a sample first. 

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See 
"Loading Print Media in the Multipurpose Feeder (MPF)" on page 151 and "Loading Print Media in the Priority 
Sheet Inserter (PSI) (Dell C1760nw Color Printer only)" on page 159 for detailed loading instructions. 

Paper Characteristics 
The following paper characteristics affect print quality and reliability. It is recommended that you follow these 
guidelines when evaluating new paper stock. 

Weight 

Both MPF and PSI automatically feed paper whose weights range from 60 to 163 g/m2 (16 to 44 lb bond) grain long. 
Paper lighter than 60 g/m2 (16 lb) may not feed properly, and could cause paper jams. For best performance, use 75 
g/m2 (20 lb bond) grain long paper. 

Curl 

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl 
usually occurs after the paper passes through the printer, where it is exposed to high temperatures. Storing paper 
unwrapped, even in the paper feeder, can contribute to paper curling prior to printing and cause feeding problems 
regardless of humidity. When printing on curled paper, straighten the paper and then insert it into the MPF or PSI. 

Smoothness 

The degree of paper smoothness directly affects print quality. If the paper is too rough, the toner does not fuse to the 
paper properly, resulting in poor print quality. If the paper is too smooth, it can cause paper feeding problems. 
Smoothness between 150 and 250 Sheffield points produces the best print quality. 

Moisture Content 

The amount of moisture in the paper affects both print quality and the ability of the printer to feed the paper 
properly. Leave the paper in its original packaging until you are ready to use it. This limits the exposure of the paper 
to moisture changes that can degrade its performance. 

Grain Direction 

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of 
the paper, or grain short, running the width of the paper. For 60 to 135 g/m2 (16 to 36 lb bond) paper, grain long 
fibers are recommended. For paper heavier than 135 g/m2 (36 lb bond), grain short is preferred. 
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Fiber Content 

Most high-quality xerographic paper is made from 100% chemically pulped wood. Paper containing fibers such as 
cotton possess characteristics that can result in degraded paper handling. 

Recommended Paper 
To ensure the best print quality and feed reliability, use dry 75 g/m2 (20 lb) xerographic paper. Business paper 
designed for general business use also provide acceptable print quality. Only use paper able to withstand high 
temperatures without discoloring, bleeding, or releasing hazardous emissions. The laser printing process heats paper 
to high temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is 
acceptable for laser printers. 

NOTE: Always print several samples before buying large quantities of any type of print media. When choosing any print media, 
you should consider the weight, fiber content, and color. 

Unacceptable Paper 
The following paper types are not recommended for use with the printer: 

•	 Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, carbonless
 
copy paper (CCP), or no carbon required (NCR) paper
 

•	 Preprinted paper with chemicals that may contaminate the printer 

•	 Preprinted paper that can be affected by the temperature in the fusing unit 

•	 Preprinted paper that require a registration (the precise print location on the page) greater than ±0.09 inches, such 
as optical character recognition (OCR) forms
 

In some cases, you can adjust registration with your software program to successfully print on these forms.
 

•	 Coated paper (erasable bond), synthetic paper, thermal paper 

•	 Rough-edged, rough or heavily textured surface paper, or curled paper 

•	 Recycled paper containing more than 25% post-consumer waste that do not meet DIN 19 309 

•	 Multiple-part forms or documents 

•	 Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper. 

•	 Moist paper that may cause wrinkle 

Selecting Paper 
Proper paper selection helps prevent jams and ensures trouble-free printing. 

To help avoid jams or poor print quality: 

•	 Always use new, dry, and undamaged paper. 

•	 Before loading the paper, identify the recommended print side of the paper. This information is usually indicated 
on the paper package. 

•	 Do not use paper that you have cut or trimmed yourself. 

•	 Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam. 

•	 Do not remove the PSI while a job is printing. 

•	 Ensure that the paper is properly loaded in the MPF or PSI. 

•	 Flex paper back and forth, and then fan them. Straighten the edges of the stack on a level surface. 
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Selecting Preprinted Media and Letterhead 
When selecting preprinted media and letterhead paper for the printer: 

•	 Use grain long paper for best results. 

•	 Use only forms and letterhead printed using an offset lithographic or engraved printing process. 

•	 Select paper that absorb ink, but do not bleed. 

•	 Avoid paper with rough or heavily textured surfaces. 

•	 Use paper printed with heat-resistant inks designed for use in xerographic copying machines. The ink must 

withstand temperatures of 225°C (437°F) without melting or releasing hazardous emissions.
 

•	 Use inks that are not affected by the resin in toner or the silicone in the fusing unit. Inks that are oxidation-set or 
oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier. 

Printing on Letterhead 
Check with the manufacturer or vendor to determine whether the pre-printed letterhead you have selected is 

acceptable for laser printers.
 

Page orientation is important when printing on letterhead. Use the following illustration for help when loading
 
letterhead in the print media sources.
 

Loading Letterhead 
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead enters the 
printer first. 

Multipurpose Feeder (MPF)	 Priority Sheet Inserter (PSI) 
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Selecting Pre-Punched Paper 
Pre-punched paper brands can differ in the number and placement of holes and in manufacturing techniques. 
However, it may not be possible to print on the paper to depending on the placement of holes on the paper. 

To select and use pre-punched paper: 

•	 Test paper from several manufacturers before ordering and using large quantities of pre-punched paper. 

•	 Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled 
paper can cause jams when multiple sheets feed through the printer. This may result in a paper jam. 

•	 Pre-punched paper can include more paper dust than standard paper. Your printer may require more frequent 

cleaning and feed reliability may not be as good as standard paper.
 

•	 Weight guidelines for pre-punched paper are the same as non-punched paper. 

Envelopes 
Depending on the choice of envelopes, it is possible to expect variable levels of light wrinkling. Before buying large 
quantities of any print media, it is recommended that you try a sample first. See "Loading Print Media in the 
Multipurpose Feeder (MPF)" on page 151 or "Loading Print Media in the Priority Sheet Inserter (PSI) (Dell 
C1760nw Color Printer only)" on page 159 for instructions on loading an envelope. 

When printing on envelopes: 

•	 Use only high-quality envelopes that are designed for use in laser printers. 

•	 Set the print media source to MPF or PSI. Set the paper type to Envelope, and select the correct size of envelope 
from the printer driver. 

•	 For best performance, use envelopes made from 75 g/m2 (20 lb bond) paper. You can use up to 105 g/m2 (28 lb 

bond) weight for the envelope feeder as long as the cotton content is 25% or less. Envelopes with 100% cotton 

content must not exceed 90 g/m2 (24 lb bond) weight.
 

•	 Use only freshly unpackaged, undamaged envelopes. 

•	 Use envelopes that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or 
releasing hazardous emissions. If you have any doubts about the envelopes you are considering, check with the 
envelope supplier. 

•	 Adjust the guide to fit the width of the envelopes. 

•	 To load envelope in MPF or PSI, the print side must be facing up. 

•	 See "Loading Envelopes in the Multipurpose Feeder (MPF)" on page 156 or "Loading an Envelope in the Priority 
Sheet Inserter (PSI)" on page 161 for instructions on loading an envelope. 

•	 Use one envelope size during a print job. 

•	 Ensure that the humidity is low because high humidity (more than 60%) and the high printing temperatures may 
seal the envelopes. 

•	 For best performance, do not use envelopes that: 

–	 Have excessive curl or twist 

–	 Are stuck together or damaged in any way 

–	 Contain windows, holes, perforations, cutouts, embossing 

–	 Use metal clasps, string ties, or metal folding bars 

–	 Have an interlocking design 

–	 Have postage stamps attached 

–	 Have nicked edges or bent corners 
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–	 Have rough, cockle, or laid finishes 

Labels 
Your printer can print on many labels designed only for use with laser printers. 

When selecting labels: 

•	 Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 205°C 

(401°F) and pressure of 25 pounds per square inch (psi).
 

•	 Use labels that can be without sealing, excessive curling, wrinkling, or releasing hazardous emissions. 

•	 Do not use label sheets with a slick backing material. 

CAUTION: Before buying large quantities of any print media, it is recommended that you try a sample first. 

When printing on labels: 

•	 Use labels that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or 

releasing hazardous emissions.
 

•	 Set the paper type to Label from the printer driver. 

•	 Do not load labels together with paper in the same tray. 

•	 Do not print within 1 mm (0.04 inches) of the die-cut. 

•	 Do not print within 1 mm (0.04 inches) of the edge of the label, of the perforations, or between die-cuts of the
 
label.
 

•	 Do not print a label through the printer more than once. 

•	 Portrait orientation is preferred, especially when printing bar codes. 

•	 Do not use labels that have exposed adhesive. 

•	 Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. 

•	 Do not use label sheets that have adhesive to the edge of the sheet. It is recommended that zone coating of the 

adhesive is done at least 1 mm (0.04 inches) away from edges. Adhesive material contaminates your printer and 

could void your warranty.
 

WARNING: Otherwise a jam occurs in the printer and contaminate your printer and your cartridges with adhesive. As a result, 
could void your printer and cartridge warranties. 

Storing Print Media 
For proper print media storage, the following guidelines help avoid media feeding problems and uneven print 
quality. 

•	 For best results, store print media in an environment where the temperature is approximately 21°C (70°F) and the 
relative humidity is 40%. 

•	 Store cartons of print media on a pallet or shelf, rather than directly on the floor. 

•	 If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so 
that the edges do not buckle or curl. 

•	 Do not place anything on top of the print media packages. 
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Identifying Print Media and Specifications 
This section provides information on supported paper sizes, types, and specification. 

Supported Paper Sizes 

Multipurpose Feeder (MPF) Priority Sheet Inserter (PSI) 

A4 (210x297 mm) Y	 Y 

B5 (182x257 mm) Y	 Y 

A5 (148x210 mm) Y	 Y 

C5 (162x229 mm) Y	 Y 

Monarch (3.875x7.5 in) Y	 Y 

Y*4Monarch LEF (7.5x3.875 in)*1	 Y 

Envelope #10 (4.125x9.5 in) Y	 Y 

DL (110x220 mm) Y	 Y 

Y*4DL LEF (220x110 mm)*1	 Y 

Letter (8.5x11 in) Y	 Y 

Legal (8.5x14 in) Y	 Y 

Folio (8.5x13 in) Y	 Y 

Executive (7.25 x 10.5 in) Y	 Y 

Custom*2*3	 Y Y 

*1	 You can place the originals in a long-edge feed direction or in a short-edge feed direction. The following illustration shows SEF and LEF. 
The arrow mark in the illustration shows the orientation of the paper loading. 

NOTE: Not available when the XML Paper Specification (XPS) Printer Driver is used. 
*2 Custom width: 76.2 mm (3.00 inches) to 215.9 mm (8.50 inches) 

The maximum width for envelope (DL LEF): 220 mm (8.66 inches) 
Custom length: 127 mm (5.00 inches) to 355.6 mm (14.00 inches) 
The maximum length for envelope (Monarch LEF): 98.4 mm (3.87 inches) 

*3 Only the administrator user can set the custom size from the printer driver. 
*4 Be sure to fully insert the envelope until it stops. Otherwise, print media that is loaded on the MPF will be fed. 

SEF	 LEF
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Supported Paper Types 

Media Multipurpose Feeder (MPF) Priority Sheet Inserter (PSI) 

Plain Y* Y* 

Plain Side 2 Y Y 

Plain Thick Y Y 

Plain Thick Side 2 Y Y 

Recycled Y Y 

Recycled Side 2 Y Y 

Label Y Y 

Covers Y Y 

Covers Side 2 Y Y 

Envelope Y Y 

Coated Y Y 

Coated Side 2 Y Y 

* Values marked by an asterisk (*) are the factory default menu settings. 

Paper Type Specifications 

Paper type Weight (gsm) Remarks 

Plain Paper 60–90 -

Plain Thick Paper 91–105 -

Covers 106–163 -

Coated 106–163 Inkjet printer paper cannot be used. 

Label - Inkjet printer paper cannot be used. 

Envelopes - -

Recycled 60–105 -
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Loading Print Media 
Loading print media properly helps prevent jams and ensures trouble-free printing.
 

Before loading print media, identify the recommended print side of the print media. This information is usually on
 
the print media package.
 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

NOTE: Priority Sheet Inserter (PSI) is available only for Dell C1760nw Color Printer. 

Capacity 
Multipurpose Feeder (MPF) can hold: 

• 150 sheets of standard paper 

• 16.2 mm (0.64 inches) of thick paper 

• One sheet of coated paper 

• 16.2 mm (0.64 inches) of post cards 

• Five envelopes 

• 16.2 mm (0.64 inches) of labels 

Priority Sheet Inserter (PSI) can hold: 

• 10 sheets of standard paper or one sheet of other paper 

Print Media Dimensions 
Both MPF and PSI accept print media within the following dimensions: 

• Width — 76.2 mm (3.00 inches) to 215.9 mm (8.50 inches) 

• Length — 127.0 mm (5.00 inches) to 355.6 mm (14.00 inches) 

Loading Print Media in the Multipurpose Feeder (MPF) 
NOTE: PSI is available only for Dell C1760nw Color Printer. 

NOTE: Use only laser print media. Do not use ink jet paper in this printer. 

Open the front cover. 
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4 

Pull the PSI out. 

Pull the length guide forward until it stops. 

Pull the MPF extension forward until it stops. 
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Adjust the paper width guides to their maximum. 

Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack 
on a level surface. 

Load print media on the MPF with the top edge first and with the recommended print side facing up. 
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Adjust the width guides until they rest lightly against the edges of the stack of print media. 

Slide the length guide towards the printer until it touches the print media. 

NOTE: Depending on the size of print media, first slide the length guide backward until it stops, and then slide the MPF 
extension until it touches print media. 
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10 Insert the PSI into the printer and then align the PSI to the marking on the paper tray. 
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Loading Envelopes in the Multipurpose Feeder (MPF) 

NOTE: When you print on envelopes, be sure to specify the envelope setting on the printer driver. If not specified, the print 
image will be rotated 180 degrees. 

When Loading Envelope #10, DL, or Monarch 

Load envelopes with the side to be printed on facing up, the flap side facing down, and the flap turned to the right. 

To prevent DL and Monarch from being wrinkled, they are recommended to be loaded with the print-side facing up, 
flap opened, and facing you. 
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When Loading C5 

Load envelopes with the side to be printed on facing up, with the flap open. 

CAUTION: Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 
printer. 

NOTE: If you do not load envelopes in the MPF right after they have been removed from the packaging, they may bulge. To avoid 
jams, flatten them as shown below when loading them in the MPF. 
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NOTE: If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
 
The amount of the bending shall be 5 mm (0.20 inches) or less.
 

NOTE: To confirm the correct orientation of each print media such as envelopes, see the instruction on the Envelope/Paper 
Setup Navigator on the printer driver. 

Loading Letterhead 
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead enters the 
printer first. 
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Loading Print Media in the Priority Sheet Inserter (PSI) (Dell C1760nw 
Color Printer only) 

NOTE: To avoid paper jams, do not remove the PSI while printing is in progress.
 

NOTE: Use only laser print media. Do not use ink jet paper in this printer.
 

Open the front cover. 

Slide the PSI forward, and then align the PSI to the marking on the paper tray. 

Adjust the paper width guides to their maximum. 
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Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack 
on a level surface. 

Load print media on the PSI with the top edge first and with the recommended print side facing up. 

Adjust the width guides until they rest lightly against the edges of the stack of print media. 

Select the paper type from the printer driver if the loaded print media is not standard plain paper. If a 
user-specified print media is loaded in the PSI, you must specify the paper size setting by using the printer driver. 
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Loading an Envelope in the Priority Sheet Inserter (PSI) 

NOTE: Be sure to fully insert the envelope until it stops. Otherwise, print media that is loaded on the MPF will be fed. 

NOTE: When you print on envelopes, be sure to specify the envelope setting on the printer driver. If not specified, the print 
image will be rotated 180 degrees. 

When Loading Envelope #10, DL, or Monarch 

Load an envelope with the side to be printed on facing up, the flap side facing down, and the flap turned to the right. 

To prevent DL and Monarch from being wrinkled, they are recommended to be loaded with the print-side facing up, 
flap opened, and facing you. 
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When Loading C5 

Load envelopes with the side to be printed on facing up, with the flap open. 

CAUTION: Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 
printer. 

NOTE: If you do not load envelopes in the PSI right after they have been removed from the packaging, they may bulge. To avoid 
jams, flatten them as shown below when loading them in the PSI. 
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NOTE: If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
 
The amount of the bending shall be 5 mm (0.20 inches) or less.
 

NOTE: To confirm the correct orientation of each print media such as envelopes, see the instruction on the Envelope/Paper 
Setup Navigator on the printer driver. 

Loading Letterhead 
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead enters the 
printer first. 
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Loading Print Media When Manual Duplex Printing 
NOTE: When printing on curled paper, straighten the paper and then insert it into the feeder. 

When you start manual duplex printing, the instruction window appears. Note that the window cannot be reopened 

once it is closed. Do not close the window until duplex printing is complete.
 

Manual duplex printing can be done using the MPF or PSI.
 

When Using the Multipurpose Feeder (MPF) 
First print the even pages (rear sides). 
For a six page document, rear sides are printed in the order of page 6, page 4, then page 2. 
The orange LED lights and the message appears on the operator panel when the even pages finish printing. 

After the even pages are printed, remove the paper stack from the output tray and set them as they are (with the 
blank side facing up) into the MPF. 

NOTE: Warped or curled prints can cause paper jams. Straighten them before setting them.
 

NOTE: Printing on both sides of the paper is not possible if the document consists of various sizes of papers.
 

Ensure that Insert Output into paper tray appears, and then press the (Set) button. Print pages in 
the order page 1 (rear of page 2), page 3 (rear of page 4), then page 5 (rear of page 6). 
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When Using the Priority Sheet Inserter (PSI) (Dell C1760nw Color Printer only) 
First print the even pages (rear sides).
 
For a six page document, rear sides are printed in the order of page 6, page 4, then page 2.
 

The orange LED lights and the message appears on the operator panel when the even pages finish printing.
 

After the even pages are printed, remove the paper stack from the output tray and set them as they are (with the 
blank side facing up) into the PSI. 

NOTE: Warped or curled prints can cause paper jams. Straighten them before setting them.
 

NOTE: Printing on both sides of the paper is not possible if the document consists of various sizes of papers.
 

Ensure that Insert Output into paper tray appears, and then press the (Set) button. Print pages in 
the order page 1 (rear of page 2), page 3 (rear of page 4), then page 5 (rear of page 6). 
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Using the Output Tray Extension 
The output tray extension is designed to prevent print media from falling from the printer after the print job is 

complete.
 

Before printing a document, ensure that the output tray extension is fully extended.
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Printing
 
This chapter covers tips for printing, how to print certain lists of information from your printer, and how to cancel a 
job. 

Tips for Successful Printing 

Tips on Storing Print Media 
Store your print media properly. For more information, see "Storing Print Media" on page 187. 

Avoiding Paper Jams 

NOTE: It is recommended that you try a limited sample of any print media you are considering using with the printer before 
purchasing large quantities. 

By selecting appropriate print media and loading it properly, you can avoid paper jams. See the following instructions 
on loading print media: 

• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 151 

• "Loading Print Media in the Priority Sheet Inserter (PSI) (Dell C1760nw Color Printer only)" on page 159 

• "Avoiding Jams" on page 201 

If you experience a jam, see "Jam" on page 223 for instructions. 

Sending a Job to Print 
To support all of the printer features, use the printer driver. When you choose Print from an application, a window 
representing the printer driver opens. Select the appropriate settings for the specific job you are sending to print. 
Print settings selected from the driver have precedence over the default menu settings selected from the operator 
panel or Tool Box. 

You may need to click Preferences from the initial Print box to see all of the available system settings you can 
change. If you are not familiar with a feature in the printer driver window, open the online Help for more 
information. 

To print a job from a typical Microsoft® Windows® application: 

1 Open the file you want to print. 

2 From the File menu, select Print. 

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as needed (such as the pages 
you want to print or the number of copies).
 

4 Click Preferences to adjust system settings not available from the first screen, and then click OK. 


5 Click OK or Print to send the job to the selected printer.
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Canceling a Print Job 
There are several methods for canceling a print job. 

Canceling From the Operator Panel 
To cancel a job after it has started printing: 

1 Press the (Cancel) button. 

NOTE: Printing is canceled only for the current job. All the following jobs will continue to print. 

Canceling a Job From the Computer Running Windows 

Canceling a Job From the Taskbar 

When you send a job to print, a small printer icon appears in the right corner of the taskbar. 

1 Double-click the printer icon. 

A list of print jobs appears in the printer window. 

2 Select the job you want to cancel. 

3 Press <Delete> on the keyboard. 

Canceling a Job From the Desktop 

1 Minimize all programs to reveal the desktop. 

Click Start → Devices and Printers (for Windows 7 and Windows Server® 2008 R2). 

Click Start → Printers and Faxes (for Windows XP). 

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista®). 

Click Start → Control Panel → Printers (for Windows Server 2008). 

Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound → 
Devices and Printers (for Windows 8). 

Right-click the bottom left corner of the screen, and then click Control Panel → Hardware → 
Devices and Printers (for Windows Server 2012). 

A list of available printers appears. 

2 Right-click the printer that you selected when you sent the job for print, and then select See what's printing. 

3 Select the printer driver. 

A list of print jobs appears in the printer window. 

4 Select the job you want to cancel. 

5 Press <Delete> on the keyboard. 

Printing a Report Page 
By using the Report/List menu, you can print a various of settings for your printer including printer settings. For 
details about how to print reports or lists, see "Report/List" on page 125. 
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Understanding Your Printer Software
 
Use the Software and Documentation disc that shipped with your printer to install a combination of software 
programs, depending on your operating system. 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

Windows® 

Printer Status Window 
The Printer Status window alerts you when there is a warning or when an error occurs, for example, when a paper 

jam occurs or toner is running low.
 

By default, the Printer Status window launches only when an error occurs. When an error occurs, the error message 

appears on the Printer Status window. You can set the Printer Status window to always launch when printing in
 
Printing Status Window Properties.
 

You can also check the toner level of your printer.
 

Status Monitor Console 
Use the Status Monitor Console to manage multiple instances of the Status Window for a particular printer. 

Select a printer from the list view (or Printer Selection) by clicking its name to open a Status Window for a 
particular printer. 

Dell Supplies Management System 
You can launch the Dell Supplies Management System dialog box from the All Programs menu or the desktop icon. 

You can order consumables by phone or from the web. 

1	 Click Start → All Programs → Dell Printers → Additional Color Laser Software → Dell Supplies Management 
System. 

The Dell Supplies Management System window appears. 

2 Select your printer from the Select Printer Model list. 

3	 If you are ordering from the web:
 

a Select a web address from the Select Reorder URL list.
 

b Click Visit Dell printer supplies ordering web site.
 

Dell C1760nw Color Printer/Dell C1660w Color Printer - Dell Supplies Management System window 
appears. 

c Enter the Service Tag, and then click OK. 

If you order by phone, call the number that appears in the Order by Phone section. 
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Quick Launch Utility 
Using the Quick Launch Utility window, you can open Status Window, Tool Box, and Troubleshooting.
 

To use the Quick Launch Utility, select to install the Quick Launch Utility when you install the Dell software.
 

To open the Quick Launch Utility window:
 

Click Start → All Programs → Dell Printers → Additional Color Laser Software → Quick Launch Utility. 

The Quick Launch Utility dialog box opens. 

The Quick Launch Utility window provides three buttons; Status Window, Tool Box, and Troubleshooting.
 

To exit, click X at the top-right of the window.
 

For details, click Help of each application.
 

Status Window Click to open the Printing Status window. See "Printer Status Window" on page 173. 

Tool Box Click to open the Tool Box. See "Understanding the Tool Box Menus" on page 111. 

Troubleshooting*1 Click to open the Troubleshooting Guide, which allows you to resolve issues by yourself. 

*1  Troubleshooting Guide is the Portable Document Format (PDF) file. This item needs software to view the document. 

Macintosh 

Status Monitor Widget 
Status Monitor Widget is a printer utility that promotes efficient use of the printer through the exchange of 
information between the Macintosh and the printer. 

To open the Status Monitor Widget: 

1 Click the Dashboard icon in the Dock to launch Dashboard. 

2 Click the Plus (+) sign to display the Widget Bar.
 

3 Click the icon of Status Monitor in the Widget Bar. The Printer Status window appears.
 

NOTE: If Select a printer. is displayed, select your printer in Preferences. 
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Status Monitor window appears. 

1 

2 

3 

4 

1	 Printer Status Message Area 

Displays a message of the current printer status. 

NOTE: The Status Monitor Widget automatically obtains the printer information at the updated interval that can be 
specified in Preferences. Also, the printer status is refreshed when Dashboard is launched or Preferences is closed. 

NOTE: If the Status Monitor Widget receives no response from the printer, Cannot get printer information is displayed. 

NOTE: When the printer is connected via USB cable, you cannot check the status of the printer during a print job. 

2 Printer Status Image Area 

Displays the image of printer condition. 

•	 Estimated Toner Level image
 

Displays the estimated toner level of each color if the printer is functioning properly.
 

Less than 29% Less than 9% Unknown 

NOTE: If the utility does not receive a response from the printer, the Unknown toner image is displayed. 

•	 Printer error image 

Displays an indication image when an error occurs. 

An error has occurred and the printer cannot be used. 

Understanding Your Printer Software 175 



 

   

  

  

  

  
  

 

 

3 

4 

Info (i) button
 

Click this button to open Preferences.
 

NOTE: The Info (i) button appears on the lower-right corner of the window when the cursor is over the Status Monitor 
window. 

Printer Displays a list of available printer names in the drop-down list. The first printer displayed in 
this list is set as default. 

Status Update Interval You can update the interval of the printer status. By default, it is set to obtain the printer 
information every 10 seconds. The range varies between 0 and 600. 

SNMP Community Name You can change the SNMP (Simple Network Management Protocol) community name if 
using default community name (public). Up to 31 characters can be entered. 

Service Tag button Click Get Tag to obtain the service tag. 

done button Click this button to return to the Printer Status window. 

Order Supplies button
 

Click this button to display the Order window. 


This window provides you with the information for ordering printer supplies by telephone or from the web site.
 

NOTE: The Order window automatically appears when low toner is detected. 

Order Online Select a web address from the drop-down list and click Visit Dell printer supplies ordering 
web site. hyperlink to access the web site for ordering Dell printer supplies. 

Order By Phone Displays a list of available phone numbers that you can call to order Dell printer supplies. 

Dell and the Environment Click the hyperlink to access the web site about recycling. 
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Understanding Printer Messages 
The printer operator panel displays messages describing the current state of the printer and indicates possible printer 
problems you must resolve. This chapter describes messages, their meanings, and how to clear them. 

CAUTION: When an error code is displayed, the print data remaining on the printer and the information accumulated in the 
memory of the printer are not secured. 

Error-Code What you can do 

001-360	 Turn off the printer, and then on again. If this does not solve the problem, contact Dell™. See "Contacting 
Dell" on page 230. 003-340 

003-356 

006-370 

007-340 

007-371 

009-654 

010-354 

010-377 

016-302 

016-313 

016-315 

016-317 

016-324 

016-338 

016-340 

016-344 

016-345 

016-346 

016-347 

016-370 

016-383 Press the (Set) button. Contact Dell if this message appears repeatedly. See "Contacting Dell" on page 230. 

016-384 

016-385 

016-386 

016-387 

016-391 

016-392	 Turn off the printer, and then on again. If this does not solve the problem, contact Dell. See "Contacting Dell" 
on page 230. 016-393 

016-394 

016-700	 Press the (Set) button to cancel the current print job. See "Canceling a Print Job" on page 170. 

016-720 
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Error-Code What you can do 

016-746 Press the (Set) button. Enable S/W Download and execute the operation again according to the 
operation procedure. See "Secure Settings" on page 138. 

016-799 Press the (Set) button to cancel the current print job. See "Canceling a Print Job" on page 170. 

016-920 Press the (Set) button. Execute the operation again according to the operation procedure. 

016-921 

016-922 Press the (Set) button. Check that no other wireless LAN access point (Registrar) or router is setting up 
wireless connection with WPS-PBC (Wi-Fi Protected Setup®-Push Button Configuration), and execute the 
operation again according to the operation procedure. 

016-923 Press the (Set) button. Check the passphrase for the wireless LAN access point (Registrar) or router and 
execute the operation again according to the operation procedure. 

016-924 Press the (Set) button. Check the WEP key for the wireless LAN access point (Registrar) or router and 
execute the operation again according to the operation procedure. 

024-360 Turn off the printer, and then on again. If this does not solve the problem, contact Dell. See "Contacting Dell" 
on page 230. 

024-914 Load the specified paper. See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 151 or 
"Loading Print Media in the Priority Sheet Inserter (PSI) (Dell C1760nw Color Printer only)" on page 159. 

024-969 • Load the appropriate paper. See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 151 or 
"Loading Print Media in the Priority Sheet Inserter (PSI) (Dell C1760nw Color Printer only)" on page 159. 

• For Dell C1660w Color Printer: 

If there are paper loaded in the MPF and this error is displayed, paper may be jammed. Check and clear the 
paper path, load the specified paper, and then press the (Set) button. See "Clearing Paper Jams From the 
Front of the Printer" on page 203. 

027-452 Change IP address to avoid duplication. Turn off the printer, and then on again. 

027-446 

075-100 Check and clear the paper path, load the specified paper, and then press the (Set) button. See "Clearing 
Paper Jams From the Front of the Printer" on page 203. 

075-921 Load paper for the second side (odd) pages, and press the (Set) button. See "Loading Print Media When 
Manual Duplex Printing" on page 164. 

077-100 Check and clear the paper path. See "Clearing Jams" on page 201. 

077-101 

077-102 Check and clear the paper path. See "Clearing Paper Jams From the Back of the Printer" on page 204. 

077-104 Check and clear the paper path. See "Clearing Jams" on page 201. 

077-105 

077-300 Close the rear cover. 

077-900 Check and clear the paper path. See "Clearing Paper Jams From the Output Tray" on page 206. 

077-901 Check and clear the paper path. See "Clearing Jams" on page 201. 

092-310 Clean the CTD sensor. See "Cleaning the Color Toner Density (CTD) Sensor" on page 195. 

092-910 

093-423 Replace the specified toner cartridge soon. Order a new consumable from www.dell.com/supplies 

093-424 See "Removing the Toner Cartridges" on page 188. 

093-425 

093-426 
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Error-Code	 What you can do 

093-919 Re-install or replace the specified toner cartridge. See "Replacing Toner Cartridges" on page 188. 

093-920 

093-921 

093-922 

093-930	 Remove the specified toner cartridge and install a new one. If you do not replace the toner cartridge, print 
quality problems may occur. Order a new consumable from www.dell.com/supplies 093-931 
See "Replacing Toner Cartridges" on page 188. 093-932 

093-933 

093-940 Re-install the specified toner cartridge. See "Installing a Toner Cartridge" on page 190. 

093-941 

093-942 

093-943 

093-960	 Replace the specified toner cartridge with the supported one. Order a new consumable from 
www.dell.com/supplies 093-961 
See "Replacing Toner Cartridges" on page 188. 093-962 

093-963 

093-970 Re-install the specified toner cartridge. See "Installing a Toner Cartridge" on page 190. 

093-971 

093-972 

093-973 

093-974 

116-399	 Turn off the printer, and then on again. If this does not solve the problem, contact Dell. See "Contacting Dell" 
on page 230. 124-333 

191-310 

193-700 This message indicates the printer is in the non-Dell toner mode. 
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Specifications 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

Operating System Compatibility 
Your Dell C1760nw/C1660w Color Printer is compatible with Microsoft® Windows® XP, Windows XP 64-bit 
Edition, Windows Vista®, Windows Vista 64-bit Edition, Windows 7, Windows 7 64-bit Edition, Windows 8, 
Windows 8 64-bit Edition, Windows Server® 2003, Windows Server 2003 x64 Edition, Windows Server 2008, 
Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows Server 2012, Mac OS X Version 10.4.11, 
10.5, 10.6, and 10.7. 

Power Supply 

Rated Voltage 220-240 VAC 110-127 VAC 

Frequency 50/60 Hz 50/60 Hz 

Current 5.0 A 11.0 A 

Dimensions 
Height: 225 mm (8.9 inches) Width: 394 mm (15.5 inches) Depth: 300 mm (11.8 inches) 

Weight (including toner cartridges): 

• Dell C1760nw Color Printer: 10.6 kg (23.4 lb) 

• Dell C1660w Color Printer: 10.5 kg (23.2 lb) 

Memory 

Base memory 128 MB 
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Page Description Language (PDL)/Emulation, Operating System, and 
Interface 

PDL/Emulations Host-based printing system 

OSes Windows XP, Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit Edition, Windows 7, 
Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, Windows Server 2003, Windows 
Server 2003 x64 Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 
2008 R2, Windows Server 2012, Mac OS X Version 10.4.11, 10.5, 10.6, and 10.7. 

Interfaces Standard local: USB 2.0 

Standard network: 10Base-T/100Base-TX Ethernet (Dell C1760nw Color Printer only) 

IEEE 802.11b/802.11g/ 802.11n(Wireless) 

MIB Compatibility 
A Management Information Base (MIB) is a database containing information about network devices (such as 
adapters, bridges, routers, or computers). This information helps network administrators manage the network 
(analyze performance, traffic, errors, and so on). Dell C1760nw/C1660w Color Printer complies with standard 
industry MIB specifications, allowing the printer to be recognized and managed by various printer and network 
management software systems. 

Environment 

Operation 

Temperature 10-32°C 

Relative humidity 10-85% RH (no condensation) 

Print Quality Guarantee 

Temperature 15-28°C 

Relative humidity 20-70% RH (no condensation) 

Storage 

Temperature range -20-40°C 

Storage humidity range 5-85% RH (no condensation) 

Altitude 

Operating Up to 3,100 m (10,000 feet) 

Storage 70.9275 Kpa 
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Cables 
Your interconnection cable must meet the following requirements: 

Connection type Connection specifications and symbols 

1 USB USB 2.0 

2 Ethernet 
(Dell C1760nw Color Printer only) 

10 Base-T/100 Base-TX 

1 
2 
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Maintaining Your Printer 
Periodically, your printer requires you to complete certain tasks to maintain optimum print quality. If several people 
are using the printer, you may want to designate a key operator to maintain your printer. Refer printing problems and 
maintenance tasks to this key operator. 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

Determining the Status of Supplies 
If your printer is connected to the network, the Dell Printer Configuration Web Tool can provide instant feedback 
on remaining toner levels. Type the IP address of your printer in your web browser to view this information. To use 
the E-Mail Alert feature that notifies you when the printer requires new supplies, type your name or the name of the 
key operator in the e-mail list box. 

On the operator panel, you can also confirm the following: 

•	 Any supply or maintenance items that require attention replacing (However, the printer can only display 

information about one item at a time).
 

•	 Amount of toner remaining in each toner cartridge. 

Conserving Supplies 
You can change several settings in your printer driver to conserve toner cartridge and paper. 

Supply Setting Function 

Toner cartridge Toner Saver in the 
Others tab of the printer 
driver 

This drop-down menu allows the users to select a print mode that uses less toner. 
When this feature is used, the image quality will be lower than when it is not 
used. 

Print media Multiple Up in the 
Layout tab of the printer 
driver 

The printer prints two or more pages on one side of a sheet. The available 
numbers that each printer driver can print one sheet of paper are as follows: 

• Printer driver for Microsoft® Windows®: 2, 4, 8, 16, or 32 pages 

• Printer driver for Macintosh: 2, 4, 6, 9, or 16 pages 

Combined with the duplex setting, Multiple Up allows you to print up to 64 
pages on one sheet of paper. (32 images on the front and 32 on the back) 

Storing Print Media 
To avoid potential paper feeding problems and uneven print quality, you need to consider the following points: 

•	 To achieve the best possible print quality, store print media in an environment where the temperature is 

approximately 21°C (70°F) and the relative humidity is 40%.
 

•	 Store cartons of print media on a pallet or shelf, rather than directly on the floor. 

•	 If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so 
the edges do not buckle or curl. 

•	 Do not place anything on top of the print media packages. 
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Storing Consumables 
Store consumables in their original packaging until you need to use them. Do not store consumables in: 

• Temperatures greater than 40°C (104°F). 

• An environment with extreme changes in humidity or temperature. 

• Direct sunlight. 

• Dusty places. 

• A car for a long period of time. 

• An environment where corrosive gases are present. 

• An environment with salty air. 

Replacing Toner Cartridges 

WARNING: Before replacing toner cartridges, read and follow the safety instructions in the Important Information. 

Dell toner cartridges are available only through Dell. You can order more cartridges online at 
http://www.dell.com/supplies or by phone. To order by phone, see "Contacting Dell" on page 230. 

It is recommended that you use Dell toner cartridges for your printer. Dell does not provide warranty coverage for 
problems caused by using accessories, parts, or components not supplied by Dell. 

WARNING: Never throw used toner cartridges into fire. The residual toner could explode resulting in burns and injuries. 

WARNING: Do not shake the used toner cartridge to avoid spilling of toner. 

Removing the Toner Cartridges 
1 Open the toner access cover. 
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Pinch the cartridge firmly as shown in the illustration. 

WARNING: Always pull the cartridge out slowly so that you do not spill any toner. 

Pull the toner cartridge out. 
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Installing a Toner Cartridge 
Unpack a new toner cartridge of the desired color and shake it five to six times to distribute the toner evenly. 

NOTE: Ensure that the color of the new toner cartridge matches that on the handle before replacing it. 

NOTE: Handle the toner cartridge carefully to avoid spillage of the toner. 

Remove the tape from the toner cartridge. 
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Adjust the toner cartridge to the associated cartridge holder, and then insert it firmly by pressing near the center of 
the label until the cartridge clicks. 

Close the toner access cover. 
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Cleaning Inside the Printer 

WARNING: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet 
before performing maintenance. 

Confirm that the printer is not in operation, and open the toner access cover. 

Pinch the cartridge firmly as shown in the illustration. 

Pull the toner cartridge out. 

Pull the other three cartridges out as well. 
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Pull the cleaning rod out. 

Insert the cleaning rod fully into the hole beside the arrow on the printer until its tip reaches the interior of the 
printer as illustrated below, and then pull it out. 

7 Repeat the same procedure for the other three holes. 

8 Insert the cleaning rod back to its original location. 
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9 Replace the black cartridge by adjusting it to the associated cartridge holder, and then insert it firmly by pressing 
near the center of the label until the cartridge clicks. 

10 Replace the other three cartridges as well. 

11 Close the toner access cover. 
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Cleaning the Color Toner Density (CTD) Sensor 

Clean the CTD sensor only when an alert for the CTD sensor is shown on the Status Monitor or operator panel. 

1 Ensure that the printer is turned off. 

2 Push the rear cover release handle and open the rear cover. 

Clean the CTD sensor inside the printer with a clean dry cotton swab. 

Close the rear cover. 

Turn on the printer. 
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Adjusting Color Registration 
This section describes how to adjust the color registration when you first install the printer or after moving it to a 
new location. 

NOTE: A Password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this case, 
enter the password you specified, and press the (Set) button. 

Performing Auto Correct 
Auto Correct allows you to correct the color registration automatically. 

The Operator Panel 

1 Press the (Menu) button.
 

2 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

3 Press the 
 button until Maintenance appears, and then press the (Set) button.
 

4 Press the 
 button until Color Reg Adj appears, and then press the (Set) button.
 

5 Ensure that Auto Correct appears, and then press the
 (Set) button.
 

6 Ensure that Are you sure? appears, and then press the
 (Set) button.
 

Auto correct is performed.
 

The Tool Box 

1 Click Start → All Programs → Dell Printers → Dell C1760nw Color Printer or Dell C1660w Color Printer 
→ Tool Box. 

NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1760nw Color Printer or Dell C1660w Color Printer listed in Printer Name, and then click OK. 

The Tool Box opens.
 

2 Click the Printer Maintenance tab.
 

3 Select Color Registration Adjustment from the list at the left side of the page.
 

The Color Registration Adjustment page is displayed.
 

4 Clear the On check box for Auto Registration Adjustment.
 

5 Click Start next to Auto Correct.
 

The color registration is corrected automatically.
 

Printing the Color Registration Chart 

The Operator Panel 

1 Load paper. For details about loading paper, see "Loading Print Media" on page 151. 

2 Press the (Menu) button.
 

3 Press the 
 button until Admin Menu appears, and then press the (Set) button.
 

4 Press the 
 button until Maintenance appears, and then press the (Set) button.
 

5 Press the 
 button until Color Reg Adj appears, and then press the (Set) button.
 

6 Press the 
 button until Color Regi Chart appears, and then press the (Set) button.
 

The color registration chart is printed.
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The Tool Box 

1 Click Start → All Programs → Dell Printers → Dell C1760nw Color Printer or Dell C1660w Color Printer 
→ Tool Box. 

NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1760nw Color Printer or Dell C1660w Color Printer listed in Printer Name, and then click OK. 

The Tool Box opens.
 

2 Click the Printer Maintenance tab.
 

3 Select Color Registration Adjustment from the list at the left side of the page.
 

The Color Registration Adjustment page is displayed.
 

4 Clear the On check box for Auto Registration Adjustment.
 

5 Click Start next to Print Color Regi Chart.
 

The color registration chart is printed.
 

Determining Values 
On the color registration chart printed, find the straightest lines where the two black lines and the colored line are 

most closely aligned for each color (Y, M, and C).
 

If you find the straightest line, make a note of the value (-5–+5) indicated by the straightest line for each color.
 

When the value is 0 for each color, you do not need to adjust the color registration.
 

When the value is not 0, enter the value according to the procedure in "Entering Values" on page 198.
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Entering Values 

The Operator Panel 

Using the operator panel, enter the values that you found in the color registration chart to make adjustments. 

2 Press the (Menu) button. 

3 Press the button until Admin Menu appears, and then press the (Set) button. 

4 Press the button until Maintenance appears, and then press the (Set) button. 

5 Press the button until Color Reg Adj appears, and then press the (Set) button. 

6 Press the button until Enter Number appears, and then press the (Set) button. 

7 Ensure that Enter (Y, M, C) appears, and then press the or button until you reach the value (for 
example, +3) displayed on the chart. 

8 Press the  button once and move the cursor to the next value. 

9 Repeat steps 7 and 8 to enter all of the digits, and then press the (Set) button. 

10 Ensure that Enter (LY, LM, LC) appears. 

11 Press the or  button until you reach the value (for example, +3) displayed on the chart. 

12 Press the  button once and move the cursor to the next value. 

13 Repeat steps 11 and 12 to enter all of the digits, and then press the (Set) button. 

14 Ensure that Enter (RY, RM, RC) appears. 

15 Press the or  button until you reach the value (for example, +3) displayed on the chart. 

16 Press the  button once and move the cursor to the next value. 

17 Repeat steps 15 and 16 to enter all of the digits, and then press the (Set) button. 

18 Press the (Menu) button. 

19 Press the button until Admin Menu appears, and then press the (Set) button. 

20 Press the button until Maintenance appears, and then press the (Set) button. 

21 Press the button until Color Reg Adj appears, and then press the (Set) button. 

22 Press the button until Color Regi Chart appears, and then press the (Set) button. 

The color registration chart is printed with the new values. 

23 Adjust the values for every color until the lines at 0 are the straightest. If a line is not the straightest at 0, determine 
the value and adjust the printer again. 

Load paper. For details about loading paper, see "Loading Print Media" on page 151. 

The Tool Box 

Using the Tool Box, enter the values that you found in the color registration chart to make adjustments. 

1 Click Start → All Programs → Dell Printers → Dell C1760nw Color Printer or Dell C1660w Color Printer 
→ Tool Box. 

NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1760nw Color Printer or Dell C1660w Color Printer listed in Printer Name, and then click OK. 

The Tool Box opens. 

2 Click the Printer Maintenance tab. 

3 Select Color Registration Adjustment from the list at the left side of the page. 

The Color Registration Adjustment page is displayed. 
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4 Clear the On check box for Auto Registration Adjustment. 

5 Select the value with the straight line, and then click Apply New Settings. 

6 Click Start next to Print Color Regi Chart. 

The color registration chart is printed with the new values. 

7 Adjust the values for every color until the lines at 0 are the straightest. If a line is not the straightest at 0, determine 
the value and adjust the printer again. 

CAUTION: After printing the color registration chart, do not turn off the printer until the printer motor has stopped running. 
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Clearing Jams
 
Careful selection of appropriate print media and proper loading allow you to avoid paper jams. See "Print Media 
Guidelines" on page 143 for more information. 

NOTE: The images used in this manual are those of the Dell™ C1760nw Color Printer unless otherwise mentioned. 

NOTE: Priority Sheet Inserter (PSI) is available only for Dell C1760nw Color Printer. 

NOTE: Before buying large quantities of any print media, it is recommended that you try a sample first. 

Avoiding Jams 
•	 Use only recommended print media. See "Print Media Guidelines" on page 143 for more information. 

•	 See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 151 and "Loading Print Media in the 

Priority Sheet Inserter (PSI) (Dell C1760nw Color Printer only)" on page 159 to load print media properly.
 

•	 Do not overload the print media sources. Ensure that the stack print media height does not exceed the maximum 
height indicated by the line with an arrow on each width guide. 

•	 Do not load wrinkled, creased, damp, or curled print media. 

•	 Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a 
time through the MPF or the PSI. 

•	 Do not use print media that you have cut or trimmed yourself. 

•	 Do not mix print media sizes, weights, or types in the same print media source. 

•	 Ensure that the recommended print side is face up when you insert the print media. 

•	 Keep print media stored in an acceptable environment. For more information, see "Storing Print Media" on 

page 147.
 

•	 Do not remove the PSI during a print job. 

•	 Ensure that all cables that connect to the printer are correctly attached. 

•	 Over tightening the guides may cause jams. 
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Identifying the Location of Paper Jams 
WARNING: Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path. 

1 2 3 

6 5 

4 

Output Tray 

Fusing Unit 

Levers 

Rear Cover 

Front Cover 

Multipurpose Feeder (MPF) 
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Clearing Paper Jams From the Front of the Printer 

WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Important 

Information.
 

NOTE: PSI is available only for Dell C1760nw Color Printer.
 

NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.
 

Pull the PSI out. 

Remove any jammed paper from the front of the printer. 

Replace the PSI in the printer. 

WARNING: When putting the PSI back into the printer, do not use excessive force. Doing so could damage the PSI or the 
inside of the printer. 
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Press the (Set) button. 

Clearing Paper Jams From the Back of the Printer 

WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Important 
Information. 

WARNING: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet 
before performing maintenance. 

WARNING: To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot during 
use. 

NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path. 

Push the rear cover release handle and open the rear cover. 

Lift up the levers. 
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Remove any jammed paper from the back of the printer. 

Lower the levers to their original position. 

Close the rear cover. 

Clearing Jams 205 



  

     

  

  

1 

2 

Clearing Paper Jams From the Output Tray 

WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Important 
Information. 

WARNING: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet 
before performing maintenance. 

WARNING: To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot during 
use. 

NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path. 

Push the rear cover release handle and open the rear cover. 

Lift up the levers. 
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Remove any jammed paper from the back of the printer. If no paper is found in the paper path, then remove any 
jammed paper out of the output tray. 

Lower the levers to their original position. 

Close the rear cover. 

When you cannot remove the jammed paper even if performing the above steps, press and hold the (Cancel) 
button for 2 seconds.
 

The message Clearing jammed paper is displayed and the jammed paper is ejected along with a paper fed 

from the MPF or PSI.
 

NOTE: After using this feature, the print job in progress is canceled. 

NOTE: To use this feature, paper must be loaded in the MPF or PSI. 
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Troubleshooting 

NOTE: Priority Sheet Inserter (PSI) is available only for Dell™ C1760nw Color Printer. 

Basic Printer Problems 
NOTE: Ethernet connection is available only for Dell C1760nw Color Printer. 

Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the following: 

•	 The power cable is connected to the printer, and to a properly grounded electrical outlet. 

•	 The printer is turned on. 

•	 The electrical outlet is not turned off at any switch or breaker. 

•	 Other electrical equipment plugged into the outlet is working. 

•	 When your printer is connected to the network with the Ethernet cable, the USB cable is not connected between 
the printer and the computer. 

•	 When your printer is connected to the computer with the USB cable, the Ethernet cable is not connected between 
the printer and the network. 

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn 
on the printer. This often fixes the problem. 

NOTE: If error messages are displayed on the operator panel or on your computer screen, follow the on-screen instructions to 
resolve the printer problems. For details about error messages and error codes, see "Understanding Printer Messages" on 
page 177. 

Display Problems 

Problem	 Action 

Menu settings changed from the operator Settings in the software program, the printer driver, or the printer utilities have 
panel have no effect. precedence over the settings made on the operator panel. 

Change the menu settings from the printer driver, the printer utilities, or the 
software program instead of the operator panel. 

Printing Problems 
NOTE: A Password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this case, 
enter the password you specified, and press the (Set) button. 

Problem	 Action 

Job did not print or incorrect characters Ensure that Ready to Print appears on the operator panel before you send 
printed. a job to print. Press the (Menu) button to return to Ready to Print. 

Ensure that print media is loaded in the printer. Press the (Menu) button to 
return to Ready to Print. 

Verify that you are using the correct printer driver. 

Ensure that you are using the correct Ethernet cable (Dell C1760nw Color Printer 
only) or USB cable and that it is securely connected to the printer. 
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Problem Action 

Verify that the correct print media size is selected. 

If you are using a print spooler, verify that the spooler has not stalled. 

Check the interface of your printer from the Admin Menu. 

Determine the host interface you are using. Print a device settings report to verify 
that the current interface settings are correct. Refer to "Printing a Report/List 
Using the Operator Panel" on page 125 for details on how to print a device settings 
report. 

Print media misfeeds or multiple feeds Ensure that the print media you are using meets the specifications for your printer. 
occur. See "Supported Paper Sizes" on page 148 for more information. 

Fan the print media before loading it. 

Ensure that the print media is loaded correctly. 

Ensure that the width and length guides are adjusted correctly. 

Ensure that the PSI is securely inserted. 

Do not overfill the print media sources. 

Do not force print media into the PSI or the Multipurpose Feeder (MPF) when 
you load it. Otherwise, it may skew or buckle. 

Ensure that the print media is not curled. 

Load the recommended print side correctly for the type of print media you are 
using. See "Loading Print Media" on page 151 for more information. 

Turn the print media over or around and try printing again to see if feeding 
improves. 

Do not mix print media types. 

Do not mix reams of print media. 

Remove the top and bottom curled sheets of a ream before loading the print 
media. 

Load a print media source only when it is empty. 

The envelope is creased after printing. Ensure that the envelope is loaded as instructed in "Loading Envelopes in the 
Multipurpose Feeder (MPF)" on page 156 or "Loading an Envelope in the Priority 
Sheet Inserter (PSI)" on page 161. 

Page breaks in unexpected places. Increase the setting for Time-Out in the Printer Settings menu in the 
Dell Printer Configuration Web Tool. 

Print media does not stack neatly in the Turn the print media stack over in the PSI and MPF. 
output tray. 

Printer does not duplex pages. Select Flip on Short Edge or Flip on Long Edge from the Duplex menu on the 
General tab in the printer driver. 
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Print Quality Problems 
NOTE: In this section, some procedures that use the Tool Box can also be performed using the operator panel or 

Dell Printer Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool,
 
see "Understanding the Printer Menus" on page 125 and "Dell™ Printer Configuration Web Tool" on page 81.
 

The output is too light 

Action Yes No 

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor. 

The task is complete. Go to action 2. 

b Replace the toner cartridges as necessary. 

Is the problem recovered? 

2 Verify that the print media is not damp and the correct print media is 
used. See "Supported Paper Types" on page 149. If not, use the print 
media recommended for the printer. 

The task is complete. Go to action 3. 

Is the problem recovered? 

3 Verify that the Paper Type setting in the printer driver matches the print 
media you loaded. 

a On the General tab in Printing Preferences of the printer driver, 
check the Paper Type setting. 

b Load dry (not damp) and corrected print media, and then click Print 
Test Page in Printer properties of the printer driver. 

The task is complete. Go to action 4. 

Is the problem recovered? 

4 Disable the Toner Saver in the printer driver. 
a On the Others tab in Printing Preferences of the printer driver, 

ensure that Off is selected in the Toner Saver drop-down menu. 

The task is complete. Contact Dell. 

Is the problem recovered? 
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Toner smears or print comes off/Stain on back side 

Action Yes No 

1 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick. 

The task is complete. Go to action 2. 

a On the General tab in Printing Preferences of the printer driver, 
change the Paper Type setting. 

Is the problem recovered? 

2 Verify that the correct print media is being used. See "Supported Paper 
Types" on page 149. If not, use the print media recommended for the 
printer. 

The task is complete. Go to action 3. 

Is the problem recovered? 

3 Adjust the fusing unit temperature. 
a Launch the Tool Box, click Adjust Fusing Unit on the Printer 

Maintenance tab. 

The task is complete. Contact Dell. 

b Adjust the fixing temperature by turning up the value for your 
printing media. 

c Click Apply New Settings. 
d Click close box to exit Tool Box. 

Is the problem recovered? 
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Random spots/Blurred images 

Action Yes No 

1 Ensure that the toner cartridges are installed correctly. See "Installing a 
Toner Cartridge" on page 190. 

The task is complete. Go to action 2. 

Is the problem recovered? 

2 If you use non-Dell brand toner cartridges, install Dell brand toner 
cartridges. 

The task is complete. Go to action 3. 

Is the problem recovered? 

3 Clean up the fusing unit. 
a Load one sheet of paper on the MPF, and then print a solid image all 

over paper. 
b Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper. 

The task is complete. Contact Dell. 

Is the problem recovered? 

The entire output is blank 

If this trouble comes out, contact Dell. 

Streaks appear on the output 

If this trouble comes out, contact Dell. 
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Pitched color dots 

If this trouble comes out, contact Dell. 

Vertical blanks 

Action Yes No 

1 Clean inside the printer and performing test print. 
a Clean inside the printer by using the cleaning rod. See "Cleaning 

Inside the Printer" on page 192. 
b Click Print Test Page in Printer properties of the printer driver. 

The task is complete. Contact Dell. 

Is the problem recovered? 

Mottle 

Action Yes No 

1 Adjust the transfer bias. 
a Launch the Tool Box, click Adjust BTR on the Printer Maintenance 

tab. 

The task is complete. Go to action 2. 

b Adjust the setting for the type of print media being used. 

Is the problem recovered? 

2 If you use non-recommended print media, use the print media 
recommended for the printer. 

The task is complete. Contact Dell. 

Is the problem recovered? 
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Ghosting 

Action Yes No 

1 Adjust the transfer bias. 
a Launch the Tool Box, click Chart Print on the Diagnosis tab. 
b Click Ghost Configuration Chart. 

The task is complete. Go to action 2. 

The Ghost Configuration Chart is printed. 
c Launch the Tool Box, click BTR Refresh Mode on the Printer 

Maintenance tab. 
d Check the check box next to On, and then click Apply New Settings. 
e Click Chart Print on the Diagnosis tab. 
f Click Ghost Configuration Chart. 

The Ghost Configuration Chart is printed. 

Is the problem recovered? 

2 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick. 

The task is complete. Go to action 3. 

a On the General tab in Printing Preferences of the printer driver, 
change the Paper Type setting. 

Is the problem recovered? 

3 Adjust the fusing unit temperature. 
a Launch the Tool Box, and click Adjust Fusing Unit on the Printer 

Maintenance tab. 

The task is complete. Go to action 4. 

b Adjust the fixing temperature by turning up the value for your 
printing media. 

c Click Apply New Settings. 
d Click close box to exit Tool Box. 

Is the problem recovered? 

4 If you use non-recommended print media, use the print media 
recommended for the printer. 

The task is complete. Contact Dell. 

Is the problem recovered? 
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1 

Fog 

Action Yes No 

1 Is the whole page printed light? Contact Dell. Go to action 2. 

2 Start Developer Stir Mode. 
a Launch the Tool Box, click Developer Stir Mode on the Diagnosis 

tab. 

The task is complete. Contact Dell. 

b Click Start. 

Is the problem recovered? 

Bead-Carry-Out (BCO) 

Action Yes No 

If the printer is installed in a high altitude location, set the altitude of The task is complete. Contact Dell. 
the location. 

a Launch the Tool Box, and click Adjust Altitude on the Printer 
Maintenance tab. 

b Select the value close to the altitude of the location where the printer 
is installed. 

Is them problem recovered? 

Troubleshooting 218 



 

 

   

 

 

 
  

  

     
 

 

Auger mark 

Action Yes No 

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor. 

The task is complete. Go to action 2. 

b Replace the toner cartridges as necessary. 

Is the problem recovered? 

2 Start Developer Stir Mode. 
a Launch the Tool Box, click Developer Stir Mode on the Diagnosis 

tab. 

The task is complete. Contact Dell. 

b Click Start. 

Is the problem recovered? 

Wrinkled/Stained paper 

Action Yes No 

1 Verify that the correct print media is being used. See "Supported Paper 
Sizes" on page 148 and "Print Media Guidelines" on page 143. If not, use 
the print media recommended for the printer. 

The task is complete. If printing on an 
envelope, go to action 
2. 

Is the problem recovered? If printing on print 
media other than 
envelopes, contact Dell. 

2 Check the crease. Is the crease within 30 mm of the four edges of the 
envelope? 

This type of crease is 
considered normal. 
Your printer is not at 
fault. 

If the envelope is 220 
mm or longer (C5 or 
Envelope #10), go to 
action 3a. 

If the envelope is 
shorter than 220 mm 
(Monarch or DL), go to 
action 3b. 
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Action Yes No 

3a Does the envelope have a flap on the long edge? The envelope is 
Envelope #10. 
Go to action 4b. 

The envelope is C5. 
Go to action 4a. 

3b Load the envelope long edge feed in the MPF with the flap open and 
facing up. For details, see "When Loading Envelope #10, DL, or 
Monarch" on page 156. 

The task is complete. Go to action 4b. 

Is the problem recovered? 

4a Load the envelope in the MPF with the flap open and facing up. For 
details, see "When Loading C5" on page 157. 

The task is complete. Contact Dell. 

Is the problem recovered? 

4b Use a different size envelope. The task is complete. Contact Dell. 

Is the problem recovered? 

The top margins is incorrect 

Action Yes No 

1 Ensure that the margins are set correctly on the application being used. The task is complete. Contact Dell. 

Is the problem recovered? 

Color registration is out of alignment 

Action Yes No 

1 Execute auto color registration adjustment. 
a Launch the Tool Box, and click Color Registration Adjustment on 

the Printer Maintenance tab. 

The task is complete. Go to action 2. 

b Clear the On check box for Auto Registration Adjustment. 
c Click Start next to Auto Correct. 

Is the problem recovered? 
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Action Yes No 

2 Clean the CTD sensor. 
a Clean the CTD sensor. See "Cleaning the Color Toner Density 

(CTD) Sensor" on page 195. 
b Launch the Tool Box, and click Color Registration Adjustment on 

the Printer Maintenance tab. 

The task is complete. Go to action 3. 

c Clear the On check box for Auto Registration Adjustment. 
d Click Start next to Auto Correct. 

Is the problem recovered? 

3 Print the Color Registration Chart and manually correct the color 
registration. 

a Click Color Registration Adjustment on the Printer Maintenance 
tab. 

The task is complete. Contact Dell. 

b Clear the On check box for Auto Registration Adjustment. 
c Click Start next to Print Color Regi Chart. 

The color registration chart is printed. 
d Select the value with the straight line. See "Adjusting Color 

Registration" on page 196 for details. 
e Click Apply New Settings. 
f Click Start next to Print Color Regi Chart to print the Color 

Registration Chart again. 
g Adjust the values for every color until the lines at 0 are the straightest. 

Is the problem recovered? 

Protrudent / Bumpy paper 

Action Yes No 

1 Clean up the fusing unit. 
a Load one sheet of paper on the MPF, and then print a solid image all 

over paper. 
b Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper. 

The task is complete. Contact Dell. 

Is the problem recovered? 
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Noise 
NOTE: In this section, some procedures that use the Tool Box can also be performed using the operator panel or 

Dell Printer Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool,
 
see "Understanding the Printer Menus" on page 125 and "Dell™ Printer Configuration Web Tool" on page 81.
 

Action Yes No 

1 Locate the cause of the problem by removing the toner cartridges. 
a Remove the toner cartridges. See "Replacing Toner Cartridges" on 

page 188. 
b Launch the Tool Box, and click Machine Check on the Diagnosis 

tab. 

Go to action 2. Contact Dell. 

c Select Main Motor Operation Check from the drop-down list box, 
and click Start. 

d Click Play of Sound to check the motor sound. 

Does the sound generated from the printer match with the sound from 
the Play of Sound button? 

2 a Click Machine Check on the Diagnosis tab. 
b Select Dispense Motor Check (Yellow), Dispense Motor Check 

(Magenta), Dispense Motor Check (Cyan), or Dispense Motor 
Check (Black) from the drop-down list box, and click Start. 

c Click Play of Sound to check the motor sound. 
d Repeat steps a and b to perform Dispense Motor Check for the rest of 

the toner cartridges. 

NOTE: You can perform Dispense Motor Check for CMYK in any order you 
desire. 

Go to action 3. Contact Dell. 

NOTE: Do not check the operation of the dispense motor repeatedly. 

Does the sound generated from the printer match with the sound from 
the Play of Sound button? 

3 a Reinstall the toner cartridges. 
b Perform action 2 again. 

The task is complete. Contact Dell. 

Does the sound generated from the printer match with the sound from 
the Play of Sound button? 
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Jam 
NOTE: In this section, some procedures that use the Tool Box can also be performed using the operator panel or 

Dell Printer Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool, 

see "Understanding the Printer Menus" on page 125 and "Dell™ Printer Configuration Web Tool" on page 81.
 

Misfeed jam 

Action Yes No 

1 Remove the paper from the PSI, and then ensure that papers are 
properly inserted on the MPF. 

Is the problem recovered? 

The task is complete. Proceed to the action 
corresponding to the 
type of the print media 
being used: 

• Thick - 2a  

• Thin - 2b 

• Envelope - 2c 

If performing manual 
duplex printing, go to 
action 2d. 

If using paper other 
than the above or if not 
performing duplex 
printing, go to action 
2e. 

2a Use thick paper that is 216 gsm or less. The task is complete. Go to action 3a. 

Is the problem recovered? 

2b Use thin paper that is 60 gsm or more. The task is complete. Go to action 3a. 

Is the problem recovered? 

2c Ensure that the envelope is properly loaded in the MPF as instructed in 
"Loading Envelopes in the Multipurpose Feeder (MPF)" on page 156. 

The task is complete. Go to action 3b. 

Is the problem recovered? 

2d Ensure that the print media is not curled. The task is complete. Go to action 3a. 

Is the problem recovered? 

2e Is the print media damp? Go to action 3c. Go to action 3a. 

3a Fan the print media. The task is complete. Go to action 3c. 

Is the problem recovered? If you are performing 
manual duplex printing 
or if using an envelope, 
contact Dell. 

3b If the envelope is deformed, correct it or use another envelope. The task is complete. Go to action 3a. 

Is the problem recovered? 

3c Turn over the print media. The task is complete. Go to action 4. 

Is the problem recovered? 

4 Use print media that is not damp. The task is complete. Contact Dell. 

Is the problem recovered? 
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Multi-feed jam 

Action Yes No 

1 Remove the paper from the PSI, and then ensure that papers are The task is complete. Go to action 2. 
inserted properly in the MPF. 

Is the problem recovered? 

2 Is the print media damp? Go to action 3a. Go to action 3b. 

3a Use print media that is not damp. The task is complete. Go to action 3b. 

Is the problem recovered? 

3b Fan the print media. The task is complete. Contact Dell. 

Is the problem recovered? 

Wireless Problems
 

Problem	 Action 

Cannot setup wireless connection. Ensure that the Ethernet cable (Dell C1760nw Color Printer only) and USB cable 
are disconnected from the printer. 

Ensure that Wireless LAN is set to Enable. See "Wireless LAN" on 
page 127. 

Try disabling the firewall on your computer. The firewall on your computer may be 
blocking communication with your printer. 

Cannot setup wireless connection with WPS Ensure that the security setting of the wireless LAN access point or router is WPA 
(Wi-Fi Protected Setup®). or WPA2. (WEP is not supported on WPS.) 

Turn off the printer, and then on again. 

The message Wireless Session Two or more wireless LAN access points or routers may be performing WPS setup 

Overlap Error is displayed when at the same time. Wait for a while, and then try again.
 
setting up wireless connection.
 

Cannot setup wireless connection with the Press the WPS button on the wireless LAN access point or router within 2 minutes 
WPS-PBC (Wi-Fi Protected Setup-Push after starting the WPS operation on the printer. For details about the wireless LAN 
Button Configuration). access point or router, refer to the manual supplied with the wireless LAN access 

point or router. 

Cannot setup wireless connection with Check if the PIN you have entered on the computer is correct.
 
WPS-PIN (Wi-Fi Protected Setup-Personal
 
Identification Number).
 

Cannot connect to the wireless network 	 Check if the passphrase for WPA/WPA2 encryption or WEP key set on the wireless 
after setting up wireless connection.	 LAN access point or router has been changed. (Passphrase may be described as key 

on some access points or routers.) For details about the wireless LAN access point 
or router, refer to the manual supplied with the wireless LAN access point or 
router. 
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Other Problems
 

Problem	 Action 

Condensation has occurred inside the 	 This usually occurs within several hours after you heat the room in winter. This 
printer.	 also occurs when the printer is operating in a location where relative humidity 

reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate 
environment. 

Contacting Service 
When you call for printer service, be prepared to describe the problem you are experiencing or the error message on 

the display.
 

You need to know the model of your printer type and serial number. See the label located inside the side door of your 

printer.
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Appendix 

Dell Technical Support Policy 
Technician-assisted technical support requires the cooperation and participation of the customer in the 
troubleshooting process and provides for restoration of the operating system, software program and hardware drivers 
to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of 
the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical 
support is available at Dell Support. Additional technical support options may be available for purchase. 

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for 
third-party software and peripherals is provided by the original manufacturer, including those purchased and/or 
installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus). 

Online Services 
You can learn about Dell products and services on the following websites: 

www.dell.com
 

www.dell.com/ap (Asian/Pacific countries only)
 

www.dell.com/jp (Japan only)
 

www.euro.dell.com (Europe only)
 

www.dell.com/la (Latin American and Caribbean countries)
 

www.dell.ca (Canada only)
 

You can access Dell Support through the following websites and e-mail addresses: 

•	 Dell Support websites 

support.dell.com
 

support.euro.dell.com (Europe only)
 

•	 Dell Support e-mail addresses
 

mobile_support@us.dell.com
 

support@us.dell.com 


la-techsupport@dell.com (Latin America and Caribbean countries only)
 

apsupport@dell.com (Asian/Pacific countries only)
 

•	 Dell Marketing and Sales e-mail addresses 

apmarketing@dell.com (Asian/Pacific countries only)
 

sales_canada@dell.com (Canada only)
 

•	 Anonymous file transfer protocol (FTP) 

ftp.dell.com 

Log in as user: anonymous, and use your e-mail address as your password. 
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Warranty and Return Policy 
Dell Computer Corporation ("Dell") manufactures its hardware products from parts and components that are new or 
equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your 
printer, see support.dell.com. 

Recycling Information 
It is recommended that customers dispose of their used computer hardware, monitors, printers, and other peripherals in an environmentally 
sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials. 

For specific information on Dell's worldwide recycling programs, see www.dell.com/recyclingworldwide. 

Contacting Dell 
You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, 

and fill in the requested details to access help tools and information.
 

You can contact Dell electronically using the following addresses:
 

• World Wide Web  

www.dell.com
 

www.dell.com/ap (Asian/Pacific countries only)
 

www.dell.com/jp (Japan only)
 

www.euro.dell.com (Europe only)
 

www.dell.com/la (Latin American and Caribbean countries)
 

www.dell.ca (Canada only)
 

•	 Anonymous file transfer protocol (FTP) 

ftp.dell.com 

Log in as user: anonymous, and use your e-mail address as your password. 

•	 Electronic Support Service
 

mobile_support@us.dell.com
 

support@us.dell.com
 

la-techsupport@dell.com (Latin America and Caribbean countries only)
 

apsupport@dell.com (Asian/Pacific countries only)
 

support.jp.dell.com (Japan only)
 

support.euro.dell.com (Europe only)
 

•	 Electronic Quote Service 

apmarketing@dell.com (Asian/Pacific countries only)
 

sales_canada@dell.com (Canada only)
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Numerics 
100Base-TX Full-Duplex, 102
 

100Base-TX Half-Duplex, 102
 

10Base-T Full-Duplex, 102
 

10Base-T Half-Duplex, 102
 

A 
A4, 148
 

A5, 148
 

About printer, 21
 

Ad-Hoc, 107
 

Adjust Altitude, 92, 97, 118, 138
 

Adjust BTR, 92, 95, 116, 134
 

Adjust Fusing Unit, 92, 95, 117, 135
 

Adjusting color registration, 196
 

Admin Menu, 126
 

Administrator Password, 109
 

Altitude, 182
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Apply New Settings Button, 87
 

Asset Tag Number, 90
 

Authenticate Error Trap, 106
 

Auto Log Print, 92-93, 133
 

Auto Reg Adj, 135
 

Auto Registration Adjustment, 92, 95
 

Auto SSID Setup, 32
 

Avoiding jam, 169, 201
 

B 
B5, 148
 

Base memory, 181
 

Basic Information, 101
 

Basic Printer Problems, 211
 

Bonjour (mDNS), 100, 102, 105, 130
 

BTR Refresh, 92, 96, 137
 

BTR Refresh Mode, 119
 

C 
C5, 148
 

Cable, 183
 

Cancel button, 77
 

Canceling a print job, 170
 

Carbonless copy paper, 144
 

CCP, 144
 

Change Password, 139
 

Chart, 137
 

Chart Print, 121
 

Clean Developer, 96, 136
 

Cleaning Inside the Printer, 192
 

Cleaning the Color Toner Density (CTD) 

Sensor, 195
 

Clearing jam, 201
 

Clearing Paper Jams From the Back of the 
Printer, 204
 

Clearing Paper Jams From the Front of the 

Printer, 203
 

Clearing Paper Jams From the Output Tray, 206
 

Coated, 92, 95, 116-117, 134-135
 

Color Reg Adj, 136
 

Color Regi Chart, 96
 

Color Registration Adjustment, 117
 

Color Registration Adjustments, 96
 

Color registration chart, 196
 

Color Test Page, 93, 125
 

Community Name, 105
 

Completed Jobs, 83, 91
 

Connecting Printer to Computer or Network, 29
 

Appendix 231 



 

Connecting your printer, 29
 

Connection specification, 29, 183
 

Connection type, 29, 183
 

Conserving supplies, 187
 

Contact Dell Support at, 84
 
, 86 
  

Contact Person, 85
 

Contacting Service, 225
 

Copy Printer Settings, 84, 86, 110
 

Copy Printer Settings Report, 110
 

Cover, 89
 

Covers, 92, 95, 116-117, 134-135
 

Current, 181
 

Current Ethernet Settings, 102
 

D 
Def. Paper Size, 132
 

Default Paper Size, 91, 93
 

Dell Printer Configuration Web Tool, 81
 

Dell Service Tag Number, 90
 

Dell Supplies Management System, 173
 

Dell technical support policy, 229
 

Details, 90
 

Determining Values, 197
 

Developer Stir Mode, 122
 

Device Settings, 93, 125
 

Device Settings page, 79
 

Dimensions, 181
 

Direct Connection, 29
 

Direct Connection Setup, 51
 

Disable printing with larger paper size, 91, 93
 

Disabling Panel Lock, 140
 

Display Problems, 211
 

DL, 148
 

DL LEF, 148
 

DNS, 99, 103
 

Driver, 17
 

E 
E-Mail Alert, 84, 86, 102, 104, 130
 

E-Mail Alert Settings, 101, 105
 

E-mail Alert Setup Page, 100
 

E-Mail Server Settings, 100, 104
 

Emulations, 182
 

Encryption, 107-108
 

Entering Values, 198
 

Envelope, 92, 95, 116-117, 134-135, 146
 

Envelope #10, 148
 

Environment, 182
 

Environment Sensor Info, 122
 

Error History, 93, 125
 

Ethernet, 98, 102, 183
 

Ethernet Connection, 34
 

Ethernet Port, 22, 29
 

Ethernet Settings, 102
 

Event Panel, 85
 

EWS, 130
 

EWS Settings, 101
 

Executive, 148
 

Express Code, 133
 

Express Service Code, 90
 

F 
F/W Version, 133
 

Fault Time-Out, 91, 93, 132
 

Finding Information, 17
 

Firmware Version, 90
 

Folio, 148
 

Frequency, 181
 

Front Cover, 21, 202
 

Fusing Unit, 202
 

H 
Host I/F, 90-91
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Host Name, 90-91, 100
 

host-based printer driver, 51, 54
 

HTTP, 99, 104
 

I
 
ID, 90-91
 

Identifying Print Media and Specifications, 148
 

Important Information, 17
 

Impression Number, 91
 

Infrastructure, 107
 

Initial Settings, 37
 

Initialize NIC NVRAM and restart printer, 108
 

Installing a Toner Cartridge, 190
 

Installing Printer Drivers, 51, 71
 

Interfaces, 182
 

IP Address, 39, 83, 85, 106
 

IP Filter, 100, 130
 

IP Filter (IPv4), 109
 

IPv4, 99-100, 103, 106
 

IPv6, 99, 103, 106
 

J 
Jam, 223
 

Job History, 93, 125
 

Job List, 83, 90
 

Job Name, 90-91
 

Job Status, 90
 

Job Submitted Time, 90-91
 

Job Time-Out, 91, 93, 132
 

K 
Kensington lock, 24
 

L 
Label, 92, 95, 116-117, 134-135, 147
 

LCD, 77
 

LCD Panel, 77
 

Left frame, 86
 

Legal, 148
 

Length Guide, 21
 

Letter, 148
 

Levers, 22, 202
 

Link Channel, 107
 

Link Quality, 107
 

Liquid crystal display, 77
 

Loading Envelopes, 156, 161
 

Loading Letterhead, 145, 158, 163
 

Loading paper, 43
 

Loading Print Media, 151
 

Loading Print Media in Multipurpose Feeder 

(MPF), 43, 151
 

Loading Print Media in Priority Sheet Inserter 

(PSI), 48, 159
 

Location, 85, 90
 

Login Error, 94, 139
 

Login Error - Attempts, 92
 

Low Toner Alert Msg, 92-93
 

Low Toner Msg, 133
 

LPD, 99, 102-103, 130
 

M 
MAC Address, 102, 107
 

Machine Check, 121
 

Maintaining Your Printer, 187
 

Maintenance, 133
 

Maintenance Chart, 97
 

Manual duplex printing, 164
 

Manual SSID Setup, 33
 

Memory, 181
 

Memory Capacity, 90
 

Menu button, 77
 

Menu Items, 88
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Menu Settings, 91, 112
 

MIB compatibility, 182
 

Mixed Mode PSK, 107
 

mm/inch, 91, 93, 132
 

Monarch, 148
 

Monarch LEF, 148
 

MPF Extension, 21
 

Multiple Up, 187
 

Multipurpose Feeder (MPF), 21, 202
 

N 
NCR, 144
 

Network, 126
 
Ethernet, 126
 
Protocol, 130
 
Reset LAN, 130
 
Reset Wireless, 129
 
TCP/IP, 129
 

Network Connection Setup, 54
 

Network Firmware Version, 90
 

Network Settings, 120
 

Network Type, 107
 

No carbon required, 144
 

No. of Sheets, 91
 

Non-Dell Toner, 92, 97, 119, 138
 

O 
OCR, 144
 

Online Help, 84, 86
 

Online Services, 229
 

Operating System compatibility, 181
 

Operation, 182
 

Operator Panel, 21, 77
 
Button, 77
 

Order Supplies at, 84, 86
 

Ordering supplies, 25
 

Output Result, 91
 

Output Tray, 21, 89, 202
 

Output Tray Extension, 21, 166
 

Owner, 90-91
 

P 
Panel Language, 80, 92-93, 140
 

Panel Lock, 138
 

Panel lock function, 140
 

Panel Lock Set, 92, 138
 

Paper, 143
 
Characteristics, 143
 
Curl, 143
 
Fiber content, 144
 
Grain direction, 143
 
Moisture content, 143
 
Smoothness, 143
 
Weight, 143
 

Paper Chute, 22
 

Paper Density, 92, 94, 116, 134
 

Paper Feed Roller, 22
 

Paper jam location, 202
 

Paper Size, 148
 

Paper Trays, 89
 

Paper Type, 149
 

Paper Used, 110
 

Paper Width Guides, 21
 

Parts name, 21
 

PDL, 182
 

Peer-to-Peer, 68
 

Plain, 92, 95, 116-117, 134-135
 

Plain Thick, 92, 95, 116-117, 134-135
 

Point and Print, 66
 

Port Settings, 102
 

Port Status, 100, 102
 

Port9100, 99, 102-103, 130
 

Power Connector, 22
 

Power On Wizard, 133
 

Power Saver Time - Auto-Off Timer, 91, 93
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Power Saver Time - Deep Sleep, 91, 93
 

Power Saver Time - Sleep, 91, 93
 

Power supply, 181
 

Power Switch, 21
 

PowerSaver Time, 80, 131
 

Premier, 92
 

Print Head Cleaning Rod, 21
 

Print media, 187
 

Print Media Dimensions, 151
 

Print Media Guidelines, 143
 

Print quality guarantee, 182
 

Print Quality Problems, 213
 

Print Server Reports, 98
 

Print Server Settings, 84, 86, 98, 101
 

Print Server Setup Page, 98
 

Print Volume, 84, 86, 110
 

Printer Bitmap, 85
 

Printer Driver Pre-install Status, 51
 

Printer Events, 90
 

Printer Information, 84, 86, 90, 112
 

Printer Jobs, 83, 86, 90
 

Printer Maintenance, 94
 

Printer message, 177
 

Printer Name, 100
 

Printer Page Count, 110
 

Printer Revision Levels, 90
 

Printer Serial Number, 90
 

Printer Settings, 83, 86, 91, 93, 125
 

Printer Settings Report, 91
 

Printer software, 173
 

Printer specification, 181
 

Printer Status, 83, 86, 89
 

Printer Type, 89
 

Printing, 169
 

Printing on letterhead, 145
 

Printing Problems, 211
 

Printing Speed, 89
 

Printing Status Window, 173
 

Priority Sheet Inserter (PSI), 21
 

Processor Speed, 90
 

Product Features, 19
 

Q 
Quick Launch Utility, 174
 

Quick Reference Guide, 17
 

R 
Rated Voltage, 181
 

Ready/Error indicator, 77
 

Rear Cover, 22, 202
 

Rear Cover Release Handle, 22
 

Recommended paper, 144
 

Recycled, 92, 95, 116-117, 134-135
 

Recycling Information, 230
 

Refresh button, 87
 

Refresh Mode, 122
 

Regular, 92
 

Relative humidity, 182
 

Removing toner cartridge, 188
 

Report Page, 170
 

Reports, 93, 114
 

Reset Defaults, 97, 119, 137
 

Reset Print Server, 108
 

Restart Printer, 108
 

Restore Settings button, 87
 

Return policy, 230
 

Right frame, 87
 

S 
S/W Download, 139
 

Safety information, 17
 

Secure Settings, 92, 94, 138
 

Security, 109
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Security Settings, 107
 

Security Slot, 22
 

Select Reorder URL, 92
 

Selecting paper, 144
 

Selecting preprinted media and letterhead, 145
 

Selecting pre-punched paper, 146
 

Sending print job, 169
 

Service code, 18
 

Service Tag, 18, 133
 

Set button, 77
 

Set Password, 84, 86, 109
 

Setting the IP Address, 39
 

Setting Up Printer, 37
 

Setup diagram, 18
 

Shared Printing, 64
 

SNMP, 100, 102, 105
 

SNMP UDP, 130
 

Software and Documentation Disc, 38
 

Software and Documentation disc, 17
 

Software Download, 92
 

SSID, 107
 

Status Monitor Console, 173
 

Status Monitor Widget, 174
 

Status of supplies, 187
 

Storage, 182
 

Storage humidity range, 182
 

Storing consumables, 188
 

Storing Print Media, 147, 169, 187
 

Support
 
Contacting Dell, 230
 

System Settings, 91, 93, 101, 114, 131
 

T 
TCP/IP, 103
 

TCP/IP Settings, 99, 103, 114, 120
 

Temperature, 182
 

Toner Access Cover, 21
 

Toner Refresh, 137
 

Tool Box, 111
 

Top frame, 85
 

Transfer Belt, 22
 

Transfer Roller, 22
 

Trap Notification 1-4, 106
 

Troubleshooting, 211
 

Turning On Printer, 36
 

U 
Unacceptable paper, 144
 

UNITED STATES GOVERNMENT 

RESTRICTED RIGHTS, 13
 

USB, 183
 

USB Port, 22, 29, 92, 94, 131
 

USB Settings, 92, 94, 131
 

V
 

Verifying IP settings, 41
 

W 
Warranty, 230
 

Warranty information, 17
 

Web Link Customization, 92, 98
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